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1 Introduction

1.1 About this manual
The AMS Machine Works Online Help guides you through using the software after
installation.

For information on the installation, see the AMS Machine Works System Guide
(MHM-97926). The System Guide includes information on installing the software and
performing administrator functions. The System Guide is included with the installation
files. Emerson recommends administrators to read the System Guide before attempting
installation and before reading the Online Help.

Table 1-1: Referenced Documents

MHM Number Document name

MHM-97924-PBF AMS Asset Monitor Operating Manual

MHM-97932-PBF AMS Machine Works v1.7.5 System Guide

1.2 Symbols
Note
This symbol marks passages that contain important information.

 CAUTION

This symbol marks operations that can lead to malfunctions or faulty measurements, but
will not damage the device.

1.3 Where to get help
Emerson provides a variety of ways to reach your Product Support team to get the answers
you need when you need them:

Phone Toll free 800.833.8314 (U.S. and Canada)

+1.512.832.3774 (Latin America)

+63.2 702.1111 (Asia Pacific, Europe, and Middle East)

Email Guardian.GSC@Emerson.com

Web http://www.emerson.com/en-us/contact-us

To search for documentation on AMS Machinery Manager, visit https://
www.emerson.com/en-us/catalog/ams-ams-machinery-manager.

To view toll free numbers for specific countries, visit http://www.emerson.com/
technicalsupport.
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1.4 Terms of use
Software License Agreement

LICENSOR PROVIDES THE SOFTWARE SOLELY ON THE TERMS AND CONDITIONS SET
FORTH IN THIS AGREEMENT AND ON THE CONDITION THAT LICENSEE ACCEPTS AND
COMPLIES WITH THEM. BY OPENING THE SOFTWARE PACKAGE, INDICATING ASSENT
ELECTRONICALLY, OR DOWNLOADING, INSTALLING, COPYING, OR USING THE
SOFTWARE, THE LICENSEE AGREES TO ACCEPT THE TERMS AND CONDITIONS OF THIS
SOFTWARE LICENSE AGREEMENT (THE “AGREEMENT”) AND AGREE THAT THE LICENSEE IS
LEGALLY BOUND BY ITS TERMS. IF LICENSEE IS A CORPORATION, GOVERNMENTAL
ORGANIZATION, OR OTHER LEGAL ENTITY, THEN THE INDIVIDUAL ACCEPTING THESE
TERMS HEREBY REPRESENTS AND WARRANTS THAT THEY HAVE THE RIGHT, POWER, AND
AUTHORITY TO ENTER INTO THIS AGREEMENT ON BEHALF OF LICENSEE AND BIND
LICENSEE TO THESE TERMS. IF LICENSEE DOES NOT AGREE WITH THESE TERMS AND
CONDITIONS, DO NOT CONTINUE DOWNLOADING, INSTALLING, COPYING OR USING THE
SOFTWARE AND RETURN THE SOFTWARE FOR A REFUND.

Fisher Rosemount Systems, Inc., an Emerson Automation Solutions company (“Emerson”)
is the licensor of the Software. As used in this Agreement, the term “Software” refers to
software, firmware, and all related access keys, license management devices,
documentation (e.g., manuals and specifications) and libraries as well as revisions or
updates to the foregoing provided by Emerson or its distributor to Licensee. The term
“Documentation” means user manuals or operating instructions provided by Emerson
with the Software. “Proposal” means the applicable Emerson proposal describing the
Software.

LICENSE

Subject to Licensee’s compliance with this Agreement and payment of applicable fees,
Emerson grants Licensee a non-transferable, non-sublicensable, non-exclusive limited
license during the License Term to use the Software provided to Licensee solely: (a) for
Licensee’s internal business purpose, (b) in accordance with the Documentation, and (c)
by and through its Authorized Users. Emerson may, from time to time, revise or update
the Software and, in so doing, incurs no obligation to furnish such revisions or updates to
Licensee, except as otherwise provided in a separate written agreement. The “License
Term” means the period of time that Licensee is authorized to access the Software as
specified in the Proposal. If the “License Term” is not defined in the Proposal, then the
License Term will be twelve months.

RESTRICTIONS

Licensee may not exceed any limits applicable to Licensee’s use of the Software (e.g., as
may be identified in this license, the Product Terms, the applicable data sheet, the
Proposal, or the Documentation (collectively, the “Product Descriptions”)) nor use any
features of the Software for which Licensee have not purchased a license. To the extent
the Product Descriptions include a number of users, systems, tags, or other parameter,
Licensee may not use more than the specified parameter (or, as applicable, use the
Software in support of more than the specified parameter) without purchasing an
additional license. Emerson may use technological and/or other measures to prevent
unlicensed access to, or use of, the Software or its features, and Licensee acknowledges
and agrees to the use of such measures, and that Licensee shall not actually, nor attempt
to, remove, disable, circumvent, or otherwise create or implement any workaround to,
any such copy protection or security features. LICENSEE MAY NOT USE OR COPY THE
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SOFTWARE EXCEPT AS EXPRESSLY PROVIDED IN THIS LICENSE OR THE PRODUCT TERMS.
Licensee must reproduce and include the copyright notice on any copy Licensee is
expressly permitted to make in the Product Terms. LICENSEE MAY NOT REVERSE
ENGINEER, DECOMPILE, DECODE, OR OTHERWISE ATTEMPT TO DERIVE OR ACCESS THE
SOURCE CODE OF THE SOFTWARE, MODIFY, TRANSLATE, ADAPT, OR CREATE DERIVATIVE
WORKS OF THE SOFTWARE OR ANY COPY (PERMITTED ABOVE), IN WHOLE OR IN PART.
This Agreement and the Software may only be transferred or assigned (by operation of law
or otherwise) with Emerson’s written consent and upon payment of applicable transfer
fees. Unless otherwise expressly permitted in writing, Licensee may not use the Software
to provide hosted services, subscription services, training services, consulting services,
service bureau, time sharing, or rental use to third parties or otherwise provide the
Software or extend the benefit of the Software to any third party other than an Authorized
User that uses the Software for Licensee’s benefit. Licensee may not use the Software in
violation of any governmental law, regulation, or rule or use the Software for purposes of
competitive analysis of the Software, the development of a competing software product
or service, or any other purpose that is to the Licensor's commercial disadvantage. No
license, express or implied, is granted under any intellectual property directly or indirectly
owned by Emerson which does not specifically read on the Software as provided
hereunder, nor shall any license, except the license specifically granted herein, be implied
in law, implied in equity, or exist under the doctrine of patent exhaustion.

Responsibility for Use of Software

Licensee may permit subcontractors to access and use the Software solely (i) in
compliance with the terms of this Agreement and (ii) for Licensee’s benefit. Licensee shall
ensure that all such users comply with the terms of this Agreement. Notwithstanding the
foregoing, under no circumstances may Licensee provide access to the Software to a
competitor of Emerson. Licensee is responsible and liable for all uses of Licensee’s
instance(s) of the Software. Specifically, and without limiting the generality of the
foregoing, Licensee is responsible and liable for all actions and failures to take required
actions with respect to the Software by its authorized users or by any other person or
entity to whom Licensee or an authorized user may provide access to or use of the
Software.

SECURITY ASSESSMENTS

In the event Licensee wishes to assess the vulnerability of the Software (including
conducting a penetration test or any other form of vulnerability assessment or test),
Licensee agree to obtain Emerson’s prior written consent. Emerson will not unreasonably
withhold or unduly delay such consent, but Licensee agree that Emerson may require that:
(i) Emerson participate in any such tests/assessments, (ii) receive the results of such tests/
assessments, and (iii) Licensee not publish, distribute, or otherwise make available the
results (in whole or part) to any third party without the express written consent of
Emerson. Emerson may further require that any such tests/assessments be conducted in
accordance with and subject to a separate written agreement between Licensee and
Emerson.

DIGITAL SIGNATURES

Emerson may attach or otherwise associate digital signatures to files of the Software to aid
detection of subsequent modifications to such files. However, in attaching or associating
such digital signatures, Emerson does not (i) guarantee that the Software or the files can
be trusted, nor (ii) assume any liability or claim authorship with regard to third party files.

DATA PRIVACY AND USE
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When Licensee downloads, installs or uses the Software, Emerson may use automatic
means to collect information about Licensee’s device and about its use of the Software.
Licensee also may be required to provide certain information about Licensee or its users as
a condition to downloading, installing or using the Software or certain of its features or
functionality, and the Software may provide Licensee with opportunities to share
information about Licensee or its users with others. Emerson may collect information,
including but not limited to information relating to the manner or frequency of use of the
Software. This includes data that Emerson collects as part of Emerson’s services. Some of
the data Emerson collects is relatively static, such as data about the product (for example,
serial numbers and device IDs and the Emerson model and serial number), but other data
is more dynamic, such as information about current and past product usage levels,
information about abnormal product functioning, information about the status and
location of products used with the Software and/or Licensee’s device. Emerson collects
this data from Licensee and the product and transmit it through Licensee’s network and/or
Internet services. Monitoring may continue until the Software is deleted or the services are
cancelled or terminated. Note that if Licensee does not allow us to collect this information,
Emerson may not be able to provide the full capabilities of products and services. All
information Emerson collects through or in connection with this Software and the use of
the Software in connection with Emerson products is subject to the Emerson privacy
notice found at https://www.emerson.com/en-us/privacy-notice (“the Privacy Notice”).
Emerson will collect, use and disclose Licensee’s personal information and the personal
information of its additional users as set out in that Privacy Notice, and Licensee and the
additional users or third parties Licensee has granted access or control consent to us doing
so. The Privacy Notice applies subject to requirements of local law. In the event of a
conflict between the Privacy Notice and applicable data protection laws, the stricter
obligation applies. Furthermore, the data that is generated and collected by the Software
may be stored in a hosted environment at a location identified to Licensee in the
documentation for the Software. Licensee is solely responsible for compliance with all
applicable local, state and federal data sovereignty laws, regulations and restrictions as it
relates to the movement of data generated and collected by the Software. Licensee agrees
that Emerson may use all data that it collects or receives: (i) for purposes of supporting the
Software, verifying compliance with the terms of this Agreement, enforcing Emerson’s
rights, or performing services for Licensee; and (ii) once aggregated with data received
from other Emerson customers, for purposes of improving Emerson’s products or for any
other commercial purpose.

TITLE

Licensee acknowledges and agrees that the Software are licensed and not sold. Licensee
does not acquire any ownership interest in the Software under this Agreement, or any
other rights thereto, other than the limited license expressly granted above. Emerson and
its licensors reserve and shall retain their entire right, title, and interest in and to the
Software and all intellectual property rights in the Software, except as expressly granted to
the Licensee in this Agreement. Licensee’s right to use the same is at all times subject to
the terms and condition of this Agreement. Licensee acknowledges and agrees that the
Software is Emerson’s confidential information and will not be disclosed by Licensee to any
third party without Emerson’s prior written consent.

TERM; SUSPENSION

The term of this Agreement shall be for the License Term unless terminated earlier as
permitted below. Emerson may terminate this Agreement or suspend Licensee’s access to
the Software immediately upon written notice if Licensee breaches any material term or
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condition of this Agreement or fails to pay amounts owed for the Software and fails to cure
such breach or failure within thirty (30) days of a written notice from Emerson. Licensee
may cease use of the Software at any time but may not terminate this Agreement prior to
the end of the License Term. Upon expiration of the License Term or the earlier
termination of this Agreement as permitted above, Licensee agrees to promptly (i)
destroy the Software together with all copies in any form and confirm such destruction in
writing to Emerson or (ii) return the Software and all copies to Emerson. Any termination
of the Agreement shall not relieve Licensee of its obligation to pay, at the time of
termination, the applicable license fees for the remainder of the License Term. All fees paid
for the Software are non-refundable.

WARRANTY DISCLAIMER

TO THE MAXIMUM EXTENT PERMITTED BY LAW, THE SOFTWARE IS PROVIDED "AS IS"
WITHOUT WARRANTY OF ANY KIND AND EMERSON DISCLAIMS ANY AND ALL
WARRANTIES, CONDITIONS, REPRESENTATIONS, AND GUARANTEES WITH RESPECT TO
THE SOFTWARE, EITHER EXPRESS OR IMPLIED, ARISING BY LAW, USAGE OF TRADE,
COURSE OF DEALING, COURSE OF PERFORMANCE, PRIOR ORAL OR WRITTEN
STATEMENTS, OR OTHERWISE INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-
INFRINGEMENT. EMERSON MAKES NO REPRESENTATIONS OR WARRANTIES ON BEHALF
OF ITS LICENSORS. WITHOUT LIMITING THE FOREGOING, EMERSON DOES NOT WARRANT
(I) THAT THE SOFTWARE WILL BE FREE FROM ANY INTERRUPTIONS, DELAYS,
INACCURACIES, SERVER DOWN-TIME, ERRORS, OR OMISSIONS, (II) THE PERFORMANCE
OR RESULTS LICENSEE MAY OBTAIN BY USING THE SOFTWARE, OR (III) THE SOFTWARE
WILL MEET LICENSEE’S REQUIREMENTS. NO REPRESENTATION OR OTHER AFFIRMATION
OF FACT, INCLUDING STATEMENTS REGARDING CAPACITY, SUITABILITY FOR USE, OR
PERFORMANCE OF THE SOFTWARE, NOT CONTAINED IN THIS AGREEMENT SHALL BE
DEEMED TO BE A WARRANTY, CONDITION, REPRESENTATION, OR GUARANTY BY
EMERSON. LICENSEE SHALL BE SOLELY RESPONSIBLE FOR MAINTAINING ALL APPROPRIATE
BACKUPS OF ITS DATA.

INTELLECTUAL PROPERTY INFRINGEMENT

Emerson will defend Licensee against any claim that the Software developed by Emerson
infringes a third party’s intellectual property right (including patent, copyright, design
right and trademark) protectable under the laws of the country where the Software is first
used (an “Intellectual Property Claim”). Emerson will only pay any final judgment or
settlement entered into by Emerson resulting from the action. Should an Intellectual
Property Claim arise, or if Emerson reasonably believes an Intellectual Property Claim will
arise, then Emerson may, at its sole option and expense, provide a commercially
reasonable alternative. This may include procuring for Licensee the right to continue using
the Software or replacing them with a non-infringing item or changing them to become
non-infringing or refunding their price. Emerson’s indemnity obligations are conditioned
upon Licensee: (a) promptly notifying Emerson in writing that an Intellectual Property
Claim has been threatened or filed; (b) allows Emerson complete control of the defense
and settlement of the claim; and (c) gives all reasonable help and cooperation requested
by Emerson for the defense.

Emerson will not be liable for infringement, and Licensee will indemnify Emerson, if the
claim arises from any of the following: (i) Licensee’s equipment, materials, specifications,
designs, processes or other technical information; (ii) Software is used by Licensee in
combination with other items not furnished by Emerson; or (iii) Licensee modifies or
otherwise causes the Software to become infringing. THE INDEMNIFICATION RIGHTS OF
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LICENSEE UNDER THIS SECTION 10 SHALL BE THE EXCLUSIVE REMEDY OF LICENSEE WITH
RESPECT TO CLAIMS OF INTELLECTUAL PROPERTY INFRINGEMENT.

LIMITATIONS OF LIABILITY

TO THE FULLEST EXTENT PERMITTED UNDER APPLICABLE LAW AND NOTWITHSTANDING
ANYTHING TO THE CONTRARY IN THIS AGREEMENT OR ELSEWHERE: (I) IN NO EVENT
SHALL THE AGGREGATE LIABILITY OF EMERSON AND ITS AFFILIATES EXCEED THE FEES
PAID FOR THE SOFTWARE, IF THE LICENSE TERM IS PERPETUAL, OR THE AVERAGE ANNUAL
FEES PAID FOR THE SOFTWARE, IF THE LICENSE TERM IS NOT PERPETUAL; (II) IN NO EVENT
SHALL EMERSON OR ANY EMERSON AFFILIATE BE LIABLE FOR ANY DAMAGES ARISING
FROM A CYBER ATTACK OR ANY INDIRECT, INCIDENTAL, PUNITIVE, CONSEQUENTIAL,
EXEMPLARY, SPECIAL, LOSS OF DATA, OR LOST PROFITS DAMAGES OF ANY KIND
(INCLUDING ANY LOST REVENUE, PROFITS, SAVINGS, BUSINESS OPPORTUNITIES, USE, OR
GOODWILL) HOWEVER ARISING, REGARDLESS OF WHETHER SUCH DAMAGES ARE
FORESEEABLE.

THE LIMITATIONS OF LIABILITY ABOVE SHALL APPLY: (A) TO ALL CLAIMS IN THE
AGGREGATE ARISING UNDER OR RELATING TO THIS AGREEMENT OR THE SUBJECT
MATTER OF THIS AGREEMENT; (B) REGARDLESS OF THE LEGAL OR EQUITABLE THEORY
UNDER WHICH THE CLAIM ARISES, INCLUDING BREACH OF CONTRACT, TORT (INCLUDING
NEGLIGENCE), INDEMNITY, STRICT LIABILITY, OR OTHERWISE; (C) REGARDLESS OF
WHETHER EMERSON HAS BEEN ADVISED OF THE POSSIBILITY OR LIKELIHOOD OF SUCH
DAMAGES; AND (D) REGARDLESS OF IF THE REMEDIES UNDER THIS AGREEMENT FAIL OF
THEIR ESSENTIAL PURPOSE. THE LIMITATION OF LIABILITY IS AN AGGREGATE LIMIT AND
WILL NOT BE INCREASED BY THE EXISTENCE OF MORE THAN ONE CLAIM.

THE DISCLAIMER OF WARRANTIES AND LIMITATIONS OF LIABILITY CONTAINED IN THIS
AGREEMENT ARE FUNDAMENTAL PARTS OF THE BASIS OF THE PARTIES’ BARGAIN
HEREUNDER, AND LICENSEE ACKNOWLEDGES THAT SUCH PROVISIONS REPRESENT A
REASONABLE ALLOCATION OF RISK. IF THE FOREGOING LIMITATION OF LIABILITY IS
UNENFORCEABLE UNDER APPLICABLE LAW, THEN EMERSON’S LIABILITY UNDER THIS
LICENSE SHALL BE LIMITED TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW.

GOVERNING LAW

This Agreement, and all matters concerning its construction, interpretation, performance
or validity, shall be governed by the laws of the State of Missouri, excluding its conflict
laws. Each Party shall institute and maintain any legal suit, action, or proceeding arising
out of or relating to this Agreement in the federal or state courts in each case located in
the State of Missouri. EACH PARTY HEREBY IRREVOCABLY AND UNCONDITIONALLY: (A)
CONSENTS AND SUBMITS TO THE EXCLUSIVE JURISDICTION OF THE AFOREMENTIONED
COURTS; AND (B) WAIVES ANY OBJECTION TO THAT CHOICE OF FORUM BASED ON VENUE
OR TO THE EFFECT THAT THE FORUM IS NOT CONVENIENT. The 1980 United Nations
Convention on Contracts for the International Sale of Goods does not apply to this
Agreement.

EXPORT RESTRICTIONS

The Software, Documentation, and any related technical data included with, or contained
in, such Software, and any products utilizing any such Software, Documentation, or
technical data (collectively, "Regulated Products") may be subject to US export control
laws and regulations, including the Export Administration Regulations and the
International Traffic in Arms Regulations. The Customer shall not, and shall not permit any
third parties to, directly or indirectly, export, reexport, or release any Regulated Products
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to any jurisdiction or country to which, or any party to whom, the export, reexport, or
release of any Regulated Products is prohibited by applicable federal or foreign law,
regulation, or rule. The Customer shall comply with all applicable federal and foreign laws,
regulations, and rules, and complete all required undertakings (including obtaining any
necessary export license or other governmental approval), prior to exporting or
reexporting any Regulated Products.

U.S. GOVERNMENT RIGHTS

The Software is commercial computer software, as such term is defined in 48 C.F.R.
§2.101. Accordingly, if the Licensee is the US Government or any contractor therefor,
Licensee shall receive only those rights with respect to the Software and Documentation
as are granted to all other end users under license, in accordance with (a) 48 C.F.R.
§227.7201 through 48 C.F.R. §227.7204, with respect to the Department of Defense and
their contractors, or (b) 48 C.F.R. §12.212, with respect to all other US Government
licensees and their contractors.

NUCLEAR APPLICATIONS

THE SOFTWARE IS NOT FOR USE IN ANY NUCLEAR AND RELATED APPLICATIONS. Licensee
accepts the Software with the foregoing understanding and agree to indemnify and hold
harmless Emerson from any claims, losses, suits, judgments and damages, including
incidental and consequential damages, arising from such use, whether the cause of action
be based in tort, contract or otherwise, including allegations that Emerson’s liability is
based on negligence or strict liability.

THIRD PARTY SOFTWARE

To the extent that a third-party owns any portion of the Software licensed under this
Agreement, such third-party owner shall be a beneficiary of this Agreement and shall have
the right to enforce its rights under this Agreement independently of Emerson. Any third-
party Software, not licensed under this Agreement, shall be subject to third-party owner’s
applicable license agreement and registration requirement, and Licensee authorizes
Emerson to provide its contact information, including company name, mailing address,
telephone number, ship-to recipient address, and primary contact’s name, mailing
address, telephone number, and email address, to such third-party owner for the purposes
of product registration, support, and compliance with applicable import and export
control laws, regulations, orders, and requirements.

GEOGRAPHIC RESTRICTIONS

The Software is provided for use only within (a) the Republic of India, for Software which is
delivered to Licensee in the Republic of India, (b) the People’s Republic of China, for
Software which is delivered to Licensee in the People’s Republic of China, (c) Malaysia, for
Software which is delivered to Licensee in Malaysia, or (d) the Republic of Indonesia, for
Software which is delivered to Licensee in the Republic of Indonesia. If the Software is
delivered to Licensee in one of the foregoing countries, Licensee agree to use the Software
only within the Republic of India, the People’s Republic of China, Malaysia, or the Republic
of Indonesia as applicable. If Licensee transfers the Software to any other country, this
license is automatically terminated, and the transfer shall be void.

AUDIT

Licensee agree that Emerson may audit Licensee’s facility and records to confirm
compliance with the terms of this Agreement during the License Term and for two years
thereafter. Emerson agrees to provide reasonable written notice prior to conducting such

Online Help Introduction
October 2023

AMS Machine Works v1.7.5 15



an audit and agrees to conduct the audit during regular business hours without
unreasonably interfering with Licensee’s normal business operation. No more than one
audit may be conducted in any twelve-month period unless Emerson reasonably and good
faith believes that Licensee is in violation of the terms of this Agreement. The Licensee
shall cooperate with Licensor's personnel conducting such audits and provide all
reasonable access requested by the Licensor to records, systems, equipment, information,
and personnel, including machine IDs, serial numbers, and related information.

ENTIRE AGREEMENT

LICENSEE ACKNOWLEDGES THAT LICENSEE HAS READ THIS AGREEMENT, UNDERSTANDS
IT, AND AGREES TO BE BOUND BY ITS TERMS AND CONDITIONS. LICENSEE FURTHER
AGREES THAT IT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF THE AGREEMENT
BETWEEN THE PARTIES WHICH SUPERSEDES ANY PROPOSAL OR PRIOR AGREEMENT,
ORAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN THE PARTIES
RELATING TO THE SUBJECT MATTER OF THIS AGREEMENT. This Agreement is for the sole
benefit of the parties hereto and their respective successors and permitted assigns and
nothing herein, express or implied, is intended to or shall confer on any other person or
entity any legal or equitable right, benefit, or remedy of any nature whatsoever under or
by reason of this Agreement. This Agreement may only be amended, modified, or
supplemented by an agreement in writing signed by each party hereto. No waiver by any
party of any of the provisions hereof shall be effective unless explicitly set forth in writing
and signed by the party so waiving. Except as otherwise set forth in this Agreement, no
failure to exercise, or delay in exercising, any right, remedy, power, or privilege arising
from this Agreement shall operate or be construed as a waiver thereof; nor shall any single
or partial exercise of any right, remedy, power, or privilege hereunder preclude any other
or further exercise thereof or the exercise of any other right, remedy, power, or privilege. If
any term or provision of this Agreement is invalid, illegal, or unenforceable in any
jurisdiction, such invalidity, illegality, or unenforceability shall not affect any other term or
provision of this Agreement or invalidate or render unenforceable such term or provision
in any other jurisdiction.

For purposes of this Agreement, (a) the words "include," "includes," and "including" shall be
deemed to be followed by the words "without limitation"; (b) the word "or" is not exclusive;
and (c) the words "herein," "hereof," "hereby," "hereto," and "hereunder" refer to this
Agreement as a whole. Unless the context otherwise requires, references herein: (x) to
Sections, Annexes, Schedules, and Exhibits refer to the Sections of, and Annexes,
Schedules, and Exhibits attached to, this Agreement; (y) to an agreement, instrument, or
other document means such agreement, instrument, or other document as amended,
supplemented, and modified from time to time to the extent permitted by the provisions
thereof and (z) to a statute means such statute as amended from time to time and
includes any successor legislation thereto and any regulations promulgated thereunder.
This Agreement shall be construed without regard to any presumption or rule requiring
construction or interpretation against the party drafting an instrument or causing any
instrument to be drafted.

The headings in this Agreement are for reference only and do not affect the interpretation
of this Agreement.

PRODUCT TERMS:

ADDITIONAL TERMS FOR AMS Machine Works Software: In no case may Licensee use AMS
Machine Works Software for control of plant processes. You may make, install, and use a

Introduction Online Help
October 2023

16 AMS Machine Works v1.7.5



reasonable number of copies of the Software solely for the purpose of facilitating your use
of the Software.
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2 Overview
AMS Machine Works combines predictive maintenance techniques with comprehensive
analysis tools to provide easy and accurate assessment of the machinery health in your
facility. AMS Machine Works brings together related data and prioritizes assets and alerts
based on your configuration.

AMS Machine Works v1.7.5 includes support for AMS Asset Monitor, AMS Wireless
Vibration Monitor, and the AMS 9420 Wireless Vibration Transmitter. The new Network
Device Module streamlines the process of managing a complex monitoring infrastructure
and also boosts performance.

AMS Machine Works provides a group of intuitive dashboards to help keep up with day-to-
day activities and machinery health. AMS Machine Works continues to be part of the
Plantweb™ Digital Ecosystem offering additional applications and asset sources.

AMS Machine Works applications

Configuration and interaction with the software happens through these applications,
which can be launched from a web browser:

• Asset Explorer — initiate configuration, access, and manage assets in your plant. See:
Asset Explorer

• Analysis Dashboard — view the status of your machines, devices, and the software at a
glance. See: Analysis Dashboard

• Network Device Module — configure data sources, data collections, check device
health, and handle store-on-alert functions. See: Network Device Module

• Event Viewer — view system generated events. See: Event Viewer

• Machine Configuration — configure monitored machines, map measurement
locations to device channels. See: Machine Configuration

• Alerts — configure the type of alert and the alert levels. See: Alerts

• Machine Journal — create journal entries and collaborate on maintenance issues for
your plant's machines. See: Machine Journal

• User Manager — control and monitor access to various areas of the software. See: User
Manager

• Vibration Analyzer — analyze data from machines. Vibration Analyzer can be launched
from a web browser, which will open the thick client application. However, the
vibration analyzer thick client application will have to be installed in the client machine
first. See: Vibration Analyzer

Essential system functions are performed by web services. These services may or may not
have a user interface. Examples of services include processing measurement data and
communicating with monitoring devices.

An OPC UA server is available for sending scalar data from AMS Machine Works to any OPC
UA-compliant client system.
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Assets

An asset is any physical component such as a device, machine, or equipment being
monitored, or the logical representation of a physical asset.

In AMS Machine Works, assets are typically physical pieces of equipment, such as motors,
fans, pumps, etc.

Agents

An agent collects data from devices. This includes data about the devices themselves and
about the machines they are monitoring.

Examples of agents are the AMS Asset Monitor Agent, and the Emerson Wireless Gateway
Agent. The Emerson Wireless Gateway Agent collects data from wireless vibration devices
using a HART TCP connection to an Emerson Wireless Gateway.

2.1 AMS Machine Works Architecture
AMS Machine Works has three distinct architecture layers:
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Figure 2-1: AMS Machine Works Architecture

A. AMS Machine Works Application Layer — This layer contains several web applications for data
presentation, configuration, maintenance, security, and data integration. Connects to OPC UA Server.

B. AMS Machine Works Service Layer — This layer processes the vibration data for health, alerts,
aggregation, and calculating derived measurements. Manages machine trains, monitors alerts, and asses
the health of assets.

C. Network Device Module Layer — This layer connects to monitoring devices and collects vibration data.
Native measurements, device health, and status information data is sent to the Core Module.

2.2 System Components
The system is comprised of many components, described in the table below. Refer to the
System Guide for information about where the components are installed.
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Table 2-1: System components

Component Description

AMS Machine Works Web Services The AMS Machine Works Web Service provides the essential
software components and interfaces to the Network Device
Module, the Machine Configuration process, the Analysis
Dashboard, and the Machine Journal.

The AMS Machine Works Web Service also enables you to
create machines in Asset Explorer, perform analysis in AMS
Machine Works Vibration Analyzer, and log Journal Entries in
Machine Journal. It obtains data from various other
components, which can be installed on different servers.

Emerson Wireless Gateway Agent The Emerson Wireless Gateway Agent brings data into AMS
Machine Works from wireless devices such as the AMS 9420
Wireless Vibration Transmitter and AMS 9530 Wireless
Vibration Monitor.

AMS Asset Monitor Agent AMS Asset Monitor Agent enables you to bring data into
AMS Machine Works from an AMS Asset Monitor.

AMS Machine Works Vibration
Analyzer

The AMS Machine Works Vibration Analyzer enables
complex analysis of vibration data with predictive analysis
tools and a wide array of visualization options.
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3 Machine Configuration
You can set up monitored assets, and map monitoring assets to them, in AMS Machine
Works through the Machine Configuration process.

3.1 Definition of a Machine Train
In AMS Machine Works, to create a machine you create a Machine Train. Just like an
individual machine, a Machine Train is created by using templates for each Component.

Note
A Machine Train is made up of Component elements, which are also known as Asset
elements. These terms are interchangeable in the context of AMS Machine Works.

Table 3-1: Definition of Machine Train Components

Component Definition

Driver A Driver component provides the energy to
perform some work, for example, a motor or a
turbine.

Intermediate An Intermediate component, such as a
Gearbox, connects a Driver component and a
Driven component.

Driven A Driven component is typically performing
some work, such as pumping.

Coupling Between any two other components in a
Machine Train there is always a Coupling. The
default setting for a Coupling is Direct, and no
configuration is necessary.

Configurable options include: Right Angle,
Chain, and Belt. See: Coupling Components

Note
A Machine Train can only have one of each type of Component: Driver, Intermediate, and
Driven.

The smallest Machine Train is made from just one Component, e.g., a Fan.

The largest Machine Train is made from five Component elements, e.g., from a Motor, a
Coupling, a Gearbox, another Coupling, and a Pump.

Every type of Component, except for Coupling elements:

• Has a Library associated with it.

• Can have additional elements defined on it such as:
— Bearing elements: which have their own Library as well.

— Shaft elements: which can have a maximum of 9 Bearing elements per Shaft.
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— Measurement Location elements: There are 2 standard positions, Inboard and
Outboard, but you can define up to 14 more by using the Add Custom Position
feature to reach a total of 16.

3.2 Initiate the Configuration Process
Prerequisites

To perform Step 3: Channel Mappings, some monitoring assets must first be configured.
See: Network Device Module

To create a new Machine Train, use the Asset Explorer. See: Add a Machine Train

To edit an existing Machine Train, use the Analysis Dashboard, or the Asset Explorer.

Note
You can only configure one Machine Train at a time, but you can use Copy train to make
copies of a Machine Train to populate your site with identical Machine Trains. See: Copy
Machine Train

 CAUTION

Ensure that a Machine Train is properly configured before copying it. This will help you
avoid replicating errors.

Procedure

1. Open the Asset Explorer via the App Switcher.

a) The Asset Explorer can also be launched by a desktop shortcut, or by a
browser bookmark.

2. To add a Machine Train: Add a Machine Train

3. To edit a Machine Train: Edit a Machine Train

a) Alternatively you can initiate the process to edit a Machine Train via the
Machine Config option available in the Analysis Dashboard Subheader
Section.

3.3 Machine Configuration User Interface
Machine Configuration guides you through the process of creating the components of a
Machine Train.
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Figure 3-1: Machine Configuration navigation

A. This is the Location where the new Machine Train will be created.
B. Machine Train Details is the first step in the process, for selecting the machine

components, and naming the Machine Train.
C. Machine Details is the second step in the process, for adding information about the

components.
D. Channel Mappings is the third step in the process, for adding information about the

location of sensors.
E. Summary is the fourth step in the process, for reviewing and printing the configuration.

Also, you can perform Copy Train and Copy Alerts actions.
F. Previous is for navigating backwards in the configuration process.
G. Next is for navigating forward in the configuration process.

Note
Next changes to Finish at the final step.

To navigate between steps, click Previous, or Next, or click on any step in the
configuration progress indicator. You can only proceed to the next screen after
completing all required information on the current screen. You can skip between any
screens already completed. If you skip through the steps without configuring the details,
the Machine Configuration application will supply default values.

Note
While Machine Configuration will allow you to accept default values for many fields, in
order to perform thorough machine analysis, Emerson recommends that you provide as
complete and accurate information about your machines as possible.

3.4 Step 1: Add Machine Train Details
In this step you define the basic structure of your Machine Train. A Machine Train can only
have one of each type of component: Driver, Intermediate, and Driven. In between any
two of these components the system automatically adds a Coupling component. See:
Definition of a Machine Train

Note
At least one component must be selected to define a Machine Train.
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Figure 3-2: Machine Train Details - Driver Component

Procedure

1. Required: Name: Enter a name in this field.

2. Optional: Description: Add a description of the Machine Train.

3. Optional: Driver Component, select a type of Driver from the dropdown list:
• None (default): Select this if your Machine Train doesn't have a separate Driver

Component.

• Motor.

• Turbine.

Figure 3-3: Machine Train Details - Intermediate Component

4. Picture: When you select a component an image with a generic representation of
the component is automatically displayed in the grey box.
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5. Optional: Intermediate Component, select a type of Intermediate Component
from the dropdown list:
• None (default): Select this if your Machine Train doesn't have a Gearbox

Component.

• Gearbox: Select this if your Machine Train has a Gearbox Component.

Figure 3-4: Machine Train Details - Driven Component

6. Optional: Driven Component, select the type of Driven Component from the
dropdown list.
• None (default): Select this if your Machine Train doesn't have a Driven

Component.

• Pump, Fan, Agitator, Blower, Centrifuge, Compressor, Crusher, Generator,
Spindle: If you have one of these devices, make the appropriate selection.

• Generic: Select this if you have a Driven Component which isn't included in the
list.

7. Click Next to proceed to Step 2: Add Machine Details.

3.5 Step 2: Add Machine Details
In this step, you can set design and performance parameters for every Component. You
can configure the details for each of the components manually, or by using preconfigured
machine component templates stored in a Library.
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Procedure

1. Fill in the information for every Component in your Machine Train.

Note
Detailed information about every field is found in this chapter.

2. You can click on the Previous button at any time to go to the previous step.

3. Once you fill all of the required fields, you can click on the Next button, or directly
on a Step Name at the top of the screen, to change steps.

3.5.1 Using Libraries
Every type of Component, except for Coupling elements, has a Library associated with it.
Bearing elements also have a Library.

Each Library is configured to accept parameters which are relevant to that type of
element. Two element types, Motor components, and Bearing elements, have predefined
entries in their Library.

Motor Library
The Motor Library has predefined entries for a wide range of manufacturers and models.
You can search in the Motor Library for a specific Motor, see Search the Motor Library. If
you do not find an exact match, you can edit or create your own Motor definitions, see
Add a Motor to the Library.

Search the Motor Library

AMS Machine Works has a predefined Library of Motor components. You can search this
Library by Manufacturer and Model and select a definition for the Motor in your Machine
Train.
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Figure 3-5: Motor Library

A. Manufacturer — Search by manufacturer name.
B. + — Click plus to use this definition for the Motor component.
C. The total number of results which match your search parameters, or the total number of

possible items if there are no search terms entered.
D. Model — Search by model name.
E. X — Click X to Remove this definition from the Motor Component Library. You can only

delete user defined Motor components.

Note
Do not click X unless you are sure you want Remove a definition. There is no undo
function, or confirmation dialog, for the Remove function.

F. List of pages of results.

See also: Add a Motor to the Library

Add a Motor to the Library

Adding a Motor to the Library is similar to adding any other item to the Library. The most
important points to take into consideration are:

• Double check your configuration.

• Make sure that your combination of Manufacturer and Model information are unique,
so you do not accidentally overwrite a previously configured item.

In the bottom right corner of the Machine Details screen for the Motor is the Save to
Library button.

Note
This button is in a similar position for all Component types except for:

• Coupling elements. See: Coupling Components
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• Bearing elements. See: Add a Bearing to the Library

Figure 3-6: Save to Library Button

Click the Save to Library button to save the configuration to the Library.

Note
If the combination of Manufacturer and Model information are not unique then the
results of the operation can be unpredictable.

Bearing Library
The Bearing Library has predefined entries for a wide range of manufacturers and models.
You can search in the Bearing Library for a specific Bearing, see Add a Bearing. If you do
not find an exact match, you can edit or create your own Bearing definitions, see Add a
Bearing to the Library.

Add a Bearing

Any Component in AMS Machine Works which has a Shaft can have a Bearing added to
that Shaft. Each Shaft can have a maximum of 9 Bearing elements.

Figure 3-7: Add Bearing button in the Machine Parts Section

A. Shaft Name – (Required) A 60 character alphanumeric field for the name of the shaft
with a default value, "Motor Shaft #" along with the number of the Shaft element. (e.g.,
"Motor Shaft # 1")

B. Add Bearing button – Click the + button to open the Add Bearing window.
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Figure 3-8: Add Bearing Window

A. Manufacturer – Enables the user to search for a Bearing by manufacturer. Enter a
search phase, and then either click on the loupe icon, or press the enter key on your
keyboard to search.

B. Identifier – Enables the user to search for a Bearing by model. Enter a search phase, and
then either click on the loupe icon, or press the enter key on your keyboard to search.

C. Bearing Type – A dropdown list to filter the results with choices for Antifriction, Sleeve,
and Unknown.

D. + icon - Click plus, '+', to add this type of Bearing to the Shaft. You can perform multiple
actions without needing to close and reopen this window.

E. Show Details button - Click this triangle to display the detailed parameters of this
Bearing definition. This data is read only, to create a custom Bearing press the button
marked 'G' on this image, Create Custom Bearing.

F. X button – Click this button to delete a previously defined custom Library entry.
G. Create Custom Bearing button – Click this button to begin the custom bearing

configuration process. See: Add a Bearing to the Library
H. Close button – Click this to close the Bearing Library.

The following image shows Precalculated Data and Physical Data parameters that are
shown when you click the Show Details triangle. (The Show Details triangle is shown in
position 'E' in the image above.)
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Figure 3-9: Add Bearing Window - Show Details

For more information about the meanings and possible values of the Precalculated Data
and Physical Data see: Add a Bearing to the Library.

Figure 3-10: List of Defined Bearings

A. Number of defined bearings – This displays how many Bearing elements are mounted on
the specific shaft. The maximum is 9.

B. Bearing Identifier - This is the model number or name of this Bearing.
C. Lubrication Type – A dropdown list, with Grease and Oil options.
D. Bearing Type - A read only field which displays information that comes from the Library,

or the Create Custom Bearing process.
E. Location – A dropdown list with three kinds of locations to choose from: Inboard,

Outboard, and Custom. If the user selects Custom from the list, the Custom Bearing
Position creator will be opened. See: Add or Remove a Custom Position

F. X button – Click 'X' to remove this Bearing.
G. Save to Library button – This button operates on the Library for the Component, not

the Bearing. To create a custom Bearing see: Add a Bearing to the Library
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Add a Bearing to the Library

If you cannot find an exact match in the Bearing Library, you can edit or create your own
Bearing definition.

Note
It is important to be as precise as possible with your information when you create a custom
Bearing definition. Take care not to reuse existing Manufacturer and Bearing Identifier
information combinations, as this could result in confusion and error.

To begin the Create Custom Bearing process, start by adding a Bearing to a Shaft. (See:
Add a Bearing) In the Add Bearing window click Create Custom Bearing.

The Add Bearing window will then display the following Add Custom Bearing mode.
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Figure 3-11: Add Bearing — Add Custom Bearing

A. Manufacturer – (Required) The name of the manufacturer.
B. Bearing Identifier – (Required) The id number for your bearing. This number does not

need to be unique; the system allows the creation of two bearings with the same
identifier but with different manufacturer names.

Note
The combination of the Manufacturer name and Bearing Identifier must be unique.

C. Bearing Type – (Optional) A dropdown list with Antifriction as the default value. The
other options are Sleeve and Unknown. Fields D, E, F, G, H, I, J, K, and L are only shown
when Antifriction is selected.

D. FTF (Fundamental Train Frequency) – (Optional) The default value is 0. This field accepts
decimal numeric values between 0 and 1.

E. BPFI (Ball Pass Frequency Inner) – (Optional) The default value 0. This field accepts
decimal numeric values between 0 and 999.

F. BPFO (Ball Pass Frequency Outer) – (Optional) The default value 0. This field accepts
decimal numeric values between 0 and 999.

G. BSF (Ball Spin Frequency) – (Optional) The default value 0. This field accepts decimal
numeric values between 0 and 99999.

H. Number of Balls – (Optional) The default value 0. This field accepts decimal numeric
values between 0 and 999.

I. Ball Diameter (mm) – (Optional) The default value 0. This field accepts decimal numeric
values between 0 and 9999.

J. Pitch Diameter (mm) – (Optional) The default value 0. This field accepts decimal
numeric values between 0 and 9999.

K. Contact Angle – (Optional) The default value 0. This field accepts decimal numeric
values between 0 and 90.

L. Angle In Degrees? – (Optional) This checkbox is checked by default.
M. Save button – Click this button to save your custom Bearing in the Bearing Library.
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N. Cancel button – Click this button to exit without saving your changes.

Other Libraries
Every Component type in AMS Machine Works has a Library associated with it. There are
two exceptions to this rule:

• Coupling elements, do not have an associated Library.

• Bearing elements, have an associated Library. See: Bearing Library

Search a Library

In the top section of the basic description of every Component there is a Search Library
button.

Figure 3-12: Search Library Button

Click Search Library button to open the Machine Details window.
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Figure 3-13: Machine Details Library

A. Manufacturer — Search by manufacturer name.
B. + — Click plus to use this definition for the component.
C. The total number of results which match your search parameters, or the total number of

possible items if there are no search terms entered.
D. Model — Search by model name.
E. X — Click X to Remove this definition from the component Library.

Note
Do not click X unless you are sure you want Remove a definition. There is no undo
function, or confirmation dialog, for the Remove function.

F. List of pages of results.

Add an Item to a Library

Adding any item to a Library is similar to adding a Motor to the Library. The most
important points to take into consideration are:

• Double check your configuration.

• Make sure that your combination of Manufacturer and Model information are unique,
so you do not accidentally overwrite a previously configured item.

In the bottom right corner of the Machine Details screen for any Component is the Save
to Library button.
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Note
This button is in a similar position for all Component types except for:

• Coupling elements. See: Coupling Components

• Bearing elements. See: Add a Bearing to the Library

Figure 3-14: Save to Library Button

Click the Save to Library button to save the configuration to the Library.

Note
If the combination of Manufacturer and Model information are not unique then the
results of the operation can be unpredictable.

3.5.2 Add or Remove a Custom Position
For Driver, Intermediate, and Driven components the user can define an additional
Measurement Location by clicking the Add Custom Position button under the
component icon. The system allows you to define a maximum of 14 custom positions.
Previously defined custom positions can be deleted through the same process. The two
system-defined default locations, Inboard and Outboard, cannot be deleted.

Figure 3-15: Add Custom Position

A. Add Custom Position button – Opens the Custom Bearing Position window.
B. Sketch – Click somewhere on the sketch to add a custom position.
C. New Custom Position Name – This required field must have a name from one to 30

characters long which is unique within the context of the component.
D. Save Position button – Click this to save the custom position.
E. Close – Click this button, or the 'X' in the top right corner, to close the window without

saving the changes.
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Figure 3-16: Remove Custom Position

A. Add Custom Position button –Opens the ‘Custom Bearing Position’ window.
B. Delete Position – Chose this option to open the ‘delete’ mode.
C. Sketch – Click on a custom position on the sketch to delete it.
D. Yes button – Confirm that you want to delete the selected custom position.
E. No button – Cancel the removal process.
F. Save Position button – Save your changes.
G. Close – Click this button, or the 'X' in the top right corner, to close the window without

saving the changes.

3.5.3 Coupling Components
Between any two Component elements AMS Machine Works automatically adds a
Coupling component. By default, the Coupling Type is configured as Direct and does not
affect the output shaft speed. Coupling components do not have a Library associated with
them to store custom configurations.

The Coupling Type is represented by the following icons.
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Figure 3-17: Coupling Components - Icons

• Left icon: Direct

• Middle icon: Belt or Chain

• Right icon: Right Angle
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Figure 3-18: Coupling Details

A. Name – the name of the Coupling component. This is a required field with a default
value of, "Coupling #1", and a maximum length of 60 characters.

B. Description – additional information about the Coupling component. This optional field
has a maximum length of 255 characters.

C. Coupling Type – the type of coupling. This field is a drop-down list with Direct as a
default value, with options for Belt, Right Angle, or Chain.

D. If Coupling Type = Belt: Input Shaft Sheave Diameter (mm) – This optional field
accepts decimal numeric values less than or equal to 100000.

E. If Coupling Type = Belt: Output Shaft Sheave Diameter (mm) – This optional field
accepts decimal numeric values less than or equal to 100000.

F. If Coupling Type = Belt:
Belt Length (mm) – This optional field accepts decimal numeric values less than or
equal to 100000, but greater than the minimal belt length X.
X = π (d1+d2)/2+d1+d2
Where d1 is the Input Shaft Sheave Diameter, and d2 is the Output Shaft Sheave
Diameter.

G. If Coupling Type = Right Angle: Input Shaft Number of Teeth – This is a required field
which accepts positive whole numbers from 1 to 100000.

H. If Coupling Type = Right Angle: Output Shaft Number of Teeth – This is a required field
which accepts positive whole numbers from 1 to 100000.

I. If Coupling Type = Chain: Input Shaft Sprocket Diameter (mm) – This optional field
accepts decimal numeric values less than or equal to 100000.

J. If Coupling Type = Chain: Output Shaft Sprocket Diameter (mm) – This optional field
accepts decimal numeric values less than or equal to 100000.

K. If Coupling Type = Chain:
Chain Length (mm) -
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This optional field accepts decimal numeric values less than or equal to 100000, but
greater than the minimal belt length X.
X = π (d1+d2)/2+d1+d2
Where d1 is the Input Shaft Sprocket Diameter, and d2 is the Output Shaft Sprocket
Diameter.

3.5.4 Driver Components
A Machine Train in AMS Machine Works can have Driver Component. There are two kinds
of Driver Component to choose from:

• Motor components. See: Motor Components

• Turbine components. See: Turbine Components

See: Definition of a Machine Train

Motor Components
AMS Machine Works has a predefined Library of Motor components. These definitions can
be used to load a configuration for your Motor. If none of these configurations meet your
specific needs, you can fill in your own custom configuration. Your custom configurations
can be saved to the Library for future use. See: Add a Motor to the Library

Basic Information

Figure 3-19: Driver Component Basic information

1. Name – (Required) The default name is the asset type, #, and the number of this
type of asset (for example Motor#1). This is editable if the Machine Train has not
been saved. Once saved, you can only edit this information in the Asset Explorer.
See: Renaming Locations, Machine Trains, and Assets
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2. Description – You have the option to add a custom description of the asset. This is
editable if the Machine Train has not been saved. Once saved, you can only edit this
information in the Asset Explorer. See: Properties pane

3. Speed (RPM) – You can edit this field at any time. The field has a default value of
3600, and accepts integer values from 1 to 120000. When you select a Model from
the Library this value is overridden.

4. Manufacturer – You can edit this field at any time. When you select a Model from
the Library this value is overridden.

5. Model – You can edit this field at any time. When you select a Model from the
Library this value is overridden.

6. Search Library button – Click this button to open the component library. See:
Search the Motor Library

Motor Information

This section details the various fields and settings for Motor components.
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Figure 3-20: Motor Information

A. Orientation – The system allows selection orientation for the component. There are two
options available Horizontal, and Vertical. When you change the orientation, the
graphical representation of the Component also rotates.

B. Motor Type – This dropdown list contains every type of motor:
• AC Induction

• Synchronous

• DC

• Hydraulic

• Others

The system displays additional parameters related to the Motor Type that is selected.
C. Rated Speed (RPM) – This user editable field is automatically filled in from the Library

when you select a Manufacturer and Model. This field accepts whole number values
from 1 to 120000.

D. Power (HP) – This user editable field is automatically filled in from the Library when you
select a Manufacturer and Model. This field accepts whole number values from 0 to
50000.

E. Variable Frequency – This user editable field is only displayed for AC Induction motors.
This dropdown list contains two values, Yes and No. This field is automatically filled in
from the Library when you select a Manufacturer and Model.

F. Number of Poles – This user editable field is only displayed for AC Induction motors.
This field is automatically filled in from the Library when you select a Manufacturer and
Model. This field accepts whole number values from 0 to 48.
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G. Number of Rotor Bars – This user editable field is only displayed for AC Induction
motors. This field is automatically filled in from the Library when you select a
Manufacturer and Model. This field accepts whole number values from 0 to 500.

H. Number of Stator Slots – This user editable field is only displayed for AC Induction
motors. This field is automatically filled in from the Library when you select a
Manufacturer and Model. This field accepts whole number values from 0 to 501.

I. Frame Size – (Optional) This user editable field is automatically filled in from the Library
when you select a Manufacturer and Model. This alphanumeric field can be empty and
does not have a character limit.

J. Rated Voltage (Volts) – (Optional) This user editable field is automatically filled in from
the Library when you select a Manufacturer and Model. This field accepts whole
number values less than or equal to 20000.

K. Full Load Current (Amps) – (Optional) This user editable field accepts whole number
values less than or equal to 1000. By default, this field is empty.

Figure 3-21: Motor Orientation

In AMS Machine Works a Motor can be configured in either a Horizontal or Vertical
orientation.

Motor Parts

After that you enter the motor parameters, you can configure the parts that make up the
Motor. You can add a maximum of 9 bearings from the Library.
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Figure 3-22: Add a Bearing to the Motor Parts

A. Shaft Name – This a required field, with a 60 character limit, to name the shaft. It is
prefilled with the default name, "Motor Shaft #1".

B. Add Bearing button – Click the + button to display the Add Bearing window. See: Add a
Bearing

Turbine Components
AMS Machine Works can have a Turbine as a Driver Component. There is no predefined
Library of Turbine components, but you can create your own custom configurations.

To look for a custom configuration of a Turbine click Search Library. See: Search a Library
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Figure 3-23: Turbine Configuration

• Name — "Turbine #1" (Default)

• Speed (RPM) — 3600 (Default) This field accepts values from 1 to 120000.

• Orientation — You can select Horizontal (Default), or Vertical.

• Shaft Name — "Shaft #1" (Default)

For a Turbine you can add optional information:

• Add or Remove a Custom Position

• Add a Bearing

Once you have configured a Turbine you can click Save To Library.

For more information see: Add an Item to a Library.

3.5.5 Intermediate Components
AMS Machine Works supports only one kind of Intermediate Component, a Gearbox.
During this step, the user can enter basic information about the gearbox, or load the basic
information from a user created library of Gearbox components. The user then has a
choice:

1. (Default) 'I wish to only specify the output ratio speed' See: Gearbox Configuration
— Set Output Ratio

2. 'I wish to define the gearbox parts' See: Gearbox Configuration — Define Gearbox
Parts

In either case the user can define gearbox parts such as a Shaft, or a Bearing.
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Figure 3-24: Figure 17: Machine Details - Gearbox Information

A. Name — (Required) This alphanumeric field has a maximum length 60 characters, and a
default value of "Gearbox # 1".

B. Description — (Optional) This alphanumeric field has a maximum length of 255
characters.

C. Manufacturer — (Optional) This alphanumeric field is filled according to the user's
selection in the Library.

Note
If you are creating a new Gearbox definition this field is required. See: Add an Item to a
Library

D. Model — (Optional) This alphanumeric field is filled according to the user's selection in
the Library.

Note
If you are creating a new Gearbox definition this field is required. See: Add an Item to a
Library

E. Search Library button — Click this button to open the Library. See: Search a Library
F. Orientation — The component can have either a Horizontal or a Vertical orientation.

The graphical representation of the component will reflect its orientation.
G. I wish to define the gearbox parts radio button — This option allows you to define and

configure all the gearbox parts manually. When this radio button is selected, more
options are visible in the gearbox parts section.

Note
This option is not recommended due to the potential for error during the gearbox
configuration process.

H. I wish to only specify the output ratio speed radio button — This is the default option,
and it is highly recommended because it allows you to set the value of the ratio directly
rather than go through the complex process of defining all the parameters of a gearbox's
parts.

Note
It is strongly recommended that the user should use this default option.
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I. Ratio — This field is mandatory, but it is only editable when the ‘I wish to only specify the
output ratio speed’ radio button is checked. This field accepts decimal values greater
than or equal to 0.01 and less than or equal to 100.

Gearbox Configuration — Set Output Ratio
During this step, the user can define the number of shafts and bearings. This section is
valid only when the user selected the ‘I wish to only specify the output ratio speed’ radio
button in the previous step.

The default configuration has two shafts, and the user can add a third shaft. Each shaft can
have up to nine bearings.
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Figure 3-25: Gearbox Configuration — Set Output Ratio

A. Add Shaft button — By default a Gearbox has 2 shafts, but you can define one more.
B. Shaft Name — (Required) The user can define the name of the shaft. The system's default

value is "Gearbox Shaft #1".
C. Bearing Count — This number displays how many Bearing elements are mounted on

this shaft. Values can range from 0 to 9.
D. + Add Bearing button — when the user clicks this button the bearings library is

displayed. See: Add a Bearing
E. Remove Shaft button — If you currently have three shafts defined you can remove one.
F. Bearing Name — The name of the chosen bearing.
G. Lubrication Type — dropdown list with a choice between Grease and Oil.
H. Bearing Type — a non-editable field displaying information that comes from your

selection in the Bearing Library, or from the Create Custom Bearing process. See: Add a
Bearing to the Library

I. Location — A dropdown list where the user can select between three types of
Measurement Location:

A. Outboard
B. Inboard
C. Custom — When the user selects Custom from this list the Custom Bearing

Position creator is opened. See: Add or Remove a Custom Position

J. Save To Library button — When the user clicks this button the current parameters of the
asset are saved. See: Add an Item to a Library

K. X — Remove Bearing button — Remove this bearing.

Gearbox Configuration — Define Gearbox Parts
During this step the user can define how many Shaft, Bearing, and Gear elements the
Gearbox has. To begin this configuration the user must select ‘I wish to define the gearbox
parts’’ radio button shown here: Intermediate Components.

Note
This process is complex and has many interacting variables. It is strongly recommended
that the Gearbox Configuration — Set Output Ratio process should be used instead.
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Figure 3-26: Define Gearbox Parts

A. Ratio — This is calculated based on the number of teeth on the Input Shaft divided by the
number of teeth on the Output Shaft. (e.g., 10/100 = 0.1)

B. Add Shaft button — By default a Gearbox has 2 shafts, but you can define one more.
C. Shaft Name — The default name is 'Gearbox Shaft #' followed by 1,2, or 3. This is a

required field.
D. Add Gear button — A Gearbox must have at least one Gear on each shaft. It is not

recommended, but you can add up to 9 Gear elements per shaft.

Note
The maximum recommended configuration of Gear elements in a Gearbox is four (4).

E. Gear Name — The default value is equal to 'Gearbox Gear #' followed by a number. This
is a required field.

F. The number of Gear elements on this specific shaft.
G. Bearing tab — Click on this tab to see the list of Bearing elements and to Add a Bearing.
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H. Number of Teeth — The default value is 10. This value of this field must be a whole
number greater than or equal to 10. The maximum value of this field is 2000. The Ratio
is calculated and updated according to these fields.

I. X button – Click the "X" to remove the Gear, Shaft, or Bearing associated with the
button.

J. Output Shaft — Recommended configuration: One Gear element.
K. Intermediary Shaft — (Optional) Recommended configuration: Two Gear elements.

Note
If you are using an Intermediary Shaft, it must have two gears. The gear in the first
position meshes with the Gear on the Output Shaft, and the Gear in the second position
meshes with the Input Shaft.

Check the automatically calculated Ratio marked as 'A' on the figure above to ensure
that the configuration is correct.

L. Input Shaft — Recommended configuration: One Gear element.

3.5.6 Driven Components
In AMS Machine Works there are the following types of Driven Component:

• Pump — See: Pump Components

• Fan — See: Fan Components

• Other Driven Components — These Driven Components share a similar configuration
template.
— Agitator — See: Other Driven Components

— Blower — See: Other Driven Components

— Centrifuge — See: Other Driven Components

— Compressor — See: Other Driven Components

— Crusher — See: Other Driven Components

— Generator — See: Other Driven Components

— Spindle — See: Other Driven Components

— Generic — See: Other Driven Components

Note
Use a Generic Driven Component if you do not see the specific type of equipment
you want to configure in this list.

Pump Components
For a Pump Component the user can enter and configure basic information about the
Pump such as its Speed (RPM), Orientation, and Rotor Support Type.

Further details can be recorded such as how many Stage or Bearing elements it has.
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You can use a combination of Manufacturer and Model information to search for a
particular configuration in the Library, or to save the current configuration to the Library.

• Search a Library

• Add an Item to a Library
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Figure 3-27: Pump Configuration

A. Name – (Required) This alphanumeric field contains the name of the Pump, and has a
default value of "Pump #1".

B. Description – (Optional) This alphanumeric field can contain additional information
about the asset.

C. Speed (RPM) – (Required) For a full 5 element Machine Train this field is calculated
based on the configuration of previous elements in the Machine Train.

Note
For other Machine Train configurations, the Driven component has either a calculated
value, or a default value of 3600. This field is editable and accepts whole numbers from 1
to 120000.

D. Manufacturer – (Optional) This field is filled when you do a Library search. It is also used
to define a new entry in the Library.

E. Model – (Optional) This field is filled when you do a Library search. It is also used to
define a new entry in the Library.

F. Search Library – Click this button to begin a search of the Library for this Component.
See: Search a Library

G. Orientation – (Optional) This field is a dropdown list with a choice between:
A. Horizontal (Default)
B. Vertical

The icon representing the Component changes its orientation to reflect the selection.
H. Rotor Support Type – This field is a dropdown list with a choice between:

A. Center (Default)
B. Over Hung

I. Shaft Name – (Required) This alphanumeric field has a default value of "Pump Shaft".
J. Stage Tab – Contains a list of every defined Stage. There can be from 0 to 20 Stage

elements.
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Note
Click on the Bearing Tab to the right of the Stage Tab to see the list of Bearing elements
and to Add a Bearing.

K. Add Stage button – Click this button to add a Stage. (Maximum: 20)
L. Stage Name – (Required) This alphanumeric field contains the name of the Stage, and

has a default value of "Pump Stage #" and a number.
M. Number of Impeller Vanes – (Required) This field accepts a whole number from 0

(default) to 100.
N. Number of Diffuser Vanes – (Required) This field accepts a whole number from 0

(default) to 100.
O. X button – Click to remove a Stage.

Note
If the Bearing Tab open, this button will remove a Bearing.

P. Save to Library button – When the user clicks this button, the configuration is saved to
the Library. See: Add an Item to a Library

Note
If this combination of Manufacturer and Model information for that Component are in
use, then you will overwrite the previous definition in the Library.

Fan Components
For a Fan Component the user can enter and configure basic information about the Fan
such as its Speed (RPM), Orientation, and Rotor Support Type.

Further details can be recorded such as how many Stage or Bearing elements it has.

You can use a combination of Manufacturer and Model information to search for a
particular configuration in the Library, or to save the current configuration to the Library.

• Search a Library

• Add an Item to a Library
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Figure 3-28: Fan Configuration

A. Name – (Required) This alphanumeric field contains the name of the Fan, and has a
default value of "Fan #1".

B. Description – (Optional) This alphanumeric field can contain additional information
about the asset.

C. Speed (RPM) – (Required) For a full 5 element Machine Train this field is calculated
based on the configuration of previous elements in the Machine Train.

Note
For other Machine Train configurations, the Driven component has either a calculated
value, or a default value of 3600. This field is editable and accepts whole numbers from 1
to 120000.

D. Manufacturer – (Optional) This field is filled when you do a Library search. It is also used
to define a new entry in the Library.

E. Model – (Optional) This field is filled when you do a Library search. It is also used to
define a new entry in the Library.

F. Search Library – Click this button to begin a search of the Library for this Component.
See: Search a Library

G. Orientation – This field is a dropdown list with a choice between:
A. Horizontal (Default)
B. Vertical

The icon representing the Component changes its orientation to reflect the selection.
H. Rotor Support Type – This field is a dropdown list with a choice between:

A. Center (Default)
B. Over Hung

I. Shaft Name – (Required) This alphanumeric field has a default value of "Fan Shaft".
J. Stage Tab – Contains a list of every defined Stage. There can be from 0 to 20 Stage

elements.
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Note
Click on the Bearing Tab to the right of the Stage Tab to see the list of Bearing elements
and to Add a Bearing.

K. Add Stage button – Click this button to add a Stage. (Maximum: 20)
L. Stage Name – (Required) This alphanumeric field contains the name of the Stage, and

has a default value of "Fan Stage #" and a number.
M. Number of Blades – (Required) This field accepts a whole number from 0 (default) to

100.
N. X button – Click to remove a Stage.

Note
If the Bearing Tab is open, this button will remove a Bearing.

O. Save to Library button – When the user clicks this button, the configuration is saved to
the Library. See: Add an Item to a Library

Note
If this combination of Manufacturer and Model information for that Component are in
use, then you will overwrite the previous definition in the Library.

Other Driven Components
For other Component types, the user can enter and configure basic information about the
Component Type such as its Speed (RPM), and Orientation.

Further details can be recorded such as the Shaft name, or how many Bearing elements it
has.

You can use a combination of Manufacturer and Model information to search for a
particular configuration in the Library, or to save the current configuration to the Library.

• Search a Library

• Add an Item to a Library

In this section there is information about all the remaining Driven Component elements.
This example uses a Spindle, but the configuration is similar for all the remaining Driven
Component elements.

Note
If you have a type of equipment which is not listed here, use the Generic component.

Figure 3-29: Icons of the Other Driven Components

From left to right: Agitator, Blower, Centrifuge, Compressor, Crusher, Generator,
Generic, and Spindle.
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Figure 3-30: Configuration of Other Driven Components

A. Name – (Required) This alphanumeric field contains the name of the Driven
Component, and has a default value of "Component Type" + " #1".

B. Description – (Optional) This alphanumeric field can contain additional information
about the asset.

C. Speed (RPM) – (Required) For a full 5 element Machine Train this field is calculated
based on the configuration of previous elements in the Machine Train.

Note
For other Machine Train configurations, the Driven component has either a calculated
value, or a default value of 3600. This field is editable and accepts whole numbers from 1
to 120000.

D. Manufacturer – (Optional) This field is filled when you do a Library search. It is also used
to define a new entry in the Library.

E. Model – (Optional) This field is filled when you do a Library search. It is also used to
define a new entry in the Library.

F. Search Library – Click this button to begin a search of the Library for this Component.
See: Search a Library

G. Orientation – This field is a dropdown list with a choice between:
A. Horizontal (Default)
B. Vertical

The icon representing the Component changes its orientation to reflect the selection.
H. Shaft Name – (Required) This alphanumeric field has a default value of "Component

Type " + " Shaft".
I. Bearing Tab – The Bearing Tab has a number from 0 to 9 indicating how many Bearing

elements are defined, and lists them. See: Add a Bearing.
J. Save to Library button – When the user clicks this button, the configuration is saved to

the Library. See: Add an Item to a Library
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Note
If this combination of Manufacturer and Model information for that Component are in
use, then you will overwrite the previous definition in the Library.

3.6 Step 3: Channel Mappings
In AMS Machine Works, channels have to be mapped to measurement locations on a
machine to which a sensor is mounted. Mapping assigns the sensor channel of the device
that is monitoring the asset to a measurement point on the asset.

The Channel Mapping process consists of creating a relationship between the sensors
defined in the Network Device Module to the Machine Train components that you have
defined in the previous two Machine Configuration steps.

Procedure

1. Fill in the information on the screens in the following sections.

2. Verify the information.

3. Proceed to the final step: Step 4: Summary

When you proceed to Step 4: Summary the Machine Train configuration will be saved.

3.6.1 Channel Mapping Interface
This window is divided into four panes which brings together the information defining the
relationship between a Machine Train and its Sensor data.

The Network Device Module provides the functionality for configuring and discovering
every Sensor which is available on your network. See: Network Device Module
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Figure 3-31: Channel Mapping Interface

A. Network Device Pane
B. Asset Pane
C. Measurement Pane
D. Custom Position Pane

Network Device Pane
The Network Device Pane displays the list of registered and discovered devices that the
system currently has access to. AMS Machine Works enables you to manage the Devices
on this list. Devices that are added or removed by the options available in the Network
Device Pane are still available elsewhere in AMS Machine Works. To make permanent
additions and deletions, use the functionality found in the Network Device Module.

Online Help Machine Configuration
October 2023

AMS Machine Works v1.7.5 59



Figure 3-32: Network Device Pane

A. Add Device – Click this button to choose devices from the list of defined devices. There is
no possibility to add a new device to the system using this option.

B. Refresh Devices – Click this button to refresh the list of devices. This is especially useful
for wireless devices such as the AMS 9530 Wireless Vibration Monitor, and the AMS 9420
Wireless Transmitter. Wireless device discovery in AMS Machine Works can take several
minutes, especially if there are many devices and your network infrastructure is weak.

Note
If you do not see your device yet, please wait and try refreshing the device list again. You
can be sure that a device has completed discovery in AMS Machine Works data becomes
visible in the Device Parameters tile in the Device Details screen in the Network Device
Module.

When you click Add Device button in Network Device Pane the Add Device Window
opens.
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Figure 3-33: Add Device Window

A. Search by name - This field enables you to search by the device name. Type your search
term and then press Enter, or click the magnifying glass icon, to search.

B. Device type – This dropdown list enables the user to narrow their search to one type of
device at a time. The list contains the following options:

A. AMS Wireless Vibration Monitor
B. AMS 9420
C. AMS Asset Monitor
D. All

C. Checkbox – Enables you to select a single device, multiple devices, or all devices. To
select all devices, click the checkbox at the top of the column.

Note
Devices which are already present in the Network Device Pane cannot be added a
second time, so you cannot click their Checkbox.

D. Ok button – Click Ok to confirm your choice and close the window.

Asset Pane
This pane displays the Asset/Component elements, except for Coupling components,
that the Machine Train is composed of. See: Definition of a Machine Train.

Note
In AMS Machine Works the terms Asset and Component can be used interchangeably.

The user can quickly switch between each Asset to check the mappings by clicking on the
Component Icon. The user can select a specific position (Inboard, Outboard, or Custom)
for the given asset – for example, if the user selected the outboard position in the sketch,
the list of available locations for this position only should be displayed in the
measurements pane.
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Figure 3-34: Asset with Custom Position Selected

A. Custom Position — This Custom Position is currently selected on the Component Icon.
B. Measurement Tabs — When you click on a tab, a list of the measurement points for that

position is displayed. There are four possible tabs:
A. All Measurements — This tab displays every available Measurement Location for

this Machine Train, including every Custom Position.
B. Inboard — Torque enters the Component from this side.
C. Outboard — Torque exits the Component from this side.
D. Selected Custom Location — (Optional) If you select a Custom Position that you

defined in Add or Remove a Custom Position process in Step 2: Add Machine
Details, it will be displayed here.

Note
When you select any Measurement Location on the Component Icon your view
switches to the corresponding Measurement Tab.

Measurement Pane
In the Measurement Pane, a user can either drag and drop a Device to an Acquisition
Channel field next to the desired Measurement Location or simply highlight a Device and
then click in the Acquisition Channel field to map it.
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Figure 3-35: Measurement Pane

A. Measurement Tabs — When you click on a tab, a list of the measurement points for that
position is displayed. There are four possible tabs:
• All Measurements — This tab displays every available Measurement Location for

this Machine Train, including every Custom Position.

• Inboard — Torque enters the Component from this side.

• Outboard — Torque exits the Component from this side.

• Selected Custom Location — (Optional) If you select a Custom Position that you
defined in Add or Remove a Custom Position process in Step 2: Add Machine Details,
it will be displayed here.

Note
When you select any Measurement Location on the Component Icon your view
switches to the corresponding Measurement Tab.

B. AUTOMAP button – This option can automatically assign the three axes of an AMS
Wireless Vibration Monitor to the proper acquisition channels of a Measurement
Location.

Note
This option is only available for an AMS Wireless Vibration Monitor which is configured in
a vertical position, and a Measurement Location which has no channels mapped.

C. Active – Enables you to mark Measurement Points as active or not.
D. Point Id – (Required) This 30 character alphanumeric field is the name of a

Measurement Point, and must be unique in the context of the Component. The system
will supply a unique default Point Id, but you can create your own if you require.

E. Acquisition Channel – The name of the sensor or channel mapped to the specific
acquisition channel. If you want to map a sensor or channel to the acquisition channel,
you need to select a sensor or channel from the Network Devices tree and drag and drop
the selected position to the acquisition channel. On the left side of the name of the
sensor, you can see a ‘check‘ icon – which means, that the specific sensor or channel is
mapped. Also, the user can remove the mapped sensor or channel from the acquisition
channel – can do this by pressing the ‘x’ icon display before the name of the sensor or
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channel. If you want to remap a sensor or a channel that is already mapped, you can do
it. The mapped sensor or channel will be unmapped from its previous position and
mapped to the new one.

F. Description – (Optional) This 60 character alphanumeric field is available for additional
description of each point ID.

G. Device Path – Information about how the sensor is accessed. This is composed of the
following elements: (Device Name, Charm Name, External Point Name, Device
Parameter Name) / (Axis Name, Sensor Name).

H. Position – The position type is Inboard, Outboard, contains the name of the Custom
Position.

I. Orientation – For system defined points there are three possible values:
A. Horizontal
B. Vertical
C. Axial
D. Two more options are available for custom measurement locations: Other and

Horizontal + Vertical.

J. Shaft – The name of the Shaft element where the bearing is mounted.
K. X button – The 'X' enables you to remove measurement points for custom measurement

locations.

Note
System defined points for Inboard, and Outboard locations cannot be removed.

L. Add Measurement Location – You can add more custom measurement locations.
(Maximum: 41)

Custom Position Pane
The bottom section of the Measurement Pane displays every Custom Position that exists.
The data for a Custom Position is the same as for a standard Inboard Position or
Outboard Position in the Measurement Pane. The only difference is that you can remove
all previously defined custom positions.

Figure 3-36: Custom Position List

3.7 Step 4: Summary
Prerequisites

Step 3: Channel Mappings must be completed, which saves the Machine Train.

During this step, the user can check all the data that they entered during the previous
steps:
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• Step 1: Add Machine Train Details

• Step 2: Add Machine Details

• Step 3: Channel Mappings

Note
If you are in Step 4. Summary because you are creating a new machine train, then the
Machine Alerts list will be empty.

It is not possible to immediately define an Alert for a new Machine Train. To begin this
process see: Edit Alerts

Procedure

1. Required: Review all the information that you have entered, and all the default
values that have been supplied by the system, for both correctness and
completeness.

a) Perform any necessary edits.

b) Proceed to the next step when your review is complete.

2. Click Finish.

Your Machine Train configuration is complete.

Note
If this is a new Machine Train, there are no Alerts defined for it. You can add an Alert to
this Machine Train, with the Edit Alerts process.

Some additional tasks you may want to perform are:

• You can Print a Machine Train Summary for your records, or as part of your review
process.

• Edit the Alerts for this Machine Train with the Edit Alerts process.

• Make multiple copies of this Machine Train with the Copy Machine Train process.

• Copy the Alerts which are defined for this Machine Train to other Machine Trains or
Components with the Copy Alerts process.

3.7.1 Print a Machine Train Summary
Prerequisites

If you want to print the report as a PDF, ensure that a PDF generator is installed on the
computer. Contact your IT department if you do not have a PDF option in your list of
printers.

You can print a Machine Train Summary for your records or as part of your review process.
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Figure 3-37: Print a Machine Train Summary

Procedure

1. In the Step 4. Summary of the Machine Configuration process click Print.

In the Print Preview window that opens:

2. Configure the print options which are available for your printer. Contact your IT
department for support when configuring these options.

3. Click Print: To print the Machine Configuration Summary.

4. Click Cancel: To exit without printing.

3.7.2 Copy Machine Train
When you are creating or editing a Machine Train the Copy Train option is available in the
last step of the Machine Configuration process. This is the only way to copy a Machine
Train. You have the option to create an arbitrary (n) number of duplicates of the current
Machine Train in a specific place in the Location hierarchy.

Note
This process will copy all the Machine Train details except for the mappings of device
channels to machine Measurement Locations.

 CAUTION

Ensure that a Machine Train is properly configured before copying it. This will help you
avoid replicating errors.
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Procedure

1. From the Step 4: Summary in the Machine Configuration process, click Copy
Train. (Marked A)

The Copy Trains dialog appears.

2. In the Copy Train window, select the Location (Marked B) in the hierarchy where
you want to copy the configuration. Enter the number of copies to create (Marked
C), and click the Submit button (Marked D) to confirm your choices.

Click the Close Window control, or the Cancel button (Marked E) to Cancel this
process.

Figure 3-38: Copy Train dialog

The window closes and your view returns to the Machine Configuration Step 4:
Summary page. The Machine Trains you created are now visible in the Location
pane of the Asset Explorer and other applications that show the Location hierarchy.

3.7.3 Copy Alerts
When you are creating or editing a Machine Train the Copy Alerts option is available in
the last step of the Machine Configuration process. This is the only way to copy an Alert.
You may perform a copy operation to a broad mix of Asset and Machine Train elements
simultaneously.

Note
In order to avoid the replication of errors, it is recommended that you verify the items you
are about to copy before performing a Copy Alerts operation.
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Procedure

1. From the Step 4: Summary in the Machine Configuration process, click Copy
Alerts. (Marked A)

The Copy Trains dialog appears.

2. In the Copy Alerts window, select a source Component (Marked B) from the
Machine Train you are editing to be your Alert source.

3. Use the checkboxes to select the Component and Machine Train elements that you
want to Copy Alerts to. (Marked C)

4. Click the Submit button (Marked D) to confirm your choices.

Click the Close Window control, or the Cancel button (Marked E) to Cancel this
process.

Figure 3-39: Copy Train dialog

The window closes and your view returns to the Machine Configuration Step 4:
Summary page. The Alerts have now been copied from the source Component to
the Component and Machine Train elements you selected.
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4 Alerts
An Alert allows you to define how your AMS Machine Works system reacts to the data it
collects.

You can define an Alert once you have mapped an Asset Source Channel to a
Measurement Location. This mapping is done in Step 3: Channel Mappings of the
Machine Configuration process.

Note
Alert Hysteresis is set in the System Settings popup of the Analysis Dashboard.

• See: Analysis Dashboard.

• See: alert hysteresis

There are three Alert levels in AMS Machine Works:

1. Advise: 

2. Warning: 

3. Critical: 

There are four main types of Machine Alerts:

1. Upper Absolute: Lower values are acceptable, and the Alert levels are defined at
progressively higher values. (e.g., 0 to 0.99 are acceptable, and Advise is set at 1,
Warning is set at 2, and Critical is set at 3.)

2. Lower Absolute: Higher values are acceptable, and the Alert levels are defined at
progressively lower values. (e.g., Values above 3 are acceptable, and Advise is set at
3, Warning is set at 2, and Critical is set at 1.)

3. Inside Absolute Window: A middle value is defined as unacceptable, and the Alert
levels are defined at values progressively closer to the central value. (e.g., Values
close to 3 are unacceptable, so Advise is set at 0 and 6, Warning is set at 1 and 5,
and Critical is set at 2 and 4.)

4. Outside Absolute Window: A middle value is defined as acceptable, and the Alert
levels are defined at values progressively further from the central value. (e.g.,
Values close to 3 are acceptable, so Advise is set at 2 and 4, Warning is set at 1 and
5, and Critical is set at 0 and 6.)

Note
Predefined Device Alerts are currently unsupported in AMS Machine Works.

Note
Predefined Device Alerts are recommended alert settings for a device which are loaded
directly from a device, such as an AMS Wireless Vibration Monitor, or a CHARM located in
an AMS Asset Monitor.
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Note
AMS Machine Works enables you to set alerts for all available assets. However, any
changes to Predefined Device Alerts are not downloaded into any specific device. To edit
an alert within a specific physical device you must use the configuration application
included with that device.

4.1 Edit Alerts
When a Machine Train is first created it does not have any Alerts defined. There are two
ways to add alerts:

Procedure

1. You can access the Edit Alert function through the:

a) Asset Explorer: Edit Alerts

b) Analysis Dashboard: Configure Alerts

2. You can access the Copy Alerts function as described in the Copy Alerts section of
the Machine Configuration process. This process enables you to copy a single Alert,
or perform a bulk copy.

4.2 Alert Creator Screen
When you start the Edit Alerts process, your view is switched to a new browser tab with
the following screen.

Figure 4-1: Alert Creator Screen

A. Asset Sketches: Select the icons which represents the Component of the Machine Train
you want to edit.

B. Top Menu: There are controls to start the Add Alerts process, or to Refresh Alerts for
every Alert which exists for this Component.

C. Alert List: A list of every existing Alert for this Component.
D. SAVE CHANGES button — You must click this button to save any changes made on this

screen or through the Add Alerts process.
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4.2.1 Asset Sketches
This area has a graphical representation of every Asset you currently have available to edit
or set an Alert for.

This list contains every Asset defined for this Machine Train except the Coupling
elements.

You can set an Alert for a single Asset in a Machine Train at a time. To do more than one at
a time use the Copy Alerts process.

4.2.2 Top Menu
In this area, which is marked B on the Alert Creator Screen above, there are two buttons:

• Add Alerts — The Add Alerts button enables you to open a window with the list of the
measurements which are currently available to configure an Alert for.

• Refresh Alerts — The Refresh Alerts button can be used if a user has mapped or re-
mapped a channel to a location in another window while the user has had this window
open.

4.2.3 Alert List
The Alert List is initially empty for a new Machine Train.
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Figure 4-2: Alert List

A. Expand Details icon – Click this triangle to see the Configuration Type
• All Locations: (Default) If this setting is selected every Measurement Point on this

Asset with this type of Measurement will share the same Alert Type and Alert Levels.

• By Location: If this setting is selected every Measurement Point on this Asset with
this type of Measurement and this Alert Type can have different Alert Levels.

B. Click here to view link – Click this link to view and set the Alert Levels. This link is only
available when the Configuration Type is set to By Location.

C. X control – Click the 'X' to remove the Alert from the list.
D. All Locations radio button – enables you to set the same alert value for all bearing

locations. (Default) If this setting is selected every Measurement Point on this Asset with
this type of Measurement will share the same Alert Type and Alert Levels.

E. By Location radio button – If this setting is selected every Measurement Point on this
Asset with this type of Measurement and this Alert Type can have different Alert Levels.

F. Store on Alert Settings – This button is available only for wireless devices such as the
AMS Wireless Vibration Monitor and the AMS 9420. See: Store on Alert Settings

G. Include Location checkbox – Include this location in the alerts.
H. Alert Values – You can define different alert values for each measurement location.

• Upper Absolute and Lower Absolute need 3 values.

• Inside Absolute Window and Outside Absolute Window: need 6 values.

I. Alert Unit Mode – For some types of measurement a user can choose the Alert Unit
Mode. This field is a dropdown list that contains the following choices:
• Peak

• Peak-to-Peak

• RMS (Root Mean Squared)
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4.3 Add Alerts
When you click the Add Alerts button in the Top Menu of the Alert Creator Screen, you
will see the modal window with a range of configuration options.
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Figure 4-3: Add Alerts Window

A. Filter – by default all available measurement types are shown.
• You can remove all, and add all, measurement types by clicking on the filter icon,

.

• You can filter out a single measurement type by clicking the ‘x’ icon on the left side of
each filter. Those items are then no longer shown, and the 'x' turns into a '+'.

• Click on a '+' to add a measurement type back.

B. All Alerts – (Currently this tab is not displayed, and All Alerts are displayed by default.)
This tab contains all the available measurement types, including Predefined Device
Alerts.

C. Predefined Device Alerts – (Currently unavailable.) This tab contains Predefined Device
Alerts for the specific measurement. For the measurement available on this list alert’s
range values are completed. This tab is visible only if alerts are defined within the device
itself. You may choose to reuse these alerts as machine alerts. However, in many cases,
you may want to modify, disable, or create entirely new alerts for machines.

D. Select All – Click this box at the top of the column to select all available measurements
on the list.

E. Select – Click these boxes to select measurements individually.
F. Measurement – The name of the measurement. All measurements are provided from

devices mapped to a channel. To get more measurements, you can re-map your device,
or add another mapping.

G. Alert Type – Your selection in this field effects your configuration of Alert Level values.
You can select from four types of alerts:
• Upper Absolute – See: Alerts

• Lower Absolute – See: Alerts

• Inside Absolute Window – See: Alerts

Alerts Online Help
October 2023

74 AMS Machine Works v1.7.5



• Outside Absolute Window – See: Alerts

H. Advise alert level – The lowest alert level. See: Alerts
I. Warning alert level - The middle alert level. See: Alerts
J. Critical alert level - The highest alert level. See: Alerts

K. Unit – This field is a dropdown list for different measurement types. For some
measurements a user can change the default value, for example from G to meters/sec2.

L. Show Device link – Click the link to see the device and sensor or channel name that
provides this measurement.

M. Padlock icon – This icon indicates that the measurement is native to the device. A native
measurement can have its Store on Alert settings edited. See: Store on Alert Settings

N. Add button – Click this button to add these changes. See: Alert Creator Screen for the
location of the Save button.

O. Close button – Click this button to close the window and return to the Alert Creator
Screen.

4.4 Store on Alert Settings
The Store on Alert feature is triggered by data from wireless devices (AMS Wireless
Vibration Monitor and AMS 9420), and from data from AMS Asset Monitor (CHARM and
External Data Points).

Each type of device stores different types of Collection:

• AMS Wireless Vibration Monitor — Three types of Collection are stored:
— Waveforms + Spectra + Thumbnails

• AMS 9420 — One Collection is stored:
— Waveforms & Spectra

• AMS Asset Monitor — Every Collection is stored except for Scalars.

Store on Alert settings can be configured for all devices with native scalar measurements.

All the measurements selected in the device's Collection Details are stored whenever any
alert triggers. Data storage continues until the device exits all alert statuses.

The button that begins this configuration process is found in the Alert List.

During this step, you can set the Alert trigger level, and choose to store the Collection
data.
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Figure 4-4: Store on Alert Settings

1. Device — The Emerson Wireless Gateway / Measuring Device names.

2. Device Path — This is given as an axis that this measurement is aligned to for
wireless devices, and it is given as a CHARM name for a Device located in an AMS
Asset Monitor.

3. Measurement — The exact types of measurements. A lock symbol here indicates
that this is a primary measurement.

4. Store Collection — Click this checkbox if you want the data to be stored when the
Alert is triggered.

5. Alert Level trigger — Choose which level of Alert triggers the storage of data.
• Advise

• Warning

• Critical

6. Ok / Cancel — Click Ok to save your changes and exit, or click Cancel to exit without
saving your changes.
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5 Network Device Module
The Network Device Module provides the functionality for discovering and configuring
every data source which is available on your network.

Agents

There are two types of Agent which enable connections to every kind of Device:

• AMS Asset Monitor Agent

• Emerson Wireless Gateway Agent

See: Modifying Devices

Devices

There are three main types of Device which you can connect to:

• AMS Asset Monitor
— Each physical AMS Asset Monitor device has slots which hold CHARMs.

• Emerson Wireless Gateway
— Each physical Emerson Wireless Gateway device is able to give network access to

AMS Wireless devices within its signal range.

• Each physical AMS Wireless device should be appropriately located so that it can
return reliable data. There are two types of AMS Wireless device:
— AMS 9420

— AMS Wireless Vibration Monitor

Licenses

A License tag is required for every data source Channel. Each Channel consumes one
License tag, even if it generates more than one Waveform.

License tags are not assigned to a specific data source Channel, so you must have one for
every data source you have configured in order to ensure that data is being collected for
every Channel.

License tag evaluation is carried out when measurement data arrives. The evaluation
checks if the data source Channel has a valid License tag assigned to it.

In the User Menu found in the Header of Network Device Module windows you can check
how many License tags are still available. If you are an Administrator you can also access
the License Management Functions available in the User Manager application.

5.1 Network Device Module — Dashboard and
Sidebar
When you start the Network Device Module your first view is of the dashboard. This
dashboard is initially mostly empty until devices are connected to an Agent and
configured. The dashboard has a series of links on the left hand side to AMS Machine
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Works applications, and to the other two main areas of the Network Device Module,
Devices, and Agents.

The dashboard is divided into three main informational sections, Connection Status,
Device Health, and System Stats. These sections enable you to quickly find information
about all the elements of your monitoring infrastructure.

The doughnut diagrams, and the status lists below them, provide a way for you to quickly
find devices which meet your search criteria.
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Figure 5-1: Network Device Module - Dashboard and Sidebar

A. Analysis Dashboard — Switches to the Analysis Dashboard
B. Network Device Module - Dashboard and Sidebar — The current screen.
C. Network Device Module - Devices — Switches to the Devices view.
D. Network Device Module - Agents — Switches to the Agents view.
E. Asset Explorer — Switches to the Asset Explorer
F. Machine Journal — Switches to the Machine Journal
G. User Manager — Switches to the User Manager
H. Vibration Analyzer — Switches to the Vibration Analyzer

I. Event Viewer — Switches to the Event Viewer
J. Unit Settings — Switches to the Unit Settings view.

K. Online Help — Click the question mark icon to open the online version of this
documentation.

L. Connection Status — A doughnut diagram with an overview of the connection status of
your devices and agents. See: Connection Status

M. Device Health — A doughnut diagram with an overview of the health status of your
devices. See: Device Health

N. System Stats — A general overview of how many elements are currently configured in
the system. See: System Stats

O. User Menu — The User Menu has functions and information related to the current User,
License tags, and Language.

5.1.1 Header
The header of windows in the Network Device Module contains the User Menu.

Online Help Network Device Module
October 2023

AMS Machine Works v1.7.5 79



Figure 5-2: User Menu

A. User Info — The name of the current User.
B. Language — The current language is displayed along with a flag of a country where this

language is predominately spoken.
C. License Tags — The proportion of tags in use to the pool of available tags. (e.g.,

124/4566 means 124 tags used out of a pool of 4566 tags.)
D. Sign Out — Click Sign Out to exit your user session.

5.1.2 Connection Status
The Connection Status panel gives you a quick overview of the current connection status
of your monitoring infrastructure devices and agents. You can select devices with a
particular status from either the circular display or from the list of statuses below the
diagram.

There are three possible Connection Status statuses:

• Disconnected

• Connected

• Unknown
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Figure 5-3: Connection Status Panel

The Connection Status Diagram shows a proportional representation of the number of
devices with each connection status. The number in the center indicates how many
devices have the currently selected status.

Under each connection status, a list of network devices will appear along with the number
of devices. When you click on the network device, you will be directed to the Devices tab.

Statuses with no devices underneath will not be visible.

5.1.3 Device Health
The Device Health panel gives you a quick overview of the health of your monitoring
infrastructure devices. You can select devices with a particular status from either the
doughnut display or from the list of statuses below.

Device Health is given by one of two methods:

• Endpoint Health — This is the health of an endpoint device.

• Worst Connected Health — This is set to the lowest heath of a connected endpoint
device. For example, with an Emerson Wireless Gateway, the worst health of a
wireless device connected through that gateway. Or, in the case of an AMS Asset
Monitor, the worst health of a CHARM installed in that AMS Asset Monitor.

There are five possible Device Health statuses:

• Critical — Red

• Warning — Orange

• Advice — Yellow

• Good — Green
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• Unknown — Grey

Figure 5-4: Device Health Panel

1. Device Health Diagram — This doughnut chart shows a proportional
representation of the number of devices with each health status. The number in the
center indicates how many devices have the currently selected status. Critical is
selected.

2. Critical — This red section is currently selected and expanded, and there are 2
devices with this status.

3. Warning — This orange section is not selected, and we can see that there is 1 device
with this status.

4. Advice — This yellow section is not currently present because there are no devices
with this status.

5. Good — This green section is not selected and is not expanded. We can see that
there are 3 devices with this status.

6. Unknown — This grey section is not currently present because there are no devices
with this status.

5.1.4 System Stats
The System Stats panel has general information about your monitoring infrastructure.
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Figure 5-5: System Stats Panel

• Agents

• Network Devices
— Emerson Wireless Gateway

• Monitoring Devices
— AMS Asset Monitor

— AMS Wireless Vibration Monitor

— AMS 9420

Clicking on a specific row redirects to the Devices tab which lists all the devices and the
information for each device.

5.2 Devices
The Network Device Module handles the configuration and monitoring of three types of
device:

• AMS Asset Monitor devices

• Emerson Wireless Gateway devices

• AMS Wireless devices

Each kind of device has different measurement, self-monitoring, and data collection
capabilities that are explained in the following sections.
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5.2.1 AMS Asset Monitor Tab

Figure 5-6: AMS Asset Monitor Tab

1. AMS Asset Monitor Tab — When this tab is underlined with a blue line the AMS
Asset Monitor Tab is selected.

2. Search — Use this field to search for a particular device.

3. Connection Status — Filter the device list by Connection Status.

4. Device Health — Filter the device list by Device Health. See: Device Health

5. Clear — Clear the filtering parameters.

6. New Device — Add a new device. See: Modifying Devices

7. Change Agent — Change the agent responsible for handling this device. See:
Change Agent

8. Remove Selected — Use this to remove a device from the list.

9. Health Bar — The color of the vertical Health Bar matches the color and description
of the Device Health. See: Device Health

10. Checkboxes — The Change Agent function will affect each Device which has a
checkbox selected. Use the Checkbox at the top of the column to select every
Device.

11. Device Name — Name of the device.

12. Address — The IP address and port number for accessing this device.

13. Agent Name — The name of the agent communicating with the device.

14. Connection Status — This field can display Connected, Disconnected, or Unknown.

15. Device Health — This displays the health of the monitoring device: Critical,
Warning, Advice, Good, or Unknown. See: Device Health

16. Mapped Sources — This displays the number of measurement sources from the
total which have been mapped to a point on a Machine Train. (e.g., 10/61)

17. Labels — Any custom Label that is defined for the device is displayed here.

18. Mini Menu — Click these three dots to bring up a menu for modifying devices:
Update Credentials, Configure, and Delete. See: Modifying Devices
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AMS Asset Monitor Details
When you view the details of any device the header of the window displays a breadcrumb
path to the device. You can click on any item in the path to navigate between views.

Asset Monitor Details — Main Section

Figure 5-7: Main

1. Device Name

2. Asset Monitor Icon

3. Device Health Bar — Health is shown by a colored bar. See: Device Health

4. Connection Status — See: Connection Status

5. Device Health — This health is the same as the health of the Charm with the worst
health inside this Asset Monitor. The health information is written and color coded
to match. See: Device Health

6. Host — The IP Address of the Asset Monitor.

7. Port — The port used to access the Asset Monitor.

8. Add Label — Add a custom label for this Asset Monitor.

9. Modification Controls — Click one of these three controls, Update Credentials,
Configure, and Delete, to bring up a window for modifying devices. See: Modifying
Devices

10. More Details — This expandable section contains some contextual information
about the device.
• Agent Name — This is the name of which agent is being used to access this

device. See: Agents

• Type — The type of device.

• Description — Description of what the device is and what it does.

• Advanced Details — Click this file icon, , to display a .json file with technical
details about your device such as the firmware version, serial number, or other
technical details.

Collections

For more information about what is included in a Collection see: Collection Details
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Figure 5-8: Collections

1. Demand — When you have one or more Collection boxes marked you can use the
Demand button to refresh the data.

2. Selection boxes — Mark the Collections you want to Demand here.

3. Collection Name — The name of the Collection is displayed here. The name is
defined in the AMS Asset Monitor interface, and the instructions for this are
described in that product's documentation.

4. Number of measurements — This is the number of measurements defined in this
AMS Asset Monitor Collection.

5. Last collected date — The date and time of when data was last gathered.

6. Next occurrence date — The date and time of when data will be gathered next.

7. Demand status — Requested / Completed / Outdated / Not requested / Failed.
Also shows the progress of the request in percentage.

8. Demanded at — This is the date (MM/DD/YYYY) and time (HH:MM AM/PM) the
request was made at.

Sensors

Figure 5-9: Sensors

1. Sensor Filters — The Sensors can be filtered by four characteristics. Only the
Sensors which meet all of the conditions you apply will be displayed. Click Clear to
reset the filter.
• — Health — You can select the Sensors which have a particular Health.

— Sensor — For an AMS Asset Monitor this is either a CHARM or an External
Data Point.

— Sensor type — There is a wide range of Sensor type available for AMS Asset
Monitor.
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— License status — "Not applicable" / "Out of date" / "Up to date"

2. Health — Health is displayed by color code and text. See: Device Health

3. Sensor name — This name is set within the AMS Asset Monitor interfaces and is
documented within the AMS Asset Monitor documentation.

4. Sensor — This can be either CHARM or External Data Point.

5. Sensor type — CHARM sensors have a specific type, and External Data Point
sensors have no entry here.

6. Train info — Includes a hyperlink to the train in the Dashboard.

7. License status — The three possible statuses are: "Not applicable", "Out of date", and
"Up to date".

8. Measurement count — This column displays how many measurements the CHARM
is capable of delivering. An External Data Point can only deliver one measurement.

Measurement Definitions

Figure 5-10: Measurement Definitions

1. Filter Options — The Measurement Definitions can be filtered by four
characteristics. Only the Measurement Definitions which meet all of the conditions
you apply will be displayed. Click Clear to reset the filter.
• Measurement — You can filter for Measurement Definitions which have a

particular type. (Waveform, Spectrum, Scalar, Interval Band, Thumbnail, Peak
List)

• Sensor name — You can filter by Sensor name. For an AMS Asset Monitor there
can be custom names which are defined in the AMS Asset Monitor interface.

• Sensor — For an AMS Asset Monitor you can filter by CHARM or by External Data
Point.

• Collections — For an AMS Asset Monitor you can filter by the following types of
Collection: Scalars, Waveforms, or by a custom Collection defined on the AMS
Asset Monitor.

2. Measurement — A short description of the type of measurement.

3. Sensor name — The name of the sensor.

4. Sensor — This can be either CHARM or External Data Point.
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5. Collections — The name of the Collection that this data is gathered in.

6. Last collected value — The latest value along with the associated unit for that type
of Measurement.

7. Last collected date — A value along with a unit of time to indicate how long ago the
measurement was taken.

Device Parameters

Figure 5-11: Device Parameters

These are measurements of the measuring device itself.

1. Measurement — This column lists the type of Measurement, e.g., Temperature or
Voltage.

2. Last collected value — The latest value along with the associated unit for that type
of Measurement.

3. Last collected date — A value along with a unit of time to indicate how long ago the
measurement was taken.

Event Logs

Figure 5-12: Event Logs

1. Event Severity Indicator — This indicator gives a visual representation of the
severity of the Event. These match in color and severity to the Device Health scale.
For example, Red indicates a Critical Event, and Green indicates a Good Event.

2. Date — The date of the Event.

3. Event log type — The type of event, e.g., Network error or Network device
connected successfully.

Event Types

Table 5-1: 

Event Message Severity Recommended Action

Agent closing Warning

Authentication process failed Critical Check your credentials.
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Table 5-1: (continued)

Event Message Severity Recommended Action

Network device connected
successfully

Good None.

Connection broken Critical Check your network
connection to this device.

Network error Critical Check your network
connection to this device.

Unknown event log Unknown

Modifying Devices
The functions described below are available from the AMS Asset Monitor tab in the
Devices section of Network Device Module interface.

The functions to Modify, Update, or Delete an AMS Asset Monitor connection are also
available from the AMS Asset Monitor details page. See: AMS Asset Monitor Details

Figure 5-13: Add an AMS Asset Monitor
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1. Device Name — (Required) This is the name that you choose for this device within
AMS Machine Works. The maximum length is 100 characters.

2. Agent Name — (Required) This the name of the Agent which is facilitating the
connection. See: Agents

3. Address — (Required) This is the IP address where the AMS Asset Monitor is
located. The maximum length is 250 characters.

4. Port — (Required) The standard port is 443, and this value is filled in by default. In
some installations this port could be different. The valid range is from 1 to 65535.

5. Username — (Required) This is the Username for the AMS Asset Monitor account
you want to connect to.

6. Password — (Required) This is the Password associated with the Username for the
AMS Asset Monitor you want to connect to.

7. Description — (Optional) You can enter any useful description information or notes
here. The maximum length is 500 characters.

8. Cancel / Save — Click Cancel to exit without making changes, or click Save to save
your changes and exit

Figure 5-14: Modify an AMS Asset Monitor

You can edit a previously configured AMS Asset Monitor. All of the fields except for the
Description are required.

1. Device Name — (Required) This is the name that you choose for this device within
AMS Machine Works.

2. Address — (Required) This is the IP address where the AMS Asset Monitor is
located.
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3. Port — (Required) The standard port is 443, and this value is filled in by default. In
some installations this port could be different.

4. Description — (Optional) You can enter any useful description information or notes
here.

Figure 5-15: Update AMS Asset Monitor Credentials

You can change your access credentials for the AMS Asset Monitor.

1. Username — (Required) This is the Username for the AMS Asset Monitor account
you want to connect to.

2. Password — (Required) This is the Password associated with the Username for the
AMS Asset Monitor you want to connect to.

Figure 5-16: Delete an AMS Asset Monitor

If you want to Delete an AMS Asset Monitor device from your AMS Machine Works
installation, click Confirm. To exit without making any changes, click Cancel.

5.2.2 Emerson Wireless Gateway Tab
An Emerson Wireless Gateway is a device which enables communication with Emerson
wireless sensors, such as the AMS 9420, and the AMS Wireless Vibration Monitor.

The gateway can connect to all the AMS Wireless devices within range of its signal. The
signal strength is dependant on the operating environment and interference factors.
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When this tab is selected in the Devices area of the Network Device Module the following
screen is displayed.

Figure 5-17: Emerson Wireless Gateway Tab

1. Emerson Wireless Gateway Tab — When this tab is underlined with a blue line the
Emerson Wireless Gateway Tab is selected.

2. Search — Use this field to search for a particular device.

3. Connection Status — Filter the device list by Connection Status.

4. Worst devices health — Filter the device list by device health.

5. Clear — Clear the filter parameters.

6. Add New Device — Add a new device. See: Modifying Devices

7. Change Agent — Change the agent responsible for handling this device. See:
Change Agent

8. Remove Selected — Use this to remove a device from the list.

9. Checkboxes — Use these checkboxes to select which devices to use the Change
Agent function on.

10. Health Bar — This bar always appears as gray. The gateway does not have health on
its own.

11. Device Name — Name of the device.

12. Address — The IP address and port number for accessing this device.

13. Agent Name —

14. Connection Status — This field can display Connected, Disconnected, or Unknown.

15. Worst devices health — This displays the health of the monitoring device: Critical,
Warning, Advice, Good, or Unknown.

16. Labels — Any custom Label that is defined for the device is displayed here.

17. Mini Menu — Click these three dots to open a menu: Configure and Delete. See:
Modifying Devices

Emerson Wireless Gateway Details
When you view the details of any device the header of the window displays a breadcrumb
path to the device. You can click on any item in the path to navigate between views.
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EWG Details — Main Section

Figure 5-18: EWG Details

1. Emerson Wireless Gateway Icon

2. Device Name

3. Connection Status — See: Connection Status

4. Worst devices health — This health is the same as the health of the device with the
worst health connected to this gateway. The health information is written and color
coded to match. See: Device Health

5. Host — The IP Address of the Emerson Wireless Gateway.

6. Port — The port used to access the Emerson Wireless Gateway.

7. Add Label — Add a custom label for this Emerson Wireless Gateway.

8. Modification Controls — Click one of these controls, Configure, and Delete, to
bring up a window for modifying devices. See: Modifying Devices

9. More Details — The information contained here gives some context about the
device.
• Agent Name — This is the name of which agent is being used to access this

device. See: Agents

• Type — The type of device.

• Description — Description of what the device is and what it does.

Logical Devices

Figure 5-19: Logical Devices

1. Logical Devices — This is a list of the devices that have access to your AMS Machine
Works installation through this gateway. Click on any device in the list to go to the
AMS Wireless Details for that device.
• Search — Use this field to search for a particular device.

• Type — The type of the device connected through this gateway. (i.e., AMS
Wireless Vibration Monitor, or AMS 9420)
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• Device Health — This is the health of this particular sensor. Given in written form
and color coded to match. See: Device Health

• Device Name — The name of the device connected to through this gateway.

• Last Seen — The time the device was last in contact with the network. (e.g., a
minute ago)

• Labels — Any custom label you have defined and given to the device.

• Mapped Sources

• Mini Menu — Click here to open a menu: Bulk Configuration, Configure, and
Delete.

Event Logs

Figure 5-20: Event Logs

1. Event Severity Indicator — This indicator gives a visual representation of the
severity of the Event. These match in color and severity to the Device Health scale.
For example, Red indicates a Critical Event, and Green indicates a Good Event.

2. Date — The date of the Event.

3. Event log type — The type of event, e.g., Network error or Network device
connected successfully.

Event Types

Table 5-2: 

Event Message Severity Recommended Action

Agent closing Warning

Network device connected
successfully

Good None.

Connection broken Critical Check your network
connection to this device.

Network error Critical Check your network
connection to this device.

Unknown event log Unknown
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Modifying Devices

Figure 5-21: Add an Emerson Wireless Gateway

A. Device Name — (Required) This is the name that you choose for this device within AMS
Machine Works. The maximum length is 100 characters.

B. Agent Name — (Required) This the name of the Agent which is facilitating the
connection. See: Agents

C. Address — (Required) This is the IP address where the Emerson Wireless Gateway is
located. The maximum length is 250 characters.

D. Port — (Required) The standard port is 5094, and this value is filled in by default. In some
installations this port could be different. The valid range is from 1 to 65535.

E. Description — (Optional) You can enter any useful description information or notes here.
The maximum length is 500 characters.

F. Cancel / Save — Click Cancel to exit without making changes, or click Save to save your
changes and exit
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Figure 5-22: Modify an Emerson Wireless Gateway

You can edit a previously configured Emerson Wireless Gateway. All of the fields except for
the Description are required.

1. Device Name — (Required) This is the name that you choose for this device within
AMS Machine Works.

2. Address — (Required) This is the IP address where the Emerson Wireless Gateway
is located.

3. Port — (Required) The standard port is 443, and this value is filled in by default. In
some installations this port could be different.

4. Description — (Optional) You can enter any useful description information or notes
here.

Figure 5-23: Remove an Emerson Wireless Gateway

If you want to Remove an Emerson Wireless Gateway device from your AMS Machine
Works installation, click Confirm. To exit without making any changes, click Cancel.
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5.2.3 AMS Wireless Tab

Figure 5-24: AMS Wireless Tab

A. AMS Wireless Tab — When this tab is underlined with a blue line the AMS Wireless Tab
is selected.

B. Search — Use this field to search for a particular device.
C. Type — Filter the list accprding to device type.
D. Device Health — Filter the device list by Device Health. See: Device Health
E. Gateway Name — Filter the device list by which Emerson Wireless Gateway the devices

are connected to.
F. Clear — Clear any active filtering parameters. When this button is grey, there are no

active filters.
G. Health Bar — The color of the vertical Health Bar matches the color and description of

the Device Health. See: Device Health
H. Device Name — Name of the device.

I. Type — The Type of the device, e.g., AMS 9420, or AMS Wireless Vibration Monitor.
J. Device Health — This displays the health of the monitoring device: Critical, Warning,

Advice, Good,or Unknown. See: Device Health
K. Gateway Name — The name of the Emerson Wireless Gateway that acts as a gateway

for this device. It includes a hyperlink which leads to the page of the gateway.
L. Last Seen — How long ago the device was seen on the network. (number / unit of time /

ago)
M. Mapped Sources — A list of how many sources out of the total for that device are

mapped to a Machine Train. (e.g., 2/3, 2 out of three sources available in this device are
mapped to a Machine Train) See: Step 3: Channel Mappings

N. Labels — Any custom Label that is defined for the device is displayed here.
O. Mini Menu — Click these three dots to bring up a menu for Bulk Configuration: Bulk

Configure, Configure, and Delete. See: Bulk Configuration

AMS Wireless Details
When you view the details of any device the header of the window displays a breadcrumb
path to the device. You can click on any item in the path to navigate between views.
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Figure 5-25: Main Section

1. Device Health Bar — This bar represents the overall health of the device.

2. Device Name — The name of the device as configured.

3. Device Health — The overall health of the device is written and is color coded to
match. See: Device Health

4. Last Seen — How long ago the device was seen on the network. (number / unit of
time / ago)

5. Add label — Click this control to add a custom label to this device. You can add
more than one label. Labels are for informational purposes only.

6. Bulk configuration — Click this button to do bulk configuration of several settings.
See: Bulk Configuration

7. Configure — Click this button to modify the device name and set the Wireless Noise
Threshold (RMS) level.

8. Delete — Click this button to delete the device from the list.

9. More details — Click More details to expand the section and see the following three
items:
• Type — Shows the debice type.

• Device health details — Shows details about device health.

• Sensor health details — Shows details about sensor health.

• Additional statuses — Displays status messages about the device.

Collections

For more information about what is included in a Collection see: Collection Details

Figure 5-26: Collections

1. Demand — When you have one or more Collection boxes marked you can use the
Demand button to refresh the data.

2. Selection boxes — Mark the Collections you want to Demand here.

3. Collection Name — The name of the Collection.
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4. Number of measurements — This is the number of measurements defined in this
Collection.

5. Last collected date — The date and time of when data was last gathered.

6. Next occurrence date — The date and time of when data will be gathered next.

7. Demand status — Requested / Completed / Outdated / Not requested / Failed.
Also shows the progress of the request in percentage.

8. Demanded at — This is the date (MM/DD/YYYY) and time (HH:MM AM/PM) the
request was made at.

Figure 5-27: Sensors

1. Health — Health is displayed by color code and text. See: Device Health

2. Sensor name — This can be a custom name, or a standard one such as 'Z Axis'.

3. Train info — Includes a hyperlink to the train in the Dashboard.

4. License status — The three possible statuses are: "Not applicable", "Out of date", and
"Up to date"

5. Measurements count — This column displays how many measurements the sensor
is capable of delivering.

Figure 5-28: Measurement Definitions

1. Filter Options — The Measurement Definitions can be filtered by four
characteristics. Only the Measurement Definitions which meet all of the conditions
you apply will be displayed. Click Clear to reset the filter.
• Measurement — You can filter for Measurement Definitions which have a

particular type. (Waveform, Spectrum, Scalar, Interval Band, Thumbnail, Peak
List)

• Sensor name — For wireless devices you can filter by X Axis, Y Axis, and Z Axis.

• Collections — For wireless devices you can filter by the following types of
Collection: Scalars, Spectra, Thumbnails, Waveforms.
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2. Measurement — A short description of the type of measurement.

3. Sensor name — The name of the sensor. (X Axis, Y Axis, or Z Axis)

4. Collections — The name of the Collection that this data is gathered in.

5. Last collected value — The latest value along with the associated unit for that type
of Measurement.

6. Last collected date — A value along with a unit of time to indicate how long ago the
measurement was taken.

Figure 5-29: Device Parameters

1. Measurement — This column lists the type of Measurement, e.g., Temperature or
Voltage.

2. Last collected value — The latest value along with the associated unit for that type
of Measurement.

3. Last collected date — A value along with a unit of time to indicate how long ago the
measurement was taken.

Event Logs

This section shows the event logs of the device.

Bulk Configuration
Bulk Configuration is a four step process that takes one device as a source of a
configuration and copies it into other devices.

This configuration process is defined for AMS 9420 and AMS Wireless Vibration monitors.

Bulk configuration can be initiated from two places:

• From the Bulk configuration button in the main section of the AMS Wireless Details.

• From the '3-dot' menu on the right hand side of the AMS Wireless device list.

• From the '3-dot' menu in the Logical Devices list in Emerson Wireless Gateway Details.
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Figure 5-30: Step One — Select Configuration

Step One: Select one or both of the types of configuration information to copy to proceed
to the next step.

1. Scheduler Settings — These settings relate to the period between data collection
actions.

Note
The period is copied but its starting time is randomly offset to avoid network
congestion. The burst rate on the target device is also changed.

2. Collected Parameters — These settings relate to what data is collected.

3. Cancel / Next — Click Cancel to exit without making any changes. Click Next to
proceed to the next step.

Figure 5-31: Step Two — Select Devices to Copy

Step Two: Select the target devices for the configuration operation.
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1. Search — Use this field to search for a device.

2. Gateway Name — You can filter the device selection list by the gateway used to
gain access to those devices.

3. Clear — Click this button to clear the filter. This button is grey when no filter is set,
and blue when a filter is active.

4. Selection Checkboxes — Check the boxes next to the items you want to select, or
check the box at the top to select every item currently in the list.

5. Device Name — The name of each device.

6. Gateway Name — The name of the gateway used to gain access to the device.

7. Items per page — Select the number of items to display per page. (5, 10, 20, 50,
100)

8. Page Forward / Page Back — Use the arrows to navigate between different pages of
the device list.

9. Move Control — Click the Move Control to confirm your selections and transfer
those devices to the Selected Devices list.

10. Clear selection — Click the X next to an item to remove it from the list of selected
devices, or click the trashcan icon at the top to clear the entire list.

11. Previous — Click Previous to return to the previous screen.

Note
You can only cancel the process from the first screen.

12. Next — Click Next to proceed to the verification phase.

Figure 5-32: Step Three

Step Three: Review any warnings and apply your changes.

1. Warning Indicator — The colored status bar to the left of each device in the list
indicates if there are potential problems.
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2. Display Details — Click on any item in the list to display the warning message
details.

Figure 5-33: Step Three — Details

3. Previous — Click Previous to return to the previous screen if you need to resolve
some warnings.

4. Apply — Click Apply to configure the devices and proceed to the Summary.

Note
When you click Apply the devices will be configured even if there are potential
problems. It is recommended that you return to the Previous step and resolve any
potential configuration issues.

Figure 5-34: Step Four

Note
Device name is presented as a hyperlink. Clicking it opens the device page.

Step Four A: Review any error messages.
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1. Warning Indicator — The colored status bar to the left of each device in the list
indicates if a problem occurred, and indicates the severity of the problem.

2. Display Details — Click on any item in the list to display the warning message
details.

Figure 5-35: Step Four — Details

Step Four B: Make note of corrections you may need to make.

1. Close — Click Close to finish your after action review.

5.2.4 Collection Details
When you click on a Collection in the Collections section of AMS Wireless Details or AMS
Asset Monitor Details your view switches to the Collection Details view. In this view you
can:

• Edit which measurements are included in the Collection. The configuration of a
Collection defines what data is collected in three situations:
— Schedule — See below.

— Demand — See below.

— Store on Alert — See: Store on Alert Settings

• Set a Schedule for data collecting.

Note
The Schedule button is not available AMS Asset Monitor. AMS Asset Monitor has its
own scheduling functionality.

• Demand that the data be collected now. A progress bar will be displayed.
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Figure 5-36: Collection Details

1. Demand — Click Demand to gather data immediately. A progress bar will be
displayed.

2. Schedule — Click Schedule to open the scheduler dialog. See: Schedule Collection

Note
The Schedule button is not available for AMS Asset Monitor. AMS Asset Monitor has
its own scheduling functionality.

3. Checkboxes — Click on individual checkboxes to include or exclude a measurement
in the Collection. Click on the checkbox at the top of the column to include or
exclude all measurements.

4. Discard changes / Save — Click Discard changes to exit without making changes, or
click Save to exit and save your changes.

Note
This selection only appears when the current selection of checkboxes differs from
the previous selection.

5. Standard Columns — The following columns are available for all devices:
• Measurement, Sensor, Sensor name, Last collection date

6. Additional Columns — Depending on the combination of Device Type and
Collection Type some additional columns of information will be displayed.

Table 5-3: Additional Columns

Device Type Collection Type Optional Columns

AMS 9420 Waveforms, Spectra FMax (Hz), LOR/Number of
Samples

AMS 9420 Burst Variables, Scalars,
Energy Bands

Last collected value

AMS Wireless Vibration
Monitor

Thumbnails, Waveforms,
Spectra

FMax (Hz), LOR/Number of
Samples

AMS Wireless Vibration
Monitor

Scalars Last collected value
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Table 5-3: Additional Columns (continued)

Device Type Collection Type Optional Columns

AMS Asset Monitor All other collections FMax (Hz), LOR/Number of
Samples

AMS Asset Monitor Scalars Last collected value

Schedule Collection
There are three schedule types: Never, Interval with starting point, and Time Window.

A Collection which has an Never schedule type is only available by clicking the Demand
button.

Figure 5-37: Schedule — Never

A Collection which has an Interval schedule type has minimum and maximum intervals.
The interval depends on the collection and device type.

Figure 5-38: Schedule — Interval
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A Collection which has a Time Window schedule type should have a minimum interval of
once per day, and a maximum interval of once per 31 days. It collects data within a 6-hour
time window every interval. There are four 6-hour long time windows to chose from
starting from 12:00 AM, 6:00 AM, 12:00 PM, and 6:00 PM.

Figure 5-39: Schedule — Time Window

5.3 Agents
An Agent in AMS Machine Works enables communication with different types of devices.
Currently there are two types of Agent, an AMS Asset Monitor Agent, and an Emerson
Wireless Gateway Agent.

A standard installation of AMS Machine Works has one of each type of Agent installed on
the same machine as AMS Machine Works. To add more agents you can install just the
Agent software on additional machines. These machines can act as gateways through
firewalls in complicated secure networks.

Expanded installations with many agents can be done to access secure areas, or to
improve throughput in extremely large networks of monitoring infrastructure.

Figure 5-40: Agents View

1. Health Bar — The Health Bar has a color which matches the written Connection
Status next to it.

2. Connection Status — The written form of the connection status matches the Health
Bar.

3. Agent Name — The name of the Agent.
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4. Host — The name of the computer which this Agent runs on.

5. Type — The type of Agent, either AMS Asset Monitor or Emerson Wireless
Gateway.

6. Defined Network Devices — The number of AMS Asset Monitor or Emerson
Wireless Gateway devices defined for this Agent.

7. Connected Network Devices — The number of AMS Asset Monitor or Emerson
Wireless Gateway devices currently connected to this Agent.

8. Defined Logical Devices — The number of endpoint devices which are connected to
this Agent.

9. Menu — This three-dot menu has two options:
• Reassign devices — Select this option to reassign all the devices connected to

this Agent to another Agent. See: Change Agent

• Rename — Select this option to rename this Agent. See: Rename Agent

5.3.1 Change Agent
When you select devices by clicking checkboxes next to their names in either the AMS
Asset Monitor Tab or the Emerson Wireless Gateway Tab, and then click the Change
Agent button, the following dialog appears. This dialog enables you to select from a list of
compatible agents for that type of device.

Alternatively, you can click Reassign devices option in the 3-dot menu found on the left
side of the Agents screen.

Figure 5-41: Change Agent / Reassign devices Dialog

1. Select new Agent — Select the new agent from this dropdown list.

2. Device Name — The names of the devices that will get a new Agent.

3. Address — The IP addresses and port numbers used to contact the devices.

4. Cancel — Click Cancel to exit without saving any changes.
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5. Reassign devices — Click Reassign devices to save your changes and exit.

5.3.2 Rename Agent
When you select the Rename Agent option from the 3-dot menu in the Agents screen the
following dialog opens. The name can have a combination of letters, numbers, and
symbols.

Figure 5-42: Rename Agent Dialog

1. Agent Name — Enter the new name for this Agent. The maximum is 100 characters.

2. Cancel — Click Cancel to exit without saving any changes.

3. Save — Click Save to save your changes and exit.

5.4 Unit Settings
Your data can be displayed in three different measurement systems Imperial, Metric, or
SI. When you make a selection your data will be recalculated to display properly with the
new units.

The Unit Settings the Network Device Module are synchronized with the Plot and Unit
Settings in the the Analysis Dashboard.

Figure 5-43: Unit Settings
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6 Analysis Dashboard
This intuitive graphical dashboard delivers clear visibility to overall machine and system
health at a glance. The information displayed is persona-based, ensuring that team
members receive only the data that is relevant to their position. Users can easily identify if
there are any issues which require their attention and drill down for further analysis.

Note
Ensure that every Machine Train and Alert is properly configured so that you have reliable
information displayed in the user interface.

Figure 6-1: Analysis Dashboard Overview — Default View / System View

A. Machine Status Key Performance Indicator (KPI)
B. System Status
C. Machine List of every selected Machine Train, based on the KPI selection.

Note
If the Machine List section of the System View contains more than 12 items a SHOW
MORE button is displayed in the bottom right corner of the Machine List. Clicking on
SHOW MORE will transfer your view to the List View with a scrollable list of every Machine
Train you have selected.

6.1 User Interface Elements
The Analysis Dashboard window has three main areas, the header, the subheader, and
the view. The functionality and information which is available depends on the view you are
in:

• System View

• List View

• Analysis View
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Figure 6-2: Analysis Dashboard — Header and Subheader

A. Header: Analysis Dashboard Header Section
B. Subheader: Analysis Dashboard Subheader Section

Note
The arrangement of the views depends on your browser settings, and on your Microsoft
Windows display settings.

6.1.1 Colors and Icons
Standardized elements such as a color system, different alert levels, and icons help to
distinguish the types of notifications. The user interface elements which are used in the
Analysis Dashboard user interface depend on what view you are operating in.

Color Meanings

Buttons and status diagrams are colored depending on their functions and meanings.

Table 6-1: Standard meanings of colors

Color Meaning

 Blue Information

 Green Good

 Yellow Advise

 Orange Warning

 Red Critical

 Gray Unknown

Icons

Icons are used to indicate the availability of important functionality or information.
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Table 6-2: General Purpose Icons

Icon Meaning

The Filter icon gives you access to filter functionality
appropriate for the context it is located in.

The circle on the Filter icon indicates how many filters are in
effect.

Note
The Filter icon works differently within the context of the
pane or view in which it is located.

For example, the Filter icon in the Header helps you select a
Machine Train, but the Filter located in the Trend Plots
panel helps you select which trends to display.

For more information see: Filters

The letter 'i' within a solid circle will display contextual
information when you hover your mouse pointer over it.

The Download Asset Status Report icon in the Machine
Status panel will download a report for every Machine Train
which has been select. This selection is affected by the
Persistent Machine Train Filters.

The Machine View icon is available in the Machine Status
panel for switching views.

The Text View icon is available in the Machine Status panel
for switching views.

The Table View icon is available in the Parameters section of
the Machine Information panel for switching views.

The Bars View icon is available in the Parameters section of
the Machine Information panel for switching views.

The Refresh associated data control is available in the Trend
Plots panel.

Note
You must click this icon every time you want to obtain fresh
data.

Click the Trash icon to reset filter options for one section of
the Temporary Machine Train Filters.
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Table 6-2: General Purpose Icons (continued)

Icon Meaning

The 'X' control gives different functionality depending on the
context. (e.g., Close, Reset, Clear)

Fullscreen

Collapse

Previous

Next

Expand / Collapse Tile: Depending on context.

Expand / Collapse Tile: Depending on context.

Expand Tile

Collapse Tile

This 3-dot menu, also known as a mini-menu, can be clicked
to display additional menu items or functions.

Table 6-3: Header Icons

Icon Meaning

Navigation tree See: Navigation Tree
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Table 6-3: Header Icons (continued)

Icon Meaning

Search See: Search

App Switcher See: App Switcher

User See: User Menu

System Settings See: System Settings

Help See: Help

In the context of the header the Filter icon is for a Machine
Train filter. See: Temporary Machine Train Filters

Table 6-4: Sub-Header Icons

Icon Meaning

System View See: System View

List View See: List View

Analysis View See: Analysis View

Previous

Next
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Table 6-4: Sub-Header Icons (continued)

Icon Meaning

Hotkeys See: Hotkeys

View in Vib App See: Vibration Analyzer

Alerts See: Alerts

Machine Config See: Machine Configuration

Machine Journal See: Machine Journal

Plot Settings See: Plot and Unit Settings

6.1.2 Analysis Dashboard Header Section
The Analysis Dashboard Header is available in every view of the application. It contains
functionality for switching between AMS Machine Works applications, searching for items,
finding help, and more. The figure below illustrates all the options.

Figure 6-3: Analysis Dashboard Header — User Interface Elements

A. Navigation Tree — Navigate through the plant hierarchy of ever Machine Train. See:
Navigation Tree

B. Analysis Dashboard — The name of the application.
C. Search field — Search for a Machine Train. See: Search
D. App Switcher — Open other applications. See: App Switcher
E. Language Settings — Change the main application language. See: Language Settings
F. User menu — View your user information, and option to sign out. See: User Menu
G. System Settings — Change the Alert Hysteresis Percentage. See: System Settings
H. Help — Open the online version of this help documentation. See: Help

I. Filter — A Machine Train filter. See: Temporary Machine Train Filters
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Navigation Tree
The Navigation Tree is visible on all pages of the Analysis Dashboard and contains the
following elements:

Click the Navigation Tree icon to open the location or source overview.

Figure 6-4: Navigation Tree Icon

The Navigation Tree displays a hierarchy of all the available locations and the machines
configured in the site. The hierarchy has three logical levels: site, locations, and machines.

Figure 6-5: Navigation Tree

A. Site with a number 2, which indicates there are 2 Location elements inside.
B. Location with a number 2, which indicates there are 2 Location elements inside.
C. Machine Train with a number 3, which indicates that is is composed of 3 Component

elements.
D. Component

The color of the Machine Train icon indicates the status of the machine.

When you select a Machine Train or Component from the hierarchy a diagnostic view in
the Analysis View opens. This contains a detailed analysis view of the selected machine,
which presents plots for trends, waveforms, spectra, and other measurements.

See: Analysis View for more details.

See: Color Meanings for more details.
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App Switcher
Click the App Switcher icon to open a menu of available apps.

Figure 6-6: App Switcher icon

Click an icon to open an application.

There are seven applications to choose from:

1. Asset Explorer

2. User Manager

3. Event Viewer

4. Vibration Analyzer - VibApp

5. Machine Journal

6. Analysis Dashboard

7. Network Device Module

Figure 6-7: App Switcher menu

Click the App Switcher icon again to close the menu.
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Language Settings
The Language Settings icon is represented by a flag icon of a country which
predominantly speaks a particular language. The Analysis Dashboard and other AMS
Machine Works applications are available in these languages.

Figure 6-8: Language Settings

A. American flag: English
B. Chinese flag: Chinese
C. Russian flag: Russian
D. Japanese flag: Japanese

User Menu
To open this menu click the User Menu icon. This menu has information about the current
user, and the option to click Sign Out.

Figure 6-9: User Menu Icon

Click Sign Out to exit AMS Machine Works.

Once you are signed out you can sign in as a different user.

 CAUTION

Users should always sign out of unattended or publicly accessible machines.

Online Help Analysis Dashboard
October 2023

AMS Machine Works v1.7.5 119



Figure 6-10: User Menu

To close the menu, click the User Menu icon again.

System Settings
Click the System Settings icon to open the system settings menu.

Figure 6-11: System Settings icon

The system settings menu contain configuration for Alert Hysteresis.

Figure 6-12: System Settings window

Note
To disable Alert Hysteresis, set it to 0. For a definition of Alert Hysteresis see: alert
hysteresis
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Help
Click the Help icon to open the online version of this help documentation.

Figure 6-13: Help Icon

Additional help resources are listed here: Where to get help

6.1.3 Analysis Dashboard Subheader Section
The Analysis Dashboard subheader contains a broad range of functionality for navigating
your site, launching other applications, and configuring settings. The functionality of the
subheader changes depending on what view you are in, System View, List View, or
Analysis View.

Figure 6-14: Analysis Dashboard Subheader — User Interface Elements

A. System View link. See: System View.
B. List View link. See: List View.
C. Analysis View dropdown list containing every Machine Train you currently have

selected. See: Analysis View.
D. Previous and Next arrows for navigating between every Machine Train you currently

have selected.
E. Hotkeys, which opens Hotkeys popup window describing the function of the hotkeys

available in the Analysis View. See: Analysis View.
F. VibApp, launcher for the Vibration Analyzer application.
G. Alerts, launcher for the Alerts application.
H. Machine Config, launcher for the Machine Configuration application.

I. Machine Journal, launcher for the Machine Journal application.
J. Plot Settings, which opens the Plot and Unit Settings popup window to choose between

various measurement systems.

Navigation Breadcrumbs
The subheader contains a breadcrumb path which enables you to go to other views by
clicking on those breadcrumbs.
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Figure 6-15: Subheader - Navigation Breadcrumbs

• System View:  See: System View

• List View:  See: List View

You can select a Machine Train in the Analysis View, , from the dropdown, or by using
the Previous and Next arrows.

Subheader Shortcuts

Analysis View - Subheader

The Analysis View subheader shortcuts are located on the right side of the Navigation
Breadcrumbs.

Figure 6-16: Subheader - shortcuts

The subheader contains following shortcuts:

Hotkeys

Figure 6-17: Subheader - Hotkeys shortcut

Click on the Hotkeys shortcut to display the hotkey functions which are available for that
view:

In the Analysis View:

A — Show the Waveform & Spectrum data together in the Associated Data panel.

W — Show the Waveform data in the Associated Data panel.

S — Show the Spectrum data in the Associated Data panel.

R — Reload the data points in the Associated Data panel.

H — Switch to the History tab in the Associated Data panel.

E — Switch to the Event List tab in the Machine Information panel.

P — Switch to the Parameters tab in the Machine Information panel.
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M — Switch to the Machine Journal tab in the Machine Information panel.

C — Switch to the Machine Config tab in the Machine Information panel.

In the System View:

R — Switch to the Related to You tab in the System Messages panel.

L — Switch to the Latest in the System tab in the System Messages panel.

View in Vibration Analyzer

Figure 6-18: Subheader - View in VibApp shortcut

Click on the VibApp shortcut to open the Vibration Analyzer and display the selected
measurements.

Configure Alerts

Figure 6-19: Subheader - Configure Alerts shortcut

Click on the Configure Alerts shortcut to open a new tab in your browser for configuring
the Alerts for the currently selected Machine Train or Component.

Machine Configuration

Figure 6-20: Subheader - Machine Config shortcut

Click on the Machine Config shortcut to view or change the Machine Configuration of the
Machine Train you have selected.

Plot Settings

Figure 6-21: Subheader - Machine Journal shortcut

Click on the Machine Journal shortcut to open the Machine Journal application.
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Plot Settings

Figure 6-22: Subheader - Plot and Unit Settings shortcut

Click on the Plot and Unit Settings shortcut to open the Plot and Unit Settings window.

Plot and Unit Settings
The Plot and Unit Settings window has options for choosing the appearance of your plots,
and for choosing the unit system you wish to use:

• Metric

• SI

• English

 CAUTION

Pay close attention to the Unit Settings you have chosen to avoid confusion and the
misreading of results.

These settings are synchronized with those set in the Unit Settings window of the Network
Device Module.

Figure 6-23: Plot and Unit Settings Window
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Background Click the colored button to open the dialog for the color selection.
Select a color for the plot background. The button color changes to
the selected color. Click the button again to close the dialog.

Axis Click the colored button to open the dialog for the color selection.
Select a color for the axis. The button color changes to the selected
color. Click the button again to close the dialog.

Plot Line Click the colored button to open the dialog for the color selection.
Select a color for the line. The button color changes to the selected
color. Click the button again to close the dialog.

Show Min /
Max / Average
Lines

Place a checkmark in the box to show minimum and maximum lines
on trend plots in addition to the average value line.

Note
Averaged values are shown when there are more trend values present
than can be shown given the current screen resolution. When
averaged values are shown, you may zoom in until actual values are
displayed.

Unit Settings Allows selecting English, Metric, or SI unit systems for display. The
units used for displaying various types of data are listed below the unit
system options.

6.2 Search
To search for a Machine Train, enter text into the search field.

Figure 6-24: Search

Search results update dynamically in the List View as you type.

Click on a Machine Train displayed in the List View to go to the Analysis View of that
machine.

Click on a Breadcrumb in the Subheader to go back to those results.

Press X in the search field, or return to the System View, to cancel the search.

6.3 Filters
Finding a Machine Train in a complex site is made easier by filtering out irrelevant results.

There are two kinds Machine Train filters in AMS Machine Works:

1. Temporary Machine Train Filters: Asset Class, Asset Priority, Location

2. Persistent Machine Train Filters: Healthy Items, Unknown Items
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Temporary
Filters

are Machine Train filters which automatically reset between browser
sessions, or page refreshes. These can also be manually reset.

Persistent Filters are Machine Train filters which remain in effect between browser
sessions and page refreshes until you manually reset them.

You can select any combination of Asset Class, Asset Priority, Healthy Items, Location,
and Unknown Items filters that you need.

When you select a filter the results are displayed dynamically in the view you are using, i.e.
the System View or the List View.

Figure 6-25: Display of Currently Active Filters Types

A. Display of Currently Active Filter Types: (Healthy Items, Unknown Items, Asset Class,
Asset Priority, Location)

You can clear an active filter by clicking the 'x' next to its name.

6.3.1 Temporary Machine Train Filters
To set a temporary filter, click the Filters icon in the Analysis Dashboard Header Section to
open the Filters panel.

Figure 6-26: Filters Icon

How many types of temporary filters are in effect is shown by a number on the Filters icon.

Figure 6-27: Filters icon indicating that one type is in use
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Figure 6-28: Temporary Filters

A. Filter Icon showing the number of active filters.
B. There are three types of filters:

• Location: This is the tree structure you have defined for your site.

• Asset Class: There are 13 asset classes, (e.g., Fan), to choose from.
— For more info on Asset Classes read: Step 1: Add Machine Train Details

• Asset Priority: Select between: Not Set, Low, Medium, High, and Very High

C. Click the Clear All button to reset these filters.
D. Expand / Collapse icons for each filter section.

Note
Filters remain in effect until deactivated. To reset the Temporary Filters will you can:

1. Click on the CLEAR ALL button to deactivate all temporary filters.

2. Reload the page in your browser.

3. Log off.
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6.3.2 Persistent Machine Train Filters
Persistent filters also control which Machine Train elements are displayed, but this setting
persists between browser sessions. (See: Temporary Machine Train Filters.)

Figure 6-29: Adjust Status Display for Persistent Filters

A. The Adjust Status Display popup window activated from the Machine Status KPI
Display.

B. Show Healthy Items setting. (Set to on.)
C. Show Unknown Items setting. (Set to off.)

Note
Persistent filters can be set and cleared from the Adjust Status Display by clicking on the
controls for Show Healthy Items and Show Unknown Items.

6.3.3 Displayed Trends Filter

When you click on the Filter icon, , in the Trend Plots panel, the Displayed Trends
Filter selection panel opens.

Note
These Filter settings are stored in a cookie so they will persist in the browser they were set
in until you change the setting. If you use a different machine or browser, this filter will be
set according to the cookie set in that browser.
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The Displayed Trends Filter panel contains a variable amount of trends to choose from.
The number of trends depends on the number of channels which are mapped, and how
many measurements are collected.

Measurements can be scalars, or waveforms, and the number of available trends can
quickly become very large.

Figure 6-30: Displayed Trends Filter Panel

A. Measurement Location selection list.
B. Filter icon showing that 3 Trend Plots are filtered out.
C. Three unselected Trend Plots which are filtered out.
D. DISPLAY ALL and HIDE ALL buttons.
E. Number of Trend Plots which are selected to be displayed.

The available trends are grouped by Measurement Location or channels. Check the boxes
of the trends you want to display. Uncheck the box of a trend to filter it. To close the panel,
click anywhere outside the Displayed Trends Filter panel, or click the Filter icon again.

6.4 System View
This view displays the Machine Status summary and is the starting point for opening an
Analysis View to get more details about the status of a particular Machine Train or a
group of them. To help the user to focus on the Key Performance Indicators (KPIs) for
every Machine Train, and on which measurements are in alert status (advise, warning, or
critical), you have options to select or deselect which items to display.
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Figure 6-31: System View Overview

A. Machine Status Key Performance Indicator (KPI)
B. System Messages
C. Machine List of every selected Machine Train, based on the KPI selection.

Note
If the Machine List section of the System View contains more than 12 items a SHOW
MORE button is displayed in the bottom right corner of the Machine List. Clicking on
SHOW MORE will transfer your view to the List View with a scrollable list of every Machine
Train you have selected.

The System View displays the overall health status for different elements within the AMS
Machine Works database. It shows the three Key Performance Indicators (KPIs) – Machine
Status, Device Measurement Status, and Device Status and provides a context sensitive list
of every applicable Machine Train depending on the selected KPI. A notification of system
status is provided, with a trend of the historical database occupancy indicating the health
of the system. In addition, applicable messages from the Machine Journal application are
displayed.

6.4.1 Machine Status KPI Display
The Machine Status KPI (Key Performance Indicator) display is a doughnut chart which is
used to display the status of every Machine Train which is configured in your AMS Machine
Works site.

There are five alert status levels:

• Unknown

• Good

• Advise

• Warning

• Critical
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Figure 6-32: Machine Status KPI Display

A. The number in the center of the doughnut chart is the number of Machine Trains with a
particular alert level. If you have not selected an alert level, then the total number of
Machine Trains in your site is displayed.

B. This area contains icons for:

• Download Asset Status Report icon: 

• Adjust Status Display filter icon: 

• Machine Status information popup icon: 

C. You can click either a section of the doughnut chart, or an alert level in the legend, to
select all the Machine Trains with that alert level.

D. The section of the KPI chart which is currently selected is highlighted with an arc.

Every Machine Train that meets your filtering criteria is listed in the List View area to the
right of the Machine Status KPI display. If there are more machines than can be displayed
in this view, an icon shows the number of additional Machine Trains that are displayed on
the subsequent page(s).

6.4.2 System Messages
The messages displayed in the System Messages pane are created in the Machine Journal.
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Figure 6-33: System Messages

The Related to You contains a list of the latest system events specifically related to the
current user.

The Latest in the System contains a list of the latest system events that the user has
access to.

Two hotkeys are available to switch tabs:

R — Switch to the Related to You tab in the System Messages panel.

L — Switch to the Latest in the System tab in the System Messages panel.

6.5 List View
The List View shows the status of every Machine Train you have searched for.

Searching: Search
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The results in the List View are affected by the currently selected filtering options. More
results are progressively loaded as you scroll through long lists. To reduce the number of
results in the List View you can apply more filtering options.

Filters:

• Temporary Machine Train Filters

• Persistent Machine Train Filters

If you click on the tile of a Machine Train in List View your view will change to the Analysis
View for that Machine Train.

6.5.1 Machine Train List
This area shows every Machine Train you selected via the Machine Status KPI diagram, or
searched for with the Search functionality. If there are more machines than can be
displayed on this view, an icon shows the number of additional machines that are
displayed on the subsequent page(s).

Figure 6-34: List of Machine Trains

A. Headers:
A. Analysis Dashboard Header Section
B. Analysis Dashboard Subheader Section

B. Machine Train List

Machine
Train List

This area contains a panel for each Machine Train which matches either the
alert level you have selected, or that matches your Search criteria. Each
panel has a status bar on the left which has a color that matches its alert
level. Machine details, such as bearings and measurement locations, also
have colors which match their alert levels. Click on a panel to open a more
detailed view of the machine. Click on a Machine Train panel to open an
Analysis View for that item.
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6.6 Analysis View
The Analysis View provides a detailed analysis view of the selected machine with trends,
waveforms, spectrum, and other measurements of interest for the selected measurement
point.

Figure 6-35: Analysis View – Overview

A. Machine Status panel with measurement locations.
B. Trend Plots panel
C. Machine Information panel
D. Associated Data panel

Click the arrow icon  in the upper right corner of a panel to enlarge it, and click  to
reset the view.

6.6.1 Machine Status panel
This area shows a view of the selected Machine Train as either a Machine View, or as a List
View.

The diagnostic view shows every Machine Train which is available. Availability depends on
how you arrived in the diagnostic view, either from selecting a KPI, from a Search, or by
clicking on a specific Machine train in the Navigation Tree.

For more about filtering options see: Filters

For more about search criteria see: Search

For more about the Navigation Tree see: Navigation Tree

If there is more than one Machine Train available, the others can be reached by the
navigation options available in the Navigation Breadcrumbs.
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Figure 6-36: Measurement Selection Panel: Machine View

A. Bearing Indicator which usually has three Measurement Location points (X, Y, Z).
B. Measurement Location which indicates sensor placement.

In the Machine View shown above, click on the Measurement Location of a data source
to display the associated trend data. A blinking blue border shows which elements is
selected.

Note
In the Machine View of a Machine Train you can select only one Measurement Location,
or one Bearing Indicator. One Bearing Indicator usually has three Measurement Location
points.

Figure 6-37: Measurement Selection Panel: List View

Note
In Text View you can select more than one Measurement Location.

A Measurement Location which is selected is marked by a blue check.

To change between Text View and Machine View click the appropriate icon:

• Text View: 
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• Machine View: 

Plots for the selected channels will be shown in the other panels. The number of hidden
trends is indicated in a blue solid circle on the Trend Filter icon. Each Machine Train has a
different number of Measurement Location are available depends on the selected
machine.

Selecting a data source synchronizes, within the same time frame, all the panels such as
trend plots, parameter views, waveforms and spectra, and status indicators.

6.6.2 Machine Information panel
Several tabs provide information about the currently selected Machine Train.

The following keyboard shortcuts enable you to switch tabs in the Machine Information
panel:

P — Switch to Parameters tab.

M — Switch to Machine Journal tab.

C — Switch to Machine Config tab.

Parameters (default view)

Parameters of the data source selected on the machine status panel. Select the Bars View
icon to display the values as bar graphs.

Figure 6-38: Bars View Icon

Select the Table View icon to display the information in tabular form.

Figure 6-39: Table View Icon
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Figure 6-40: Parameters – Bars View

The parameter bars are grouped by Measurement Location, and by alert severity.

Figure 6-41: Parameters – Table View

The parameters are grouped by Measurement Location, and ordered by alert severity.

Machine Journal

If a Machine Train is selected, all the Machine Journal entries for the selected Machine
Train and its components are listed.

Figure 6-42: Machine Journal
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Machine Config

When you select a Machine Train, you can view details about the components that are in
its subassembly.

Figure 6-43: Machine Config

6.6.3 Trend Plots panel
The trend plots for the last 30 days of the data source, or Measurement Location, selected
on the Machine Train diagram are displayed in the Trend Plots panel. The number of
trends depends on the data source you have selected.

Note
For more information on how to select a Machine Train and data sources see:

• Search

• Temporary Machine Train Filters

• Persistent Machine Train Filters

One data source can provide several trends. The trends are grouped by Measurement
Location, such as all measurements for a selected bearing. All the trends displayed have a
synchronized time frame.

When you click the Filter icon, , in the upper right corner of the Trend Plots panel, the
Displayed Trends Filter selection panel opens.
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Note
The Displayed Trends Filter section has more information about selecting a Measurement
Location.

The trend plots contain several functions to adapt the view to your needs:

Maximize / Minimize Chart

• To maximize a Trend Plot, click the outward pointing arrows  icon.

• To reset the Trend Plot view, click the inward pointing arrows 

Figure 6-44: Refresh associated data button

Once you have selected a point on the trend plots you must click the Refresh Associated
Data button to refresh the data in the Associated Data view.

Trend cursor: Move the cursor over the trend to display date, time, and average amplitude
of a particular point of the trend. Click to select a point. The selection is marked with a red
dotted line. The same point in time is also marked on all trends shown on this panel.
Waveform and spectrum of the selected data block are displayed on the waveform and
spectrum panel.

Figure 6-45: Trend with selected value
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Figure 6-46: Region zoom

A. Place the mouse cursor close to the area of interest, left-click, and hold.
B. Move the mouse to frame the area of interest.
C. Release the mouse button to enlarge the selected area.

Double left-click on the trend to reset the view.

6.6.4 Associated Data panel
The Associated Data panel consists of the two tabs, the Associated Data tab and the
History tab..

Note
You can use the keyboard shortcuts to navigate between Associated Data views.

• A : Press 'a' to view associated data, i.e. waveform and spectrum together.

• W : Press 'w' to view waveforms.

• S : Press 's' to view spectra.

• R : Press 'r' to Refresh associated data.

• H : Press 'h' to switch to the History tab.

The waveform and spectrum plots under Associated data contain several functions to
adapt the view to your needs:

Cursor

Select a point on a waveform or spectrum to display the data from that particular point on
the plot.

• With a waveform, time and amplitude are displayed.

• With a spectrum, frequency and amplitude are displayed.
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Figure 6-47: Spectrum with selected data point

Left-click to select that point. The selection is marked with a red solid line. Use the
Previous and Next navigation buttons of the waveform and spectrum panel to move
through the available waveforms and spectra.

Figure 6-48: Region zoom

To enlarge an interesting part of a spectrum:

1. Place the mouse cursor close to the area of interest, left-click, and hold.

2. Move the mouse to frame the area of interest.

3. Release the mouse button to enlarge the selected area.

Double left-click on the plot to reset the view.

Waveform

When you select a data block (point) on the trend plot, and then click,  (Refresh
associated data), the waveform of the signal contained in this block is displayed.
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Figure 6-49: Waveform

A. Selected trend plot data block.
B. Corresponding waveform.

Spectrum

On the spectrum plots panel, the spectrum of the signal contained in the data block,

selected in Trend Plot, is displayed when you click,  (Refresh associated data). Use the
Previous and Next navigation buttons of the waveform and spectrum panel to move
through the available waveforms and spectra.

Figure 6-50: Spectrum

A. Selected trend plot data block.
B. Corresponding spectrum.

Waveform and Spectrum

Both waveform and spectrum of the selected data block are displayed. Use the Previous
and Next navigation buttons of the waveform and spectrum panel to move through the
available waveforms and spectra.
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Figure 6-51: Waveform and spectrum

A. Selected trend plot data block.
B. Corresponding waveform.
C. Corresponding spectrum.
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7 Vibration Analyzer
The AMS Machine Works Vibration Analyzer is a module of AMS Machine Works. You can
use it to diagnose your machines by viewing plots to analyze vibration data collected from
devices that are monitoring machines in your site.

A wide variety of plots are available such as: Spectrum, Trend, Waveform; but also: Orbit,
Shaft Centerline, Cascade, Bode/Nyquist, and Full-Spectrum.

You can launch the Vibration Analyzer on the client or server computer where it is
installed. Choose one of the following to open the Vibration Analyzer:

• Click Start → AMS Machine Works → Vibration Analyzer.

• In Asset Explorer, select a machine train or component, and then click the Vibration
Analyzer button in the Home ribbon.

• Select the Vibration Analyzer icon from the App Switcher.

• In the Network Device Module, select Vibration Analyzer from the sidebar.
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7.1 Vibration Analyzer user interface
Figure 7-1: Vibration Analyzer user interface

The workspace lets you organize your screen to display only information that is relevant to
you. It can contain any variation of the following:

A. Label for plotting workspace — identifies the data currently displayed in the plotting
workspace.

B. Plotting workspace — displays plots and information about each plot type.
C. Locations navigator — lets you navigate to a measurement location.
D. Collections navigator — displays available measurements by asset, location, and

collection.
E. Details navigator — displays all available measurements for the selection in the

Locations and Collections navigators. The measurements are shown under the Spectra,
Waveform, and Trends tables.

F. Plot information — information about the current plot.
G. Cursor details — displays details about the cursor location on the plot.
H. Function bar — shows the functions that are available according to the plot selection.

I. Common controls — functions that are available to all plot types.
J. Settings — used to configure selected settings and preferences (e.g. units, server

connection, and others).

Moving the Navigators

The Locations, Collections, and Details navigators are movable windows. To move these
navigators, click and drag the navigator title bar to a desired location. To move it back to
the default location, drag it back.

You can also click the Settings icon and then select Refresh Hierarchies to return the
navigators to their default positions. Refresh Hierarchies is also used to update the
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Vibration Analyzer application when changes are made in Asset Explorer. The software
prompts you to do this when changes are made.

If you want to keep your custom navigator locations, exit the Vibration Analyzer
application after making the edits in Asset Explorer, and then reopen it, instead of using
Refresh Hierarchies as prompted.

Hiding the Navigators

Use the pushpin icon to hide the navigators. When a navigator is hidden, a tab displays to
the left or at the bottom of the main application window. Click this tab to toggle the
navigator's display.

7.1.1 Locations navigator
This navigator lets you browse machines in your site, including measurement locations.
The machines are organized in tree form, which represent all available machine trains
onsite. For more information on creating a machine train, see the Asset Explorer section.

When you add machines in Asset Explorer utility, this is also reflected in the Locations
navigator, including the measurement locations. When you click an item in the Locations
navigator, the Collections navigator shows the available measurements in the selected
location.

Figure 7-2: Locations navigator

All items in this navigator have bubble states indicator in the form of a color disk. The color
of the indicator is related with item status. The table below describes the indicator color
with relation to the alarm status. The machine component status reflects the most severe
measurement point status. Similarly, the machine train status reflects the most severe
measurement component status.
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Table 7-1: Locations navigator bubble states for machine trains

Color Meaning

Red Critical Alert

Orange Warning Alert

Yellow Advise Alert

Green Normal, No alert

Grey Alert not applicable

Alert not received

Black No Data
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7.1.2 Collections navigator
When an asset or measurement location is selected in Locations, the Collections navigator
displays all measurements that are available in this location. The measurements are
grouped into collections.

Figure 7-3: Collections navigator

You can select multiple measurements, which then populates the Details navigator.

7.1.3 Details navigator
The Details navigator displays all available measurements from the machines and
collections that you selected in the Locations and Collections navigators. These
measurements are shown in the Spectra, Waveforms, and Trends tables.
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Click on any of the measurements in the Spectra, Waveforms, and Trends tables to display
the plot in the plotting workspace. You can select multiple measurements by pressing
CTRL or SHIFT on the keyboard while clicking.

Figure 7-4: Details navigator

7.1.4 Function bar
The Function bar contains controls that you can use while analyzing the plot.

The controls are grouped into functions such as waveform controls which are displayed for
waveform data, trend controls for trend data, spectrum controls for spectrum data, and
common controls, which are available for all measurement types.

This section discusses the functions and controls in details.

Common controls

Common controls are available for all plot types.

Click  to display all functions under Common controls.

Button Function Description

Setup
Options

Change setup options for all the plots in the plotting workspace.

Vertical
Scale

Enable vertical scaling. Click the left icon (+) to increase the scale
and the right icon (-) to decrease the scale around cursor location.
Click center button to auto-scale plot.

Horizontal
Scale

Enable horizontal scaling. Click the left icon (+) to increase the scale
and the right icon (-) to decrease the scale around cursor location.
Click center button to auto-scale plot.

Horizontal
Pan

Enable horizontal panning. Click the gray left / right arrow icons to
pan left and right.

Annotate
Plot

Displays a list of plot annotation options.

Clear Plot Clear the plotting workspace. Click the arrow to set the default
option for the Clear Plot icon. Choose from Clear Active and Clear
All.

New
Window

Launch active plots in a new window. Click one plot or shift-click
additional plots to activate plots.

Vibration Analyzer Online Help
October 2023

150 AMS Machine Works v1.7.5



Button Function Description

Print/Print
Options

Click the Print icon to print an Image Summary Report. Click the
arrow to set the default option for the icon. Choose from Print All,
Print Active, and Print Workspace.

Print
Preview

Preview the Image Summary Report in the Report Viewer. Click the
arrow to set the default option for the icon. Choose from Print
Preview All, Print Preview Active, and Print Preview Workspace.

Save Image Save a single plot or plotting workspace as an image. Click the arrow
to set the default option for the icon.

Hot Keys Launch the Hot Keys list to see the key combinations for features
available for the active plotting workspace. Hot Keys vary
depending on the plots shown in the plotting workspace.

Trend

These functions are available for Trend plots. Click + to view all available functions.

Clicking on the Trend plot icon allows to display (yellow color) or hide (blue color) Trend
plots in the plotting workspace.

For more information, see Trend plots.

Spectrum

These functions are available for Spectrum plots. Click + to view all available functions.

Clicking on the Spectrum plot icon allows to display (yellow color) or hide (blue color)
Spectrum plots in the plotting workspace.

For more information, see Spectrum plots.

Waveform

These functions are available for Waveform plots. Click + to view all available functions.

Clicking on the Waveform plot icon allows to display (yellow color) or hide (blue color)
Waveform plots in the plotting workspace.

For more information, see Waveform plots.

7.2 Active plots
Active plots allow you to perform functions and view details about a specific point on the
plot.
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Click on a plot to make it active. The controls in the Function bar changes when you switch
between active plots presenting different types of data, whether it is waveform, spectrum,
or trend.

By default, active plots show up as bright blue in color whereas inactive plots are dark blue.

You can have more than one active plot by holding the Shift or Ctrl key and clicking on the
plots you want to be active. You can make all plots in the plotting area active by pressing
Ctrl + A.

Most function bar options and hot key commands only operate on an active plot. Some
exceptions are Clear Plot, Print, and Print Preview, which can be set to work on either
active or all plots. The color of the function bar icon is changing from blue to orange if you
turn plot visibility to ON from OFF.

Figure 7-5: Active plot (top) vs inactive plot (bottom)

7.3 Cursor types
The available cursor types are: single, reference, difference, harmonic, and sideband.
Depending on the plot, one or more cursor types are available.

Cursor mode Description

Single A single cursor helps you identify a specific point on the plot.
A square identifies a single cursor.

Reference A reference cursor is used to calculate the delta (Dfrq) between the primary cursor
and the point you select as the reference cursor.
A triangle identifies a reference cursor.

Difference Difference cursors are available on waveform plots.
A circle identifies a difference cursor.
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Cursor mode Description

Harmonic Harmonic cursors are available on spectrum and waveform plots.
A circle identifies a harmonic cursor.

Sideband Sideband cursors are only available for spectrum plots.
A diamond identifies a sideband cursor.

7.3.1 Mark a single cursor
To mark a single cursor, click on an active plot.

A cursor appears at the nearest data point. The exact cursor position displays in the lower
right-hand corner of the plot legend and updates as the cursor moves.

7.3.2 Move a cursor
There are four ways to move a cursor.

Procedure

• Press and hold Ctrl while using the left or right arrow key to move the cursor to a short
distance (micro-cursor movement).

• Press the left or right arrow keys to move between neighboring points.

• Use your mouse by dragging and dropping the cursor or clicking on a different point on
the plot to move the cursor.

• Press Home to move the cursor to the start of the data, or press End to move the
cursor to the end of the data.

7.3.3 Mark cursors on a single spectrum plot
Procedure

1. Set the cursor on a spectrum plot.

2. Right-click the plot and select Mark Cursors → Add.
The cursor is marked by a unique symbol. The symbol type changes each time a
new cursor is marked.

Note
To clear marked cursor symbols, right-click the plot and select Mark Cursors →
Clear.

7.3.4 Set a reference cursor
If you have a single cursor placed on a plot, you can set a reference cursor on trend,
spectra, cascade, and waveform plots.
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Procedure

1. Mark a single cursor by first clicking on an active plot. A cursor appears at the
nearest data point. The exact cursor position displays in the lower right-hand corner
of the plot legend and updates as the cursor moves.

2. Press Alt and click on the plot again.
A second cursor, the reference cursor, appears at the nearest data point. The
primary cursor remains and can be moved. The plot legend displays the position of
the reference cursor, the primary cursor, and their delta in the X dimension.

3. You can also right-click the plot and select Set Reference Cursor to place the
reference cursor exactly at the position of the primary cursor.

This is useful when measuring the precise frequency difference between two peaks.

7.3.5 Display a harmonic cursor
Harmonic cursors are available on all spectrums and waveforms plots.

Procedure

1. Mark a single cursor by first clicking on an active plot.

A cursor appears at the nearest data point. The exact cursor position displays in the
lower right-hand corner of the plot legend and updates as the cursor moves.

2. Right-click on the plot and then select Cursor Type → Harmonic.

Moving a harmonic cursor results in moving its harmonics.

7.3.6 Display a sideband cursor
Sideband cursors are only available for spectrum plots.

Procedure

1. Set a reference cursor.

2. Right-click the plot and select Cursor Type → Sideband.

N sideband cursors are displayed at intervals of the delta of the reference and primary
cursor. You can set the value for N in the Spectrum tab of the Setup Options Editor. You
can also move the primary sideband cursor in relation to the reference cursor. This will
update the locations of all N sideband cursors. See Related information for details.
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7.3.7 Display difference cursors
Difference cursors apply only to waveform plots. On a plot, they are used for measuring
time difference between selected points.

Procedure

1. Set a reference cursor.

2. Right-click the plot and select Cursor Type → Difference.

The primary cursor can be moved relative to the reference cursor, and cursor information
is displayed for both cursors and delta spacing.

7.3.8 Use linked cursors
Linked cursors let you synchronize the movement of cursors on multiple active plots.
Generally, only plots of the same type have linked cursors.

Procedure

1. Display multiple plots of the same type either together or separately.

2. Mark a cursor on one of the plots.

3. Press Ctrl and click the plots you want to activate.

When you move a cursor on one active plot, a cursor appears on all other active plots at
the same location and moves simultaneously.

7.4 Zoom in or out on a plot
Procedure

1. To zoom in, right-click and hold on the plot, and select the area you want to zoom.
A dotted box shows the selection area.

2. Release the right mouse button. The plot zooms in to display only the portion of the
plot you selected.

3. To zoom out, right-click near the axis of a plot and select Zoom Out. The X and Y
axis can be zoomed in and out separately. Zoom to the original view by clicking the
green scale arrow icons.

Alternatively, place a cursor on a plot. Use the Vertical Scale and Horizontal Scale
functions from Common controls to zoom in or zoom out.

7.5 Overlay
An overlay lets you compare two plots of the same type using similar units. You can
generate an overlay by dragging and dropping one plot onto another plot. All plot types
except for cascade plots support overlays.

The image below illustrates two waveform plots with the same amplitude units. The top
waveform was dragged and dropped to the bottom waveform to create an overlay. The
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data from the top waveform is displayed in green. This color can be changed in the Plot
Options tab of the Setup Options Editor dialog.

Figure 7-6: Overlay

For all plot types except spectrum plots, a plot can only have one overlay at a time. If
another plot is dragged to a plot that already has an overlay, the current overlay is
replaced.

For spectrum plots, the default view of overlay data can be set in the Spectrum tab of the
Setup Options Editor dialog. Multiple overlays can be displayed by pressing the Ctrl key
and dragging and dropping multiple spectrum plots to a target spectrum plot.

The overlay function generally requires plots to have the same amplitude units. However,
you can overlay spectrum and waveform plots even if the amplitude units are different.
Overlay units will be converted to the units of the target plot.

You can view information about the overlay by right-clicking the plot and selecting Display
Overlay Info.

7.6 Annotate plot
Mark plots with annotations to point out specific areas of interest and make notes.
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Procedure

1. Click  on the Common Controls function bar, or right-click on a plot and
select Annotate Plot.

The Adjust Annotations dialog appears.

2. Click the icon for the type of annotation you want to add.

Icon Option Description

New Line
Annotation

Adds a new line to the plot.

New
Rectangle
Annotation

Adds a new rectangle to the plot.

New Ellipse
Annotation

Add a new ellipse to the plot.

New Text
Annotation

Adds new text to the plot.

Advanced
Editing Tools

Lets you specify additional details for the annotation you selected.

3. Click on the annotation and adjust the size by dragging a sizing handle. You can also
move the annotation by dragging it.

4. Click .

Click  to delete a selected annotation or click  to delete all annotations on the
plot.

Note
Annotations are NOT saved. Save the plotting workspace as an image if you want to
keep the annotations.

7.7 Configure the plotting workspace
Change the type of information to display automatically when you make a selection in the
navigators.

Procedure

1. Click  and select Selection Type Preferences.
The Selection Type Preferences dialog appears.

2. Expand a selection type and select an option to modify.
Display settings appear on the right pane.
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3. Modify your desired settings.

Note
Click Defaults to reset settings to default values.

4. Click OK.

7.7.1 Set the line frequency
The line frequency can be used for identification of some faults, e.g. while using flux
measurements, or can be used for identification of line component in a spectrum.

Procedure

1. Click  and select General Settings.

2. Enter a value and click OK.

7.7.2 Set unit preferences for the Vibration Analyzer
Procedure

1. Click  and select Units Preferences.

2. Use the drop-down menu to configure the unit modes and decibel references for
the following:

• Acceleration

• Velocity

• Displacement

• Sound Pressure

• General Dynamic

• HFD

• Motor Current

• Flux Data

• Shaft Voltage

• Shaft Current

3. For Data Display Units, select English or Metric.

4. Click OK.

7.8 Customize display for plots
Procedure

1. From the Locations navigator, select a measurement location, and then select a
collection from the Collections navigator.
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Press CTRL to make multiple selections.

2. Select a measurement from the tables in the Details navigator to display a plot in
the plotting workspace.You can select multiple data entries.
• Spectra — customize display for spectrum plots.

• Waveforms — customize display for waveform plots.

• Trends — customize display for trend plots.

7.8.1 Waveform tab
From the plotting worksace, right-click on a waveform plot, and then select Setup Options
→ Waveform tab. The Waveform tab displays options for waveform plots.

Time Axis Options

Option Description

Units Select either time or revolutions as the unit used
for the time axis. Revolutions do not apply to
live waveforms.

Independent Scaling Allows each plot to scale independently to
maximize data resolution.

Autoscale Across Plots Scales similar data plots to the same time axis
scale to make time differences more visually
obvious.

Fixed Scale Enabled Limits the range of Time or Revolution to a
specified lower and upper value.

Starting Position Set the starting position for the fixed scale.

Ending Position Set the ending position for the fixed scale.

Defaults Resets all Time Axis options to default values.

Amplitude Axis Options

Option Description

Units Select Stored Units, Acceleration, Velocity, or
Displacement as the unit used for the amplitude
axis.

Independent Scaling Allows each plot to scale independently to
maximize data resolution.

Autoscale Across Plots Scales similar data plots to the same amplitude
axis scale to make amplitude differences more
visually obvious.
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Option Description

Fixed Scale Enabled Limits the Amplitude Axis range based on
specified lower and upper amplitudes for
selected units. Enter the lower scale and upper
scale values. The lower scale sets the lower
amplitude and the upper scale sets the upper
amplitude.

Defaults Resets Amplitude Axis options to default values.

Display Options

Option Description

Number of Cursor Markers Sets the number of cursor markers to display.
The default value is 5.

Mark Normalizing Frequency Displays marks for the normalizing frequency.

Plot in Circular Format Displays the waveform in circular format rather
than X-Y format.

Display In Single Column Displays the analysis pane in a single column.

Display Grid Lines Displays grid lines on plots.

Display Alarm Levels Displays alarm levels on waveform plots.
Selecting this check box enables the four fields
below.

Maximum Peak Acceleration

Maximum Peak Velocity

Maximum Peak Displacement

Maximum Crest Factor

Enter the waveform alarm levels to generate
waveform alarms for points that do not have
measured waveform analysis.

Defaults Resets Display options to default values.

Filter Settings

Option Description

Acceleration Select a filter for each field. The filters are:
• None — No filter is applied to the data.

• 1x — A 1xRPM filter is applied to the data.

• 2x — A 2xRPM filter is applied to the data.

• 3x — A 3xRPM filter is applied to the data.

• Custom — A custom filter is applied to data.

If any filter is selected, the type of filter can be
set to Bandpass or Lowpass. A custom filter is
defined by Custom Value - a whole number
multiple of the rotation speed.

Velocity

Displacement

General Dynamic

Defaults Resets all Filter Settings options to default
values.
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7.8.2 Spectrum tab
From the plotting workspace, right-click on the spectrum plot, and then select Setup
Options → Spectrum. The Spectrum tab displays options for spectrum plots.

Frequency Axis Options

Option Description

Units Select Hz, CPM, or Orders as the unit used for
the frequency axis.

Type Select either Linear or Log as the scale.

Fixed Scale Enabled Select the check box to limit the frequency axis
range to a specified lower and upper frequency.

Lower Frequency Set the lower frequency for the fixed scale.

Upper Frequency Set the upper frequency for the fixed scale.

Defaults Resets Frequency Axis options to default values.

Amplitude Axis Options

Option Description

Units Select Stored Units, Acceleration, Velocity, or
Displacement as the unit used for the amplitude
axis.

Type Select either Linear or Log as the scale.

Independent Scaling Allows each plot to scale independently to
maximize data resolution.

Autoscale Across Plots Scales similar data plots to the same amplitude
axis scale to make amplitude differences more
visually obvious.

Fixed Scale Enabled Limits the Amplitude Axis range based on
specified lower and upper amplitudes for
selected units. Enter the lower scale and upper
scale values. The lower scale sets the lower
amplitude and the upper scale sets the upper
amplitude.

Defaults Resets Amplitude Axis options to default values.

Display Options

Option Description

Harmonic Cursor Markers Enter the number of harmonic cursors to
display. The default value is 8.

Peaks to List Enter the number of peaks to be listed when the
peak list viewer is displayed. The default value is
24.
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Option Description

Sideband Cursor Markers Enter the number of sideband cursor markers to
display. The default value is 5.

Display Grid Lines Displays grid lines on plots.

Automatic Overlay Type (Periodic and Online) Lets you display an automatic overlay. Select
None, Reference, or Previous.

Defaults Resets Display options to default values.

Peak Label Options

Option Description

Displayed Information Choose the type of information to be displayed. Select Frequency,
Amplitude, or Both.

Automatic Peak
Labelling

Select the check box to automatically display peak levels.

Number of Peaks to
Label

If Automatic Peak Labelling is selected, specify the number of peaks to
label. The default value is 5.

Multiple Spectrum Options

Option Description

Highlight Active Trace Highlights the active spectrum in a multi-
spectral plot.

Display Floor Cursor Select the check box to display a floor-type
cursor.

Display Plane Cursor Select the check box to display a plane-type
cursor.

Opacity If Display Plane Cursor is selected, enter the
opacity of the plane cursor.

Z-Axis Angle Enter the Z-axis angle of spectral data in multi-
spectral plots.

Overlap Percentage Enter the overlap percentage of spectral plots
displayed in multi-spectral plots.

Plot Sequence Lets you choose the direction of time for
spectral data displayed in multi-spectral plots.
Select either Top Down or Bottom Up.

Defaults Resets Multiple Spectrum options to default
values.
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7.8.3 Trend tab
From the plotting workspace, right-click on the trend plot, and then select Setup Options
→ Trend tab. The Trend tab displays options for trend plots.

Time Axis Options

Option Description

Fixed Scale Enabled Select the check box to limit the range of the
Time axis to a specified starting and ending
position.

Starting Date If the Fixed Scale Enabled check box is selected,
choose the starting date.

Ending Date If the Fixed Scale Enabled check box is selected,
choose the ending date.

Keep End Date Set to Current on Restart Select the check box to match the end date with
the current date.

Defaults Resets all Time Axis options to default values.

Amplitude Axis Options

Option Description

Independent Scaling Allows each plot to scale independently to maximize data resolution.

Autoscale Across Plots Scales similar data plots to the same amplitude axis scale to make
amplitude differences more visually obvious.

Fixed Scale Enabled Limits the Amplitude Axis range based on specified lower and upper
amplitudes for selected units. Enter the lower scale and upper scale
values. The lower scale sets the lower amplitude and the upper scale sets
the upper amplitude.

Defaults Resets Amplitude Axis options to default values.

Display Options

Option Description

Display Grid Lines Displays grid lines on plots.

Update Spectrum/
Waveform with Trend
Cursor

Select the check box to allow the trend point where the cursor is
positioned to simultaneously display the time-associated spectrum and
waveform, if available.

Alarms Select the check box beside each alarm level you want to display.

Defaults Resets Display options to default values.

7.8.4 Plot Options tab
From the plotting workspace, right-click on the plot, and then select Setup Options →
Plot Options tab.
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The Plot Options tab provides settings available for most plot types. You can change the
color settings, labeling preferences, fault frequencies display options, and image saving
options.

Plot Color Setup

Select a color for different element types displayed on a plot. Click Defaults to reset the
color settings to default values.

Miscellaneous

Miscellaneous portion of the Plot Options tab contains the options for Fault Frequencies
and Saved Images.

Option Description

Source Fault frequencies can come from different sources. Select All,
Configuration, or Measurement Location.

Format Select either Lines or Lines and Values. Lines only display fault frequency
lines on the plot while Lines and Values display fault frequency lines on
the plot and the value on the plot legend.

Line Thickness Specify the thickness of the line used to mark the fault frequency position
on the data plot. Select either Thin or Thick.

Match Tolerance
(%/Order)

Specify the percentage per order of tolerance to be applied to consider
the frequency a match.

Specify Colors Change plot colors for specific components of the plot.

Default Frequency
Units

Set the default frequency units. Select either Hz or CPM.

Format for Speed
Values

Set the unit for speed. Select either RPM or RPS.

Plot Font Size Set the size of the text displayed in the plot. Select Small, Medium, Large,
or Extra Large. More information is displayed if a smaller font is chosen.

Auto-hide Function Bar Mark the box to automatically hide the Common Controls function bar
when it is not used. Hiding the function bar increases the size of the plot
area.

Saved Images

Each plot type can be saved as an image file.

Option Description

File Format Set the default file format for images. Select: .bmp, .jpeg, .png, or .emf.

Manually Enter
Filename

Mark the box to be prompted to enter a filename when saving an image.
Otherwise, the filename will be added automatically.

Link Image to Machine
Journal Entry

Select this option to link images to a Journal entry.

Save Image to File on
Local Machine

Save images on your computer in the database system.
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Option Description

File Save Location Location of a file on a Local Machine. The default location is C:\temp.
Click Browse to select a different location.

Defaults Resets all settings in this section to the default values.

7.9 Spectrum plots
A spectrum plot is a graphical representation of vibration amplitudes in the frequency
domain.

To view a spectrum plot, select a measurement location in the Locations navigator, and
then select a collection in the Collections navigator.

In the Details navigator, under the Spectra table, select a date/time of interest.

Figure 7-7: Spectrum plot

7.9.1 Spectrum function bar
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The spectrum function bar is available when:

• a spectrum plot is the only open plot

• a spectrum plot is selected in a plot viewer with multiple plots

• a spectrum plot is an active plot in plotting workspace containing multiple plots

Click  to display all functions.

Button Function Description

Cursor Type Click to toggle cursor types.

Peak Locate Click to locate a peak.

Label Peaks Click to label peaks. Click the arrow to label the primary cursor
or all cursors.

Fault
Frequencies

Click to open the Fault Frequency List Viewer. Click the left or
right buttons to show the previous or next fault frequency.

Peak List Click to open the Peak List Viewer. Click the left or right buttons
to show the previous or next peak.

Harmonic
Family List

Click to open the Harmonic Family Viewer. Click the left or right
buttons to show the previous or next harmonic family.

Set Rpm Click to open pop-up window allowing to set correct RPM speed.
Cursor can be used to identify RPM value.

Note
For multiple spectrum plots, only the Cursor Type, Peak List, and Harmonic Family buttons
are displayed.

7.9.2 Peak List Viewer

To display the Peak List Viewer, click  on the Spectrum function bar.

Use the Peak List Viewer to:

• Display detailed information about peaks in a spectrum plot.

• Select specific peaks to print detailed information.

• Select specific peaks to label on the plot.

7.9.3 Display harmonic family list
Procedure

1. Open a spectrum plot.

Vibration Analyzer Online Help
October 2023

166 AMS Machine Works v1.7.5



2. Click  on the Spectrum function bar.
The Harmonic Family Viewer dialog appears.

3. Select a harmonic family or difference family.
The plot displays your selection.

4. You can also use the left or right buttons to display harmonic families or difference
families.

7.9.4 Display fault frequencies
You can display fault frequencies in autocorrelation plots, waveforms, and spectra. Fault
frequency markers start at the fist point in the waveform and are separated by time
distance being a reciprocal of the fault frequency.

Procedure

1. Open a spectrum or waveform plot. To open auto the autocorrelation plot right
click on the waveform plot and choose Autocorrelate.

2. Expand the Spectrum or Waveform function bar.

3. Click .
The Fault Frequency List Viewer dialog appears.

4. Select a fault frequency.
The plot displays the selected fault frequency.

5. Select Keep Frequency Displayed if you want the plot to always display your
chosen fault frequency.

A checkmark appears beside the selected fault frequency.

Note
• You can select multiple fault frequencies to be always displayed.

• You can also click the left or right buttons to view the previous or next fault
frequency without opening the Fault Frequency List Viewer dialog.

To clear fault frequencies, right-click on the plot, and then click Clear Displayed
Frequencies or Clear Fault Frequencies.

7.9.5 Match the fault frequency of a cursor location
AMS Machine Works compares all fault frequencies (including harmonics) to the current
cursor location. If the difference between the cursor frequency and a given fault frequency
is less than the match tolerance specified in the Plot Options tab, the frequency will be
considered a match.

Procedure

1. Activate a spectrum plot.

2. Mark a cursor to identify the location you want to match.

3. Press K on your keyboard.
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Matches display on the plot for the current cursor.

7.9.6 Match any available fault frequency
You can find a match from the entire peak list to any of the available fault frequencies. If
the difference between the frequency of a peak in the peak list and a given fault frequency
is less than the match tolerance specified in the Plot Options tab, the frequency will be
considered a match.

Procedure

1. Activate a spectrum plot, but do not place a cursor.

If you have a cursor on the plot, remove the cursor.

2. Press K on your keyboard.
Matches display on the plot for the entire peak list.

7.9.7 Locate peaks
When you mark a cursor, the cursor may be near the peak, on a slope instead of a peak.
Use this function to move the cursor so that it is on a precise peak. For example, it can be
used to determine the exact frequency and amplitude of a peak.

Procedure

1. On a spectrum plot, place the cursor on top of the desired peak by clicking near the
peak.

2. Click  on the Spectrum function bar or right-click on the plot and select
Locate Peak.

Note
To remove a peak, right-click on the plot and select Remove Peak. This action will
temporarily remove a group of points creating the peak from the spectrum plot and
will connect neighboring points with a straight line. You can bring all removed
peaks back by selecting Restore Peaks from a context menu.

7.9.8 Label peaks on single spectrum plots
If you have located peaks on a spectrum plot, you can label the peaks. You can label the
primary cursor or all cursors. Use the following methods:

Procedure

• To label the primary cursor, right-click on the plot and select Label Peak → Primary

Cursor. You can also use the Label Peaks button  on the Spectrum function
bar. Click the down arrow and select Label Primary Cursor.
The primary cursor is labeled with the horizontal axis value of the peak.
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• To label all cursors, right-click on the plot and select Label Peak → All Cursors. You can

also use the Label Peaks button  on the Spectrum function bar. Click the
down arrow and select Label All Cursors.
All cursors are labeled with the horizontal axis value of the peaks.

7.9.9 View multiple spectra in one plotting workspace
Multiple spectra plots can be viewed in the plot area together or separately.

Procedure

1. From the Details navigator, find a spectrum.

2. Press Shift and then click on another spectrum to select a range of data.You can
also press Ctrl and click more than one spectrum to select multiple, specific data.
The plots appear separately on the plotting workspace.

3. Right-click on the plotting workspace and select Display Spectra Together.

Note
To change the plot display back to separate plots, right-click and select Display
Spectra Separately.

7.9.10 Display calculated trend from cascade plots

Procedure

1. Mark a cursor on the plot.

2. Right-click and select Display Calculated Trend → Primary Cursor Location.

The Primary Cursor Amplitude Trend dialog is displayed.

Notes
• The generated trend plot includes data points from the displayed spectra.

• If a single cursor is marked on the plot, a calculated trend for the frequency or
order is displayed.

• If the plot has a reference cursor and a primary cursor, an additional option
allows the calculation of a trend for the spectral band bounded by cursors.

7.10 Waveform plots
A waveform plot is a graphical representation of how the vibration level changes with
time.

To view a waveform plot, click on a measurement location from the Locations navigator
and then select the appropriate waveform measurement from the Collections navigator.

In the Details navigator, under the Waveform table, select a date/time of interest.
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Figure 7-8: Waveform plot

7.10.1 Waveform function bar
These functions are available for waveform plots.

Click  to display all functions.

Button Function Description

Cursor Type Click to toggle cursor types: Single, Difference,
and Harmonic.

Mark RPM Click to display RPM markers. Use the arrow to
select Toggle Markers or Set Markers. Toggle
Markers displays or hides the RPM markers.
Toggle Markers synchronizes the RPM
markers with the current cursor location.
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Button Function Description

Filter Options Click the left or right button to show the
previous or next filter type. You can select all
the available options for band-pass and low-
pass filters.

Fault Frequencies Click to open the Fault Frequency List Viewer.
Click the left or right buttons to show the
previous or next fault frequency.

Peak List Click the left or right buttons to show the
previous or next peak.

Set RPM Click to open pop-up window allowing to set
correct RPM speed. Cursor can be used to
identify RPM value.

Toggle Display Format Click to change the plot display. You can view
a waveform in standard X/Y format or in a
circular format.

Toggle All/One Revolutions Click to display all revolutions or one
revolution at a time. When displaying one
revolution, click the left or right arrows to
display the previous or next revolution. Click
the first or last arrows to show the first or the
last full revolution (on some data plots,
clicking the arrow again will show the
remaining "partial" revolution"). When
displaying all revolutions, click the arrows to
step through each revolution with the cursor.

Play Audio Click to open the Waveform Audio Replay
dialog and listen to an audio recording of the
waveform.

7.10.2 Use micro-step cursor on waveform plots
Note
When moving the micro-step cursor, you are not moving through different data points,
but through virtual points only artificially created between real data points.

Procedure

1. Click on a plot.

2. On keyboard press Ctrl+LEFT ARROW or Ctrl+RIGHT ARROW to move through
different data points.

7.10.3 Display fault frequencies
You can display fault frequencies in autocorrelation plots, waveforms, and spectra. Fault
frequency markers start at the fist point in the waveform and are separated by time
distance being a reciprocal of the fault frequency.
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Procedure

1. Open a spectrum or waveform plot. To open auto the autocorrelation plot right
click on the waveform plot and choose Autocorrelate.

2. Expand the Spectrum or Waveform function bar.

3. Click .
The Fault Frequency List Viewer dialog appears.

4. Select a fault frequency.
The plot displays the selected fault frequency.

5. Select Keep Frequency Displayed if you want the plot to always display your
chosen fault frequency.

A checkmark appears beside the selected fault frequency.

Note
• You can select multiple fault frequencies to be always displayed.

• You can also click the left or right buttons to view the previous or next fault
frequency without opening the Fault Frequency List Viewer dialog.

To clear fault frequencies, right-click on the plot, and then click Clear Displayed
Frequencies or Clear Fault Frequencies.

7.10.4 Play waveform audio
Procedure

1. Activate a waveform plot.

The controls on the Function bar changes.

2. From the Function bar, click 
The Waveform Audio Replay dialog is displayed.

3. Use these buttons  to play and operate the waveform audio
recording.

4. You can also save a copy of the audio file by clicking .
The Save Waveform Audio File dialog is displayed. Browse to your selected folder
and then click Save.

7.10.5 View each revolution in a waveform
You can view each single revolution in a waveform plot. You can view all the revolutions on
the same plot or display them one at a time.

Procedure

1. Use the navigators to find a measurement point.

2. Expand the measurement point and then click a waveform.
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In the plotting workspace, a waveform is displayed for all the revolutions in the
measurement. The revolutions are selected based on set rotation speed.

You can select multiple waveforms. Press Shift and click the range of points. You
can also press Ctrl and then click multiple, specific waveforms.

Figure 7-9: Waveform plot: all revolutions in X/Y mode

3. Click  to toggle from all rotations to one revolution.

Figure 7-10: Waveform plot: one revolution in X/Y mode

4. Click the right and left arrows  to view the next and previous
complete revolution.

5. Click the first and last arrows  to view the first and last complete
revolutions.

To see a partial revolution after the last complete revolution, click the right arrow.

6. Click  to toggle from the waveform plot in standard X/Y format to a
circular format.

The waveform plot displays all the revolutions in the measurement.
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Figure 7-11: Waveform plot: all revolutions in circular mode

7. Click  to toggle from all rotations to one revolution.
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Figure 7-12: Waveform plot: one revolution in circular mode

8. Use the arrows to view each revolution.

7.11 Trend plots
A trend plot shows a set of values of a vibration parameter over a period of time.

To view a Trend plot, select a measurement location in the Locations navigator, and then
select a measurement type in the Collections navigator.

In the Details navigator, under the Trends table, select a date/time of interest.

Online Help Vibration Analyzer
October 2023

AMS Machine Works v1.7.5 175



Figure 7-13: Trend Plot

7.11.1 Trend function bar
These functions are available when a trend plot is shown on the plotting workspace:

Button Function Description

Trend On/Off Click the button beside the image to show all functions.

Label Point Displays a label for your selected data point.

7.11.2 View multiple trend plots on one plot
Trends with the same amplitude units can be displayed together in the plotting workspace
using the overlay feature. You can generate an overlay by dragging and dropping one plot
onto another plot.

For more information, see Overlay.
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7.11.3 Display critical, warning, and advise alarm levels
Procedure

1. From the plotting workspace, right-click on the trend plot, and then select Setup
Options.

2. On the Trend tab, go to Vibration Alarms under Display Options.

Select the alarms that you want to show.

To show upper alarm levels:

• Upper Critical

• Upper Warning

• Upper Advise

To show lower alarm levels:

• Lower Advise

• Lower Warning

• Lower Critical

3. Click Apply, and then click OK.

7.12 Connect Vibration Analyzer to a different AMS
Machine Works server
If you have more than one AMS Machine Works deployment, you can connect Vibration
Analyzer to a different AMS Machine Works server. For example, a site might have
different plants with AMS Machine Works setup independently on different networks, or
service personnel may use the same laptop to connect to different AMS Machine Works
servers as they visit plants and perform analysis on different AMS Machine Works servers.
When you have Vibration Analyzer installed, you can switch the AMS Machine Works
server in Vibration Analyzer. This is a convenient option because AMS Machine Works
Vibration Analyzer is a windows-based application. This feature allows a single installation
of Vibration Analyzer to select from a list of AMS Machine Works servers to connect to.

Note
The version of the Vibration Analyzer in the Windows client application must match the
version on the AMS Machine Works server.

Prerequisites

• Refer to your System Architecture drawings or other installation records for
information about where AMS Machine Works Web Services and AMS Machine Works
Historian are installed. They can be installed on the same server or on different servers.
You need the server connection information before creating a profile for each AMS
Machine Works server connection.

• Confirm the version of AMS Machine Works Vibration Analyzer you have installed is
compatible with the AMS Machine Works server.
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• Confirm the other AMS Machine Works server is available by using your browser to
connect to one of the web-based utilities such as Asset Explorer.

• Install the certificate from the AMS Machine Works server on your PC.

Procedure

1. Click  and select Machine Works Server Setting.

The Change Server Connections dialog appears. By default, the option Use the
default application connection settings is selected.

Figure 7-14: Change Server Connections dialog
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2. To change the server, create a profile for the connection.

a) Select Use a profile to specify different connection settings.

b) Under Select a Profile, click Create.

c) Under Profile Information, enter a name for the profile. Emerson
recommends using the name of the AMS Machine Works server.

d) For AMS Machine Works Web Service, enter the Host name and Port.
The host information for AMS Machine Works Historian is automatically
updated to the same information, by default.

Note
Only use an IP address if the AMS Machine Works was configured during
installation with the Use IP Address option. Emerson recommends using a
server name instead of an IP address for the setup.

e) If the AMS Machine Works Historian is on a different server, clear the check
box beside Use the same server as AMS Machine Works Web Service.
Then, under AMS Machine Works Historian, enter the Host name and Port.

f) Click Save.

The profile name appears in the Select a Profile menu as the selected profile. You
can edit this information later by clicking Edit. If you need to delete the profile, click
Delete.

3. Under Select a Profile select the profile name from the menu.

4. Click Connect.

The Connect button is only active if a profile is selected.

Vibration Analyzer displays information from the different instance of AMS Machine
Works. If there is a problem connecting to the server, an error message displays and
prompts you to edit the configuration settings.
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8 Asset Explorer
The Asset Explorer utility allows you to set up your site, create locations, add machines,
and arrange them according to how your plant is set up. You can set persona-specific
functions for user accounts by setting responsibilities and permissions in the User Manager
utility. Permissions and responsibilities ensure each user has the proper access to locations
and assets to which they are assigned. You can also do the following in the Asset Explorer
utility:

• Set up your site hierarchy: Add a Location

• Add assets to AMS Machine Works: Add a Machine Train

• Launch the AMS Machine Works Vibration Analyzer (VibApp): Home menu

8.1 User Interface Elements
Figure 8-1: Asset Explorer user interface

A. Ribbon— contains a link to the File menu and to the Home ribbon, a context-sensitive tab that displays
actions and editable settings.

B. Navigation bar— icons and breadcrumbs that help you move through the Location navigator.
C. Location navigator—displays the Location trees.
D. Contents pane— displays the name, description, and class of the item selected in the Location navigator.
E. Details pane— displays information based on the selection in the Contents pane.
F. Search bar— enables searching for machine trains and assets in the Location navigator, and contains a link

to the Search Menu.
G. User toolbar— enables launching of other applications, utilities, and software via the App Switcher, and

has links for the User Menu, Language Settings, Help, and a button to collapse the Ribbon.

8.1.1 Ribbon
The ribbon section contains three menus:
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Figure 8-2: Ribbon menus

A. The File menu, which has information about the current user and enables validation of
the license.

B. The Home menu, which is a context sensitive display of currently available actions and
settings.

C. The Search menu, which becomes available whenever the user has entered something
into the Search bar.

File menu
The File menu has two sections:

• System Info, which is displayed by default.

• Account, which has basic info about the current user and a sign out option.

Figure 8-3: System Info details

A. AMS Machine Works — Shows the activation status of the software.
B. About — Click on this section to open a window with detailed information about versions

and licences.
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Figure 8-4: Account section details

A. Name of the current user.
B. Clickable link to Sign Out.

Home menu
The Home ribbon displays different groups of contextual menus depending on what you
have selected in the Location navigator.

Figure 8-5: Home menu — contextual menu configurations

A. Main Site selected — default view.
B. User deflined Location selected.
C. User defined Machine Train or Asset selected.
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Figure 8-6: Home menu ribbon — icon specification

A. Rename — which enables you to change the name of the currently selected Location or
Machine Train.

B. Delete — which deletes the currently selected Location or Machine Train.
C. New Train — which adds a new Machine Train to the currently selected Location.
D. New Location — which adds a new Location folder as a child of the currently selected

Location.
E. Map Channels — which opens a browser tab where you can associate each channel on

an asset source with a particular measurement location on a Machine Train.
F. Failure Effects — which opens the Failure Effects selection submenu.
G. Edit — has two submenus:

• Edit Alert — which opens a browser tab for defining alerts.

• Edit Machine — which opens a Machine Configuration browser tab for editing the
currently selected Machine Train.

H. Analyze — which launches the AMS Machine Works Analysis Dashboard for the
currently selected Machine Train.

I. Machine Journal — which launches the AMS Machine Works Machine Journal for the
currently selected Machine Train.

J. Vibration Analyzer — which launches the AMS Machine Works Vibration Analyzer for
the currently selected Machine Train.

Search menu
This menu becomes available whenever the user has entered something into the Search
Bar.
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Figure 8-7: Search menu options

A. This Site — which enables you to search for assets, machine trains, and locations in the
entire Site.

B. Current Location — which enables you to search for specific values in the currently
selected Location.

C. All Child Locations — which enables you to search for specific values in the currently
selected Location and all of its Child Locations.

D. Asset — which enables you to search by selecting a single asset type, or by a combination
of asset types.

E. Location Class — which enables you to search for a specific location in all the defined
locations.

F. Failure Effects — which enables you to search by selecting a failure effect, or a
combination of failure effects, for assets and machine trains in the current location.

Note
Inverse search is also possible for finding assets and machine trains without a failure
effect or a combination of failure effects.

G. Open — This option is not currently used in AMS Machine Works.
H. Close Search — This option closes the Search menu.

8.1.2 Navigation bar
The Navigation bar is a group of navigational elements to aid the user in stepping through
the levels of the your Site and all the Locations and Assets it contains. The Navigation bar
has the following elements:
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Figure 8-8: Navigation bar elements:

A. Navigation arrows
• The back arrow moves to the last item selected in the navigator.

• The forward arrow moves the view to the previous view.

Note
The Forward arrow only becomes active after you have clicked back arrow.

• Click on the triangle icon to display a list of every place you have visited in this
session.

• The up arrow moves the view to one level higher in the your Site hierarchy.

B. Breadcrumbs — The breadcrumb path shows the full path to your current location in the
navigator. Go to any level within the path by clicking its breadcrumb.

8.1.3 Location navigator
The Location navigator enables you organize machines in the Asset Explorer utility in a way
that makes sense to you and your users. It also enables you view information about the
locations, machine trains, and assets you create. You can perform operations within the
context of a selected location or machine train.

The Location navigator is a representation of your Site with three main levels of
organization: Location → Machine train → Asset.

Figure 8-9: Location navigator - heirachy example

1. Location folders can be expanded and collapsed, and can contain other location
folders and machine trains.

2. Machine trains can be expanded and collapsed, and contain from one to three
assets.
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3. Assets are elements of a machine train such as fans, gearboxes, and motors.

Related information:

• For more information about how to add a Location: Add a Location

• For more information about how to add a Machine train: Add a Machine Train

8.1.4 Contents pane
The Contents pane displays information about locations, machine trains, and assets.
There are three columns:

• Name — the name of the Location, Machine Train, or Asset.

• Description — the user-defined description of the contents.

Note
Each Location has a default description of "Area".

• Class — the type of the item.
1. Area — the class for a Location.

2. Train — the class for a Machine Train.

3. Asset — one of the predefined classes for an Asset. (e.g., Motor, Pump, etc.)

Your selection in the Location navigator determines what data is displayed:

Figure 8-10: Contents pane

A. Site or Main Location — displays every child Location.

Note
Best practice is to place every Machine Train in the end nodes of a folder structure which
reflects the organization of your site. However, you can place them at any level of your
location structure if you need to.

B. Location — displays every child Location, or if it is an end node it displays every Machine
Train that it contains. (See the note above for exceptions.)

C. Machine Train — displays the assets included in that train such as a Motor, Pump, etc.
D. Asset

Related information:
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• For more information about how to add a Location: Add a Location

• For more information about how to add a Machine train: Add a Machine Train

8.1.5 Properties pane
The Properties pane displays detailed information about the currently selected Location,
Machine Train, or Asset. Different information is displayed for a Location vs. a Machine
Train or Asset.

Figure 8-11: Properties pane — Location view

Note
Save and Cancel buttons appear for you to confirm or reject any edits, and disappear once
you click one of the buttons.

For a Location the following fields are available:

A. The Location name
B. Description – You can edit the description here. The default description for a Location is,

“Area”.
C. Priority – A Location inherits its priority from its parent folder. You can change it here by

selecting from: Not Set, Low, Medium, High, or Very High.
D. Add link button – You can define a link to an external website.
E. Add Photo – You can add photos here.
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Figure 8-12: Properties pane — Machine Train and Asset view

Note
Save and Cancel buttons appear for you to confirm or reject any edits, and disappear once
you click one of the buttons.

For a Machine Train or Asset, the following fields are available:

A. Machine Train/Asset name.
B. Description – The description is displayed here, and can be edited here.
C. Manufacturer – This information is only filled in for an Asset.
D. Model Number – This is an Asset model number, and is only filled in for assets.
E. Serial Number – This option is not currently used in AMS Machine Works.
F. Tag – This option is not currently used in AMS Machine Works.
G. Priority – A Machine Train or Asset inherits its priority from its parent folder. You can

change it here by selecting from: Not Set, Low, Medium, High, or Very High.
H. Failure effects – This is an editable drop-down list. For more information refer to: Failure

Effects.
I. Interfaces – This is the name of the interface which the Asset uses to communicate,

currently only through AMS Machine Works.
J. CMMS Asset ID - This option is not currently used in AMS Machine Works

K. Add link button – You can define a link to an external website.
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L. Add Photo – You can add photos here.

8.1.6 Search bar
The Search bar is located in the top right area of the User Interface Elements . The Search
bar enables you to perform searches with different scopes:

Figure 8-13: List of search levels

A. Search in the entire Site, the main Location for this installation of AMS MW Asset
Explorer.

B. Search in the currently selected Location. For example, search for a Machine Train or
asset in the Denver plant.

C. Search in the currently selected Machine Train for an Asset. For example, search for the
motor in Denver train #1.

D. Search in the currently selected Asset for some data. For example, search for the failure
effects defined for motor #1.

The Search bar enables users to search with additional labels applied. For example, a user
can add Failure Effects labels to their search criteria. Once users click in the Search bar the
contextual Search menu ribbon is activated.

You can then type in some text to start your search. To refine your search results you can
choose to add labels by clicking on Asset, Location Class, or Failure Effects and selecting
labels.

For more information see: Apply Failure Effect Labels

Figure 8-14: Searching with labels and hints

This search bar has two labels added to refine the search, Class: Location and Failure
Effects: Production Control. Also, the Search bar is offering suggestions based on what
has been typed, 's'.
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Note
You can also define custom failure effects: Define Custom Failure Effect Labels

8.1.7 User toolbar
The User toolbar contains a links to other applications and services..

Figure 8-15: User toolbar

A. Application Switcher — this menu enables you to switch to other AMS Machine Works
applications. For more information: App Switcher

B. User Menu — this menu has information about the current user and the option to log
out. For more information: User Menu

C. Langugage Settings — this menu allows you to change the interface language for AMS
Machine Works. For more information: Language Settings

D. Online Help — click this link to get to the online version of this documentation. For more
information: Help

8.2 Locations vs. Assets
A Location or generic assets can contain a Machine Train, and other generic assets. In
certain situations, it makes sense to use one of these instead of the others. You can create
several types of Location and organize them in the Location Navigator. Every Location
has some basic properties, and every type of specialized location has some specific
additional properties. These specialized properties are represented in the Location
Navigator by icons.

Areas are the most basic type of Location and are represented by a folder icon. Its
properties include a name and links to its sub-locations (children).

Location assets are also represented by folder icons and can contain other locations, and
assets.

A machine, or a Machine Train, is a type of asset defined in AMS Machine Works. A
machine has specific properties defined for collecting measurements such as PeakVue,
vibration, and temperature. This data is analyzed and used to diagnose problems and the
condition of the equipment in order to schedule maintenance before a failure occurs.

Online Help Asset Explorer
October 2023

AMS Machine Works v1.7.5 191



Table 8-1: Assets vs. Locations

Property Assets Locations

Contents Generic assets can contain any number
of machines or asset sources, but
cannot contain a location.

A Location can contain any number
of sub-locations (children). This
allows you to organize your Location
Navigator in any way that makes
sense to you.

Filtering You can apply filter preferences to
assets so they are easier to find with
the search functions.

You cannot apply filter preferences to
locations.

Customization You can customize assets to display
specific icons and images.

The icon for a Location is always a
folder.

Related information:

• Add a Location

• Add a Machine Train

8.3 Add a Location
Use a Location hierarchy to represent the functional areas, floors, or sections of your site.
You can nest a Location within another Location.

 CAUTION

When you add a Location it inherits the priority of its parent Location.
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Figure 8-16: Add a Location

Procedure

1. In the Asset Explorer utility highlight a Site or Location.

2. In the Home ribbon click New Location.
A new location folder named New Area appears at the bottom of the Contents
Pane. You may type in a name now, or rename it later.

3. To rename a Location, highlight it in the Location navigator or in the Contents
pane.

4. Next, click Rename in the Home ribbon. You may now type in a name.

Postrequisites

Note
You can create a practically unlimited number of locations with a practically unlimited
depth of folder structure.

Postrequisites

Add a Machine Train to your site.

8.4 Add a Machine Train
Best practice is to add a Machine Train to an end (leaf) node folders in the Location
Navigator. The folders in the Location Navigator should be organized in logical groups
which are similar to the organization of the physical site in your facility.
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Note
You can add a Machine Train to your main Site or at any level in the Location Navigator if
you need to.

 CAUTION

When you add a Machine Train it inherits the priority of its parent folder.

Figure 8-17: Add a Machine Train

Procedure

1. In the Asset Explorer's Location Navigator, highlight the Location where you want
to add a Machine Train.

2. In the Home ribbon, select New Train.

Your view is transferred to a new tab in your browser for further configuration steps.

Postrequisites

Follow the instructions in the Machine Configuration section beginning with Step 1: Add
Machine Train Details.

Related information:

• Add a Location

• Locations vs. Assets

• Step 2: Add Machine Details

• Step 3: Channel Mappings

• Step 4: Summary

8.5 Edit a Machine Train
You can start to reconfigure a Machine Train in the Asset Explorer by selecting the Edit →
Edit Machine option in the Home menu.
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Figure 8-18: Select the Edit Machine option

Procedure

1. In the Asset Explorer select a Machine Train in either the Location navigator or
Contents pane.

2. There are two ways to access the Edit Machine function:

a) (Shown above.) Right-click on a Machine Train or a Component, and select
the Edit → Edit Machine option.

b) In the Home menu select Edit → Edit Machine.

Your view is transferred to a new tab in your browser for further configuration steps.

Postrequisites

Follow the instructions in the Machine Configuration section beginning with Step 1: Add
Machine Train Details.

Related information:

• Add a Location

• Locations vs. Assets

• Step 2: Add Machine Details

• Step 3: Channel Mappings

• Step 4: Summary

8.6 Edit Alerts
You can edit the Alerts for a Machine Train in the Asset Explorer.
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Figure 8-19: Select the Edit Alerts option

Procedure

1. In the Asset Explorer select a Machine Train in either the Location navigator or
Contents pane.

2. There are two ways to access the Edit Alert function:

a) (Shown above.) Right-click on a Machine Train or a Component, and
selecting the Edit → Edit Alert option.

b) In the Home menu select Edit → Edit Alert.

Your view is transferred to a new tab in your browser for further configuration steps.

8.7 Renaming Locations, Machine Trains, and
Assets
To rename a Location, Machine Train, or Asset follow this procedure below.

Figure 8-20: Rename Icon
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Procedure

1. In the Location navigator or Contents pane, select a Location, Machine Train, or
an Asset and then click Rename in the Home menu.

2. In the name field of the item, enter the new name, and then press the Enter key to
accept the change.

3. To reject the name change, press the Esc key.

The new name is displayed.

8.8 Deleting Locations and Machine Trains
To delete a Machine Train or Location you may use the following method. It is
recommended to only delete items at the end (leaf) nodes of your heirarchy.

 CAUTION

Deleting a Machine Train or Location also deletes ALL of its descendants or contents. (i.e.,
ALL of the Location, Machine Train, or Asset elements that it contains.)

Figure 8-21: Delete Icon

Procedure

1. In the Location Navigator or Contents pane, select a Location or Machine Train,
and then click Delete in the Home menu.

2. Click OK to confirm your intention to delete.

 CAUTION

Deleting a Machine Train or Location also deletes ALL of its descendants or
contents. (i.e., ALL of the Location, Machine Train, or Asset elements that it
contains.)

3. Click Cancel to finish without deleting.
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8.9 Failure Effects
Failure Effects settings help you identify and organize both Machine Train and Asset
elements by the effects caused if they fail. For example, you could label a Fan Asset with an
Environmental Control setting if the purpose of the fan is to provide cooling to a
production environment.

 CAUTION

1. Failure effects are for informational purposes only.

2. Failure effects do not affect system performance or trigger alerts.

3. Failure effects are only for filtering searches.

8.9.1 Apply Failure Effect Labels
Failure Effects are labels for categorizing system elements. This enables grouping and
filtering of these elements when using the Search bar.

Note
Failure Effect Settings do not transfer automatically in either direction between Machine
Train and Asset elements. All Failure Effect Settings must be made separately for each
individual element.

There are three ways to apply labels in the Asset Explorer:
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Apply an effect — right-click method

Figure 8-22: Method One: Apply a Failure Effect with a right click

Procedure

Right-click method: In the Location navigator or Contents pane, right-click on a Machine
Train or an Asset and select an effect from the Contextual Menu → Failure Effects menu.

Online Help Asset Explorer
October 2023

AMS Machine Works v1.7.5 199



Apply an effect — Home menu method

Figure 8-23: Method Two: Apply a Failure Effect by the Home menu

Procedure

Home Menu method: In the Location navigator or Contents pane, select a Machine Train
or an Asset and then in the Home Menu click Failure Effects and select an effect to add.

Apply an effect — Properties pane method

Figure 8-24: Method Three: Apply a Failure Effect — Properties pane method
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Procedure

1. Properties pane method: In the Location navigator or Contents pane, select a
Machine Train or an Asset and then in the Properties pane select all the applicable
effects from the Failure Effects drop-down menu.

2. Next, click Save to confirm your choices, or Cancel to reject your choices.

8.9.2 Remove Failure Effect Labels

This is the same method as: Apply an effect — Properties pane method. So you may also
use this method to add effects.

Figure 8-25: Remove Failure Effect Labels

Procedure

1. Properties pane method: In the Location navigator or Contents pane, select a
Machine Train or an Asset and then in the Properties pane select the effects from
the Failure Effects drop-down menu that you want to remove.

2. Next, click Save to confirm your choices, or Cancel to reject your choices.

8.9.3 Define Custom Failure Effect Labels
You can define or modify Failure Effects and assign a colored label to them. There are 25
colors to choose from.

Procedure

1. In the Asset Explorer, select a Machine Train or Asset in the Location navigator.
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Figure 8-26: Choose: All Failure Effects

2. Right-click your selection and choose Failure Effectsfrom the menu, or click the
Failure Effects menu in the Home ribbon, and then select All Failure Effects.

Note
This step is similar to:
• Apply an effect — right-click method

• Apply an effect — Home menu method

3. In the window that pops up, click the New button.
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Figure 8-27: Add a new Failure Effect

4. Enter a new Failure Effect name and choose a color.

Note
Default is without a color.

Figure 8-28: Enter a new Failure Effect name

5. To modify, rename, or delete a user defined Failure Effect follow Step One and Step
Two and then click Rename, Delete, or choose a new color.
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Figure 8-29: Modify or Delete a user defined Failure Effect
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9 Machine Journal
The Machine Journal is a web application in AMS Machine Works. The Machine Journal
enables Analysts to track problems which are developing in machines.

The Machine Journal application is also accessible from a menu in VibApp (Vibration
Analyzer application).

The Machine Journal enables you to:

• track work orders for every Machine Train

• and add notes and observations along with supporting images and data

• search for and filter cases

• gather statistics which complex analysis

• create case reports to support work orders

9.1 Launch the Machine Journal
The Machine Journal can be launched by the App Switcher in the Analysis Dashboard, or
from other utilities such as the Asset Explorer.

See:

• App Switcher

• Home menu

9.2 Machine Journal Terms
Terms

The following terms are used to describe the Machine Journal functionality.

Case A case is related to a machine asset. It has a title, creation date,
severity, urgency, open or resolved status, and a list of posts.

User Mention A user mention is used to associate a user with a post, which is
different from a Tag. A tag is used to categorize a post by, for
example, fault type. User mentions are prefixed by the @ sign.

Post A post is a note, data link, or image that is associated with a case.

Tag A tag is a word or phrase used to identify or categorize a post.
Tags are prefixed by a # sign.

Urgency Urgency is a property you can assign to a case to indicate how
quickly the problem needs to be fixed. Urgency has a number,
caption, and corresponding color. You can select urgency from a
list of values and create custom values. You can manage the list of
values for urgency. The urgency you set applies only to Machine
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Journal cases and does not contribute to the health value of a
machine.

Severity Severity is a property you can assign to a case to indicate how
much impact this problem has on your plant or operations.
Severity has a number, caption, and corresponding color. You can
select severity from a list of default values and create custom
values. You can manage the list of values for severity. Use severity
to indicate the significance of the problem or the impact to your
plant operations. The severity you set applies only to Machine
Journal cases and does not contribute to the health value of a
machine.

Work
Recommendation

The request for action to be tracked and executed on particular
machine asset.

9.2.1 Machine Journal user interface
The Machine Journal Posts News Feed is the main view from which you navigate the site
and select machines to add or modify cases.

Figure 9-1: Machine Journal user interface

A. Home ribbon menu—options for case creation, search and sort cases, and to create a
report

B. Navigation tree—list of machines that may have cases added to the components under
each machine

C. Posts news feed—list of cases based on the selection in the navigation tree
D. Search bar—list in which you can add or remove search parameters
E. Case history details—a summary of machine information, history, tags, users, and

work recommendations

The information displayed in the navigation tree depends on the responsibilities assigned
to your user. The responsibilities are configured in the user settings, available from the File
→ User Settings menu in Asset Explorer or User Manager.
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The home ribbon displays different options depending on what is selected. Options
display in the ribbon menu based on your context in the tree. These options are also
available from a context menu. Right-click a node in the tree to see the available options.

Table 9-1: Home ribbon menu default options

Option Description

Show resolved Show cases that are resolved.

Search Open the search ribbon menu to refine the results displayed in the
cases in the Posts News feed.

Newest First Display newest cases first.

Oldest First Display oldest cases first.

Create Report Open the News Feed view in print preview mode.

9.3 Machine Journal settings

9.3.1 Severity and Urgency
Severity and Urgency are properties of a case that help you describe the impact of a
problem and how quickly the problem needs to be fixed. These categories are used only
within the Machine Journal application and do not contribute to the health value of a
machine.

9.3.2 Customize severity and urgency
You can customize the text, value, and color for the Severity and Urgency categories.

You can add new items to the categories or edit and delete existing items. The default
values can only be deleted if they have not yet been used in the system.

Procedure

1. Select File → Urgency Settings or File → Severity Settings.

2. Hover over a category.

The row becomes light blue and displays a pencil icon and a trash icon.

3. To add a new category, click Add new.

A new row appears for the category in edit mode.
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Figure 9-2: Urgency Settings: Add a new category

4. Edit the number, select a color, and add a text label for the category.

5. To edit an existing category, click the pencil icon or double click the category.

You can change the number, color, or text of an existing item. Each entry must be
unique. Do not select the same color, text, or number used by another category.

6. To delete an existing item, click the item, then click the trash icon.

You can delete an existing category if it is not used in the system. Hovering over the
trash icon displays a message that the category is used in the system. If the
category is not used in the system, the trash icon is dark gray, indicating it is active.
If the category is used in the system, the trash icon is light gray, indicating it is
inactive.

9.3.3 Show or hide resolved cases in the navigation tree
You can show or hide resolved cases. By default, resolved cases are hidden. Resolved cases
must be displayed before you can reopen a resolved case.

Procedure

Click Show Resolved in the Home ribbon to show the resolved cases in the navigation
tree.

The navigation tree shows all resolved cases.

Machine Journal Online Help
October 2023

208 AMS Machine Works v1.7.5



9.3.4 Show or hide deleted posts in case information
When you select to show deleted posts in the case information, all cases will show all the
deleted posts. Emerson recommends using the default setting, which hides the deleted
posts. You can temporarily show deleted posts to perform an audit of the cases.

Procedure

1. Select File → Settings → Preferences.

2. Place a check mark in Show deleted posts in the case information.

9.4 Procedures

9.4.1 View the Posts News Feed
The Posts News Feed shows all the information below your selection in the navigation tree,
according to your settings. You can modify your view of the Posts News Feed by date and
time order. By default, the news feed shows newest posts first.

Procedure

• In the navigation tree, select the root node to display all open cases.

• Select a machine to display only the cases and posts for the machine.

• Change the sort order by selecting either Oldest first or Newest first in the ribbon.

9.4.2 Set news feed sort and filter options
From the Search ribbon, you can select options for customizing your news feed and posts.

As you select options to customize your search results, the search results are automatically
updated.

Procedure

1. Click Search on the ribbon or place the cursor in the search bar.

A Search Tools ribbon appears.

2. Select any node in the tree to narrow the results to the items below the selected
node. For example, select a folder to display the cases of machines in that area.

3. Reorder the search results by selecting Ascending Order or Descending Order from
the home tab of the ribbon.

4. Type text in the search parameters bar.
The search phrase is compared against case title and post descriptions.

5. In the Search Tools ribbon, select from the filter options to limit the results.

Option Description

State Show cases by state: open, resolved, or deleted. All states are
included by default. This search setting is independent from the
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Option Description

preferences setting to show resolved cases or deleted posts. If you
have Hide Resolved selected in the ribbon, you can still see resolved
cases when you select resolved as a search property.

Urgency Show cases with the urgency selected.

Severity Show cases with a selected severity.

Tag Tags are specified in notes field prefixed by the # symbol.

User Users are specified in notes field prefixed by the @ symbol. List of
users is provided from the User Manager utility.

Asset Type Asset type shown in Asset Explorer.

Date Range Show only results within range defined by the dates. Select only a
start date to show results newer than the specified date and newer.
Select only an end date to show results older than the specified date.
When you choose the date, it appears on the search parameters bar.
If you need to change the date, click the x beside the date to clear
the date.

The results view displays all matching posts.

The search options you select are shown as filters with an x in the search parameters
bar.

6. Remove a search parameter by clicking x.

9.4.3 Create a new case
When creating a new case, some basic information is required such as: title and
description. The title and description are required. Values indicating severity and urgency
are required and set to the highest level by default. You can update the case later, for
example, by adding: images or a post to the case, or by changing the urgency or severity
of the case.

Procedure

1. In the Posts News feed, select a machine from the navigation tree.

Existing cases display in the main pane. If the machine has no cases, the main pane
is empty.

2. Click Add case in the ribbon.

An entry named *New case appears beneath the selected machine. The asterisk (*)
means the case is not saved.

The Create Case view appears with placeholders for you to fill in.

3. Provide a name for the case. Use a name that helps identify the symptom being
diagnosed.

4. Add notes in the description field.
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In the description, you can add tags by entering a # before the word to be tagged.
You can mention users by entering @ and selecting a user from the list.

5. Select a value for Severity. The default is Impending Failure (1).

6. Select a value for Urgency. The default is Critical (1).

7. Click Publish.

The new case name appears (without an asterisk) in the tree in the left panel.

An entry named Case Opened appears in the case. The entry includes the user's name, the
current date and time, the severity and urgency settings, and the description.

Machine details, post history, and summary information display in the case details on the
right side of the case information.

The case status is open.

9.4.4 Add and remove notes and tags on a case
A case shows all the tags from underlying posts. When you add a post to a case, and the
post contains a tag, the tag is associated with the case if the case did not already have the
tag. A machine condition is a type of tag.

To remove a tag from a case, delete the post in the case that contains the tag you want to
remove.

9.4.5 Add a post to a case
When you add a new post to a case, the post contains one note and may contain images,
data links, attachments and work recommendations. You can also change the severity or
urgency of the case. Changes you make to the case while editing the post will be included
in the post. You can add multiple posts to a case. You can add a post to an open case but
not to a resolved case. Once you create the post, you cannot edit the post, but you can
update the case information by adding a reply to the post or creating a new post. For
example, you cannot change the severity or urgency of the case in a post, but can in a
reply.

Prerequisites

The machine has an open case.

Procedure

1. In the navigation tree, select the case you want to update.

The case information displays the case details, posts, and replies.

2. Select Add Post from the ribbon.

The Add Post form appears below the case title.
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Figure 9-3: New post form

3. Add a note, images, or data links as a main part of the post.

4. Click Publish.

The post is added to the case. The user name and current date and time are saved
with the post.

Add a tag or mention a user to a post
Tags and mentions help you flag any topic or user you want to associate with your case.
You can tag any phrase or mention a user while typing in a post. When you mention a user,
the post or case displays in that user’s Machine Journal Dashboard. When using Search,
select tags and users to limit the results.

Procedure

• To tag a phrase:

a) While typing a note, create a tag by starting a phrase with the # symbol. Text
you type after # is the tag.

As you type the tag, any relevant matching tags appear in a list.

b) Select the existing tag from the list, or continue typing to create a new tag.

When you type a new tag for the first time and save the post, that tag will be
available in future posts.

• To mention a user:

a) While typing a note, mention a user by typing the @ symbol.

b) Select a user from the list that appears by the @ symbol.

Add images to a post
When adding a post, you can click the + icon beside the notes field to add an image. You
can also drag and drop an image or attachment.

Machine Journal Online Help
October 2023

212 AMS Machine Works v1.7.5



Procedure

1. Click the + icon beside the notes field and select Add image.

2. In the Browse dialog, locate the image to upload. Click OK.
The image appears in the next available box after the + icon.

3. Add more images if desired.

4. To discard one of the uploaded images, click the image in the post.
The Gallery dialog appears.

A. Selected image
B. Delete
C. Next image in gallery
D. Full screen view

5. Click  to delete the selected image.

6. Close the Gallery dialog when finished.

7. Click Publish.

The added images are saved when the post is saved. If the post is discarded, the
added images are also discarded.

Add data from Vibration Analyzer to a post
When adding a post, you can click the + icon beside the notes field to add data from
Vibration Analyzer. This lets you easily launch Vibration Analyzer to select the image to
add. Images added from Vibration Analyzer are standard images in Machine Journal and
are included in the attachments limit.

Procedure

1. To the right of the notes field, click the + icon to the right of the notes field and
select Add data from VibApp.

2. Vibration Analyzer launches.

3. Finish editing the post and click Publish. The added data is saved when the post is
saved. If the post is discarded, the added data is also discarded.
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Add attachments to a post
When adding a post, simply drag and drop an image or document to your post. Or you can
click the + icon beside the notes field to add attachments. The attachments list can
contain up to 64 items (up to 50 MB per document and 15 MB per image). The images
from Vibration Analyzer are standard images and also count in this total. If you add an
image as an attachment, it appears in a documents list, and to see it, you must download
the image first. If you prefer to see preview icons of your images, do not upload it as an
attachment; add it as an image instead.

Procedure

1. To the right of the notes field, click the + icon and select Add attachment.

2. In the Browse dialog, locate the attachment to upload. Click OK.
An Attachment link appears in the post below the image gallery. The number of
attachments displays in parentheses.

3. To view, edit, or discard one of the attachments, click Attachments.
The Attachments dialog displays a list of attachments and actions including
download, edit the description, delete, or add a new attachment.

Figure 9-4: Attachments dialog

4. Click the pencil icon and type a description. Click Save.

Adding a description helps provide other users with more information to identify
the attachment without downloading and opening the attachment.

5. Click Close.

6. Finish editing the post and click Publish. The added attachments are saved when
the post is saved. If the post is discarded, the added attachments are also discarded.

Add a work recommendation to a post
While adding a post, you can add a recommendation to a case. A work recommendation is
a type of note that lets you categorize work or a suggestion to fix the problem. One way a
work recommendation is helpful is that you can search for cases with work
recommendations. It helps you track information about the work performed on a specific
case as well. You can use the work recommendations like a ToDo list. A case can only be
resolved when its work recommendations are resolved or rejected.
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Figure 9-5: Work Recommendations dialog

Procedure

1. Click Add recommendation in the ribbon.

2. In the Work Recommendations dialog, enter a Subject, Priority, and a Description
and click Add.
A Work Recommendations link appears in the post below the image gallery. The
number of recommendations displays in parentheses.

3. To view, edit, or discard one of the work recommendations, click Work
Recommendations.
The Work Recommendations dialog displays a list of work recommendations and
actions including view details, edit, delete, and add.

Figure 9-6: Work Recommendations dialog

4. Click the pencil icon to edit the description, subject, and status. Click Save.

5. Click Close.

6. Finish editing the post and click Publish.
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The recommendation is saved when the post is saved. If the post is discarded, the
recommendation is also discarded.

The work recommendation is created with an active status.

All work recommendations for a case must be resolved or rejected before the case can be
resolved.

Add a reply to a post
A reply is a post that you can use to add more details to the case. You can add a reply to a
post in an open case. For readability, all posts and replies are displayed at the same level of
a case, not nested within posts. If you reply to a post, it appears as a post to the case. The
posts are nested and collapsed by default.

Procedure

1. In the navigation tree, select the case you want to update.

The case information displays the case information, posts, and replies.

2. Click Reply on a post that you want to update.

A reply field appears where you can fill in notes or add images.

3. Click Publish.

The reply appears on the case information screen, under the original post.

9.4.6 Delete a post from a case
You can delete a post from an open case, one post at a time. Deleted posts are marked as
deleted, and by default do not appear in the case information. You can change the
settings to show deleted posts.

Procedure

1. In the navigation tree, select an open case.
The case information shows posts and replies, if present.

2. Locate the post to delete.

3. In the upper right corner of the post, select ... → Delete post.

4. At the prompt, select OK.

The post no longer appears in the case information. You can select other posts to
delete.

9.4.7 Update a work recommendation
All work recommendations for a case must be resolved before the case can be resolved.
The status can be Completed or Rejected.

Procedure

1. In the Posts news feed, select a machine from the navigation tree.
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Existing cases display in the middle pane. If the case has work recommendations,
the case details contain links to the Work Recommendations list.

2. Click All to see all of the work recommendations. Choose other links to see the
items of that status (Active, Completed, or Rejected).

3. In the Work Recommendations list, click the checkmark to mark the work
completed, or click X to reject the work recommendation.

9.4.8 Resolve a case
When you are finished working on a case, mark it resolved so it no longer appears in the
list of cases.

Procedure

1. In the navigation tree, select an open case.

2. Click Resolve case in the ribbon bar.

3. A new post appears with a Resolve case button.

4. Fill in details about why the case is being resolved.

5. Click Resolve Case.

The case status is resolved. The case no longer appears in the navigation tree. You can
show or hide the list of resolved cases by clicking Show Resolved from the Home ribbon.

9.4.9 Delete a resolved case
Prerequisites

Resolve the case. A case status must be set to resolved before it can be deleted.

Deleting a resolved case causes it to become an archive. Once deleted, the case cannot be
reopened. When resolved cases are visible in the navigation tree, you can delete or reopen
a resolved case.

Procedure

1. Click Show Resolved in the Home ribbon to show the resolved cases in the
navigation tree.

2. Select the case you want to delete.

3. Select Delete case from the ribbon.

4. At the prompt, select OK.

The case status is deleted.

By default, deleted cases do not appear in the navigation tree. The case appears in the
navigation tree if Show deleted cases, posts, and replies is enabled in Preferences.
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9.4.10 Reopen a resolved case
After a case is resolved, it may be necessary to open the case again. If more work needs to
be done on the same issue, it is convenient to reopen a resolved case instead of creating a
new case.

Procedure

1. Click Show Resolved in the Home ribbon to show the closed cases in the navigation
tree.

2. In the navigation tree, select the case you want to reopen.

3. Select Reopen case from the ribbon.

The Reopen case post view appears.

4. Write an explanation for reopening the case.

5. Click Publish.

The case status is open.

The case appears in the tree in the left panel.

9.4.11 Print a report of the Machine Journal screen
You can print the contents of your Machine Journal screen as a PDF report.

Prerequisites

Install a PDF generator as a printer on the computer if you want to save the report as a
PDF. Contact your IT department if you do not have a PDF option in your list of printers.

Procedure

1. In the navigation tree, select a machine to display the cases and posts for the
machine.

2. Select Create Report in the ribbon.

A new window displays a print preview of the report.

3. Print the report.

9.5 Vibration Analyzer

9.5.1 Launch Vibration Analyzer from Machine Journal
You can launch Vibration Analyzer to show the machine you have selected in Machine
Journal.

Prerequisites

Vibration Analysis must be installed on the PC where you are using Machine Journal.
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Procedure

1. In the Machine Journal navigation tree, select a machine.

2. Click Vibration Analyzer in the ribbon.

Vibration Analyzer opens to this machine in the Location Navigator.

9.5.2 Create a new case from Vibration Analysis
In Vibration Analyzer you can see a list of existing cases for a machine in the Machine
Journal Browser pane.

You can also create a new case while using Vibration Analyzer.

Procedure

1. In Vibration Analyzer, select a machine in the Location navigator.

2. Select the Machine Journal Case Browser tab.

The tab displays a list of open cases for the selected machine.

3. Select Add Case.

Machine Journal opens to the new case for this machine.

4. In Machine Journal, fill in placeholders with new case information:

5. Type a title for the case.

a) Select values for Severity and Urgency.

b) Click Publish.

The new case appears in the tree in the left panel.

The user name and current date and time are saved with the new case.

The case status is open.

9.5.3 Add a new post to a case from Vibration Analyzer
In Vibration Analyzer you can see a list of existing cases for a machine.

You can update a case in Machine Journal by adding a new post while using Vibration
Analyzer.

Procedure

1. In Vibration Analyzer, select a machine in the Location navigator.

2. Select the Machine Journal Case Browser tab.

The tab displays a list of open cases for the selected machine.

3. Locate the case you want to edit and select + in the Add Post column.

Machine Journal opens to a new post for this case.
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10 User Manager
User Manager functionality is different for Administrators, and regular users, (i.e., Non-
Administrators).

Administrators can use the User Manager to add users to, or remove users from, the
system. Administrators can also edit properties, responsibilities, and other settings for all
users.

For Non-Administrators, the User Manager displays read-only information about that
user's settings and responsibilities.

Note
Administrators are users that have been given the MANAGEUSER permission in User
Manager.

Note
Some options may not be available in your user account, and may only be available for
Administrator accounts. Some features may be visible in the user interface but have no
function. For example, tokens are not used by AMS Machine Works.

10.1 User Manager Interface Overview
The user interface for the User Manager is divided into five main sections. The Ribbon
menu, and the three information panes (Navigation, Contents, and Details), and the Tab
Menu.

Your selection in the Context Tab Menu changes the functionality and informational
content of the other four sections.

The image below shows a general overview of the sections of the User Manager interface.
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Figure 10-1: User Manager — Interface Overview

A. Ribbon menu — The appearance of the Home tab of the Ribbon menu changes
depending on which Context Tab, marked as E in the image, is currently selected. See:
Ribbon Menu
For a full description of the Home Menu functionality which is available when a
particular Tab is selected see:
• Users Tab: User Management Functions

• Templates Tab: Template Management Functions

• Licenses Tab: License Management Functions

B. Navigation Pane — This pane displays a different folder hierarchy depending on which
Tab is currently selected. See: Navigation Pane

C. Contents Pane — This pane displays lists of items based on your selection in the
Navigation pane. See: Contents Pane

D. Details Pane — This pane displays detailed information about the item currently
highlighted in the Contents pane.
For a full description of what information is displayed in the Details Pane when a
particular Tab is selected see:
• Users Tab: Details Pane — Users Tab Selected

• Templates Tab: Details Pane — Templates Tab Selected

• Licenses Tab: Details Pane — Licenses Tab Selected
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E. Context Tab Menu — The Context Tab Menu enables you to switch contexts. See:
Context Tab Menu

10.1.1 Context Tab Menu
There are three tabs on the bottom left side of the User Manager Interface page. This
Context Tab Menu controls the context you are operating in.

The Context Tab Menu enables you to switch between three contexts, Users, Templates,
and Licenses.

The Home tab in the Ribbon menu, and the three information panes (Navigation,
Contents, and Details), change their functionality and informational content depending
on which Context Tab you have selected.

Links to detailed information about how each Context Tab affects the other four user
interface elements is listed below.

1. Users context:
• Navigation Pane: Navigation Pane

• Contents Pane: Contents Pane

• Details Pane: Details Pane — Users Tab Selected

• Home Menu: User Management Functions

2. Templates context:
• Navigation Pane: Navigation Pane

• Contents Pane: Contents Pane

• Details Pane: Details Pane — Templates Tab Selected

• Home Menu: Template Management Functions

3. Licenses context:
• Navigation Pane: Navigation Pane

• Contents Pane: Contents Pane

• Details Pane: Details Pane — Licenses Tab Selected

• Home Menu: License Management Functions

10.1.2 Ribbon Menu
The Ribbon Menu in the User Manager utility is a context dependent collection of
functions. The Ribbon Menu is divided into three sub-menus: File, Home, and Settings.

• File Menu: This menu does not change when you change your selection in the Context
Tab Menu, and is identical to the File Menu in the Asset Explorer. See: File menu

• Settings Menu: This menu does not change when you change your selection in the
Context Tab Menu. See: Ribbon Menu — Settings Menu Functions
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Figure 10-2: Settings Menu

See: Ribbon Menu — Settings Menu Functions

• Home Menu: This menu changes its layout depending on your selection in the Context
Tab Menu:

Figure 10-3: Home Menu — Users Tab Selected

See: User Management Functions

Figure 10-4: Home Menu — Templates Tab Selected

See: Template Management Functions

Figure 10-5: Home Menu — Licences Tab Selected

See: License Management Functions

10.1.3 Navigation Pane
The Navigation Pane has folders for different types of records.

• When operating in the Users Tab context the Navigation Pane has the following folder
structure:
— All Users
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• Administrators: These Users have administration privileges.

Note
Administrators are users that have been given the MANAGEUSER permission.

• Non-Administrators: These Users do not have administration privileges.

• When operating in the Templates Tab context the Navigation Pane has the following
folder structure:
— All Templates

• Default Templates: This folder contains system defined Templates.

• Custom Templates: This folder contains Templates created with the Create a
User Template process.

• When operating in the Licenses Tab context the Navigation Pane has the following
folder structure:
— All

• Good: A Good License has more than 80% of its resources still available.

• Fair: A Fair License has less than 80%, but more than 0%, of its resources still
available.

• Poor: A Poor License has 0% of its resources still available.

Note
A License which is based on a Start Date and an End Date is Good until the End
Date and then it is Poor. See: License Management Functions

10.1.4 Contents Pane
The Contents Pane is a list of records available in the folder which is selected in the
Navigation Pane.

Depending on which Context Tab Menu you have selected, different columns of
information will be displayed.

• When the Users Tab is selected:
— Name – The name of the user.

— Username – The alias defined in the system for the user.

— Email – The email associated with the user.

— Last activity – The date and time of the last user activity.

• When the Templates Tab is selected:
— Name – The name of the template.

— # of Permissions – The number of permissions assigned to this template.

— # of Locations – The number of locations available for this template.

• When the Licenses Tab is selected:
— Status – The status of the license.
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— Source – The source of the license. The default is AMS Machine Works.

— Feature – The name of the license. In AMS Machine Works 1.7.5 there are two
entries.
• AMS_Machine_Works_OPC_UA_Server: This is the License for the software.

• AMS_Machine_Works_Users: This is the License for the number of unique User
accounts which are available.

— Expires – The date when the license will expire.

10.1.5 Details Pane
The Details Pane displays information and controls based on your previous selections in
the Context Tab Menu, the Navigation Pane, and the Contents Pane.

The format and controls are set by your selection in the Context Tab Menu, and the
informational content is determined by your selections in the Navigation Pane and the
Contents Pane.

The three sections below show the exact layout and contents of the Details Pane for each
context:

• Details Pane — Users Tab Selected

• Details Pane — Templates Tab Selected

• Details Pane — Licenses Tab Selected

Details Pane — Users Tab Selected
The User Manager provides functionality in the Details Pane for changing a user's
permissions, and for granting access to each Location they can view in AMS Machine
Works.
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Figure 10-6: Details Pane — Users Tab Selected

A. Name – The first and last name of the User. Click the Edit link to edit this value. See: Edit
Name

Note
The name of the initial user, the Admin user, is not editable.

B. Email address – The email address associated with this account. Click the Edit link to
edit this value. See: Edit Email

C. Last activity – The date and time when the user was logged in the last time.
D. Status – By default this field is empty. It can display three statuses:

• Administrator – For an account which has the MANAGEUSER permission.

• Disabled – For an account which is disabled. See: Disable / Enable a User

• Locked – For an account which is locked. See: Lock / Unlock a User

E. Edit Permissions button – Click this button to edit the permissions that this user has.
Descriptions of each permission are provided on the screen. See: Edit Permissions

F. Permission List – This list is empty by default. It can contain one or both of the possible
permissions, MANAGEASSETSOURCE and MANAGEUSER.

G. Edit Locations button – Click this button to open the Edit Locations window where you
grant access to specific locations. See: Edit Locations

H. Location List – The default option is the root of your Location structure. Access can be
edited individually for every item in your Location structure.
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Edit Name

Figure 10-7: Edit Name

• Add a First name and a Last name for the User and click OK to accept this change.

• Click Cancel to finish without making changes.

Note
The name of the initial user, the Admin user, is not editable.

Edit Email

Figure 10-8: Edit Email

• Add an Email address for the User and click OK to accept this change.

• Click Cancel to finish without making changes.

Edit Permissions

Figure 10-9: Edit Permissions

Two different permissions can be selected:

• MANAGEASSETSOURCE – This permission enables the user to add and remove asset
sources.

Note
This option is not supported in AMS Machine Works 1.7.5.
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• MANAGEUSER – This permission gives the user administrator privileges. Specifically, it
allows the user to perform the following actions in the User Manager: manage users;
manage templates; manage user, password, lockout, and OIDC settings.

Note
The original 'admin' account cannot be deleted and always retains MANAGEUSER
permissions.

Edit Locations

Figure 10-10: Edit Locations

• Access can be granted to specific a Location folder individually for an end node in your
hierarchy, or to the entire contents of a Location folder and all of its sub-folders.

Details Pane — Templates Tab Selected
A Template is a configuration of permissions to access specific functions and locations for
a role within your organization. Every User who has the same Template has the same
permissions.

For example, you could define template for every User who has access to "Plant A", but
does not have access to "Plant B". See: Create a User Template

Afterward, when you have a new User, you can apply the appropriate Template for that
person's role. Apply a User Template

Note
When you change a Template that has been used to set the Permissions for a User it must
be manually reapplied to the User for the changes to take effect.
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Figure 10-11: Details Pane — Templates Tab Selected

A. Name – The name of the template.
B. Edit – Click this link to edit the name of the Template. See: Edit Name
C. Edit Permissions – Click this button to add or remove permissions to this Template. See:

Edit Permissions
D. Permission List – This is a list of the permissions granted to a User by this Template.
E. Edit Locations – Click this button to grant or remove access to a Location for this

Template. See: Edit Locations
F. Location List – The default option is the root of your Location structure. Access can be

edited individually for every item in your Location structure.

Edit Name

Figure 10-12: Edit Name

• Add a name for your Template and click OK to accept this change.

• Click Cancel to finish without making changes.
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Edit Permissions

Two different permissions can be selected:

• MANAGEASSETSOURCE – This permission enables the user to add and remove asset
sources in the Asset Explorer.

Note
This option is not supported in AMS Machine Works 1.7.5.

• MANAGEUSER – This permission gives the user administrator privileges. Specifically, it
allows the user to perform the following actions in the User Manager: manage users;
manage templates; manage user, password, lockout, and OIDC settings.

Edit Locations

Figure 10-13: Edit Locations

• Access can be granted to specific a Location folder individually for an end node in your
hierarchy, or to the entire contents of a Location folder and all of its sub-folders.

Details Pane — Licenses Tab Selected
When the Licenses Tab is selected, the Details Pane contains information about the
License you currently have selected in the Contents Pane.

There are two types of License in AMS Machine Works 1.7.5:

• AMS_Machine_Works_OPC_UA_Server

• AMS_Machine_Works_Users

Note
Complete information about your installation and licences can be found in your
Guardian Information. See: View Guardian Information
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Figure 10-14: Details Pane — Licenses Tab Selected

This includes information such as:

• Status:
— On/Off — In the case of an AMS_Machine_Works_OPC_UA_Server License.

— Number Used / Total Number — This is the number of user accounts currently in
use in the case of an AMS_Machine_Works_Users License. (e.g., 3/10)

• Start Date — (month/day/year)

• End Date — (month/day/year)

• Value:
— On/Off — In the case of an AMS_Machine_Works_OPC_UA_Server License.

— Total Number — This is the total number of user accounts in the case of an
AMS_Machine_Works_Users License.

10.2 Ribbon Menu — Settings Menu Functions
In the User Manager the Settings Menu functions remain the same in every context set by
the Context Tab Menu.
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Figure 10-15: Settings Menu

A. Settings Menu
B. Available functions:

• User Settings

• Password Settings

• Lockout Settings

• OIDC Settings

10.2.1 User Settings
The User Settings function is in the Settings Menu of the User Manager.

Note
This functionality is only available for Administrators.

Figure 10-16: User Settings Control
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Figure 10-17: User Settings Window

The User Settings Window has the following two options:

A. Require Unique Email – (Default: Checked) Check this box to prevent any email
addresses from being connected to multiple accounts.

B. Allow Only Alphanumeric Usernames – (Default: Unchecked) Check this box to prevent
users from adding special characters to their usernames.

10.2.2 Password Settings
The Password Settings function is in the Settings Menu of the User Manager.

Note
This functionality is only available for Administrators.

Figure 10-18: Password Settings Control
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Figure 10-19: Password Settings Window

The Password Settings Window has the following options:

A. Required minimum length – (Default: 6) Enter a minimum length for user passwords.

Note
The default setting is 6, but the recommended best practice is to use passwords of at
least 8 characters and up to a reasonable maximum length, such as 24. This field
accepts a wide range of values, (0 to 999999999), which fall outside of the
recommended range. Values larger than 999999999 will not be saved, and result in an
error.

B. Require special character – (Default: Checked) Check this box to require users to include
at least one special character in their passwords. The following characters are allowed:
Space; \ / | " * : < > ? , . ; ' " [ ] { } - _ = + ∼`

Note
This is a recommended option.

C. Require lowercase – (Default: Unchecked) Check this box to require users to include at
least one lowercase letter in their passwords.

Note
This option is not selected by default, but this is a recommended best practice.

D. Require uppercase – (Default: Checked) Check this box to require users to include at
least one uppercase letter in their passwords.

Note
This is a recommended option.

E. Require digit – (Default: Checked) Check this box to require users to include at least one
numeric character in their passwords.

Note
This is a recommended option.
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10.2.3 Lockout Settings
The Lockout Settings function is in the Settings Menu of the User Manager. These
settings control the Lock / Unlock a User functions found in the Home Menu of the User
Manager when the Users context tab is selected.

Note
This functionality is only available for Administrators.

Figure 10-20: Lockout Settings Control

Figure 10-21: Lockout Settings Window

The Lockout Settings Window has the following options:

A. Enable – (Default: Checked) Check this box to enable lockout functionality.
B. Lockout time (in minutes) – (Default: 40) Enter the amount of time, in minutes, that a

user is prevented from attempting to log in after the account is locked. This field accepts
numbers from 0 to 59.

Note
Values larger than 59 will be not saved, and result in an error.

C. Max failed access attempts – (Default: 3) Enter the number of times a user can
incorrectly enter their login credentials before the account is locked.

Note
The recommended range is 3 to 5. This field accepts a wide range of values, (0 to
999999999), which fall outside of the recommended range. Values larger than
999999999 will not be saved, and result in an error.
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10.2.4 OIDC Settings
The OIDC Settings function is in the Settings Menu of the User Manager.

Note
This functionality is only available for Administrators.

The OpenID Connect Settings (OIDC) control which external login options are available on
the login page. These external accounts allow you to log in to AMS Machine Works by
using credentials from another source — for example, from Google, Microsoft, your Active
Directory account, or some other provider.

If these external providers implement the OpenID Connect protocol for sharing
authentication information between Web Services, they can be used to link AMS Machine
Works users to external accounts. The OpenID Connect settings are different for every
authentication provider.

Note
Any changes, or the addition of a OIDC provider, are not applied until the Administrator
restarts the system.

Figure 10-22: OIDC Settings

Figure 10-23: OpenID Connect Settings — First Configuration

A. — When there are no OIDC connections configured you may configure the first one by
clicking this link.
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Figure 10-24: OpenID Connect Settings — Add OIDC Provider Details

The list of the OpenID Connect providers that are currently defined is located on the left.
You can select one to edit or delete.

A. Claim Type – Enter the claim type information specific to the provider. The Claim Type
field defines which claim is used to link the user in the Edit Logins dialog.

B. Display Name – Enter the user-defined display name. For example,
OIDC_Provider_Name.

C. Scheme Name – Enter the user-defined scheme name. For example,
OIDC_Scheme_Name. The Scheme Name must be unique and cannot be the same
name as another OpenID Connect Provider in the software.

D. Authority – Enter the URL specific to the provider in the following format:
• https://<AUTHORITY>/.well-known/openid-configuration

• For example, https://accounts.google.com/.well-known/openid-configuration

E. Callback Path – Enter the Callback Path specified by the provider.
F. Client ID – Enter the Client ID specific to the provider you are using.
G. Enable Client Secret – If the provider requires a Client Secret, check the Enable Client

Secret checkbox.
H. Client Secret – Enter the secret in the Client Secret field.

10.3 Ribbon Menu — Home Menu Functions
The Home Menu functions are completely different depending on which Context Tab is
active. See: Context Tab Menu

• Users Tab: User Management Functions

• Templates Tab: Template Management Functions

• Licenses Tab: License Management Functions
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10.3.1 User Management Functions
There are a variety of User Management Functions available in the Home Menu when the
Users Tab is selected:

• Add a User

• Delete a User

• Disable / Enable a User

• Lock / Unlock a User

• Force a User to Logout

• Edit Logins Settings

• Reset Password

• Refresh Users

• Export to CSV

Add a User
Before you begin, confirm that:

• You are logged in as an Administrator.

• There is an AMS_Machine_Works_Users license available.

— See: Details Pane — Licenses Tab Selected

When the Users Tab is active, click the New User function in the Home Menu view of the
Ribbon Menu. See: Ribbon Menu

Figure 10-25: New User Function
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Figure 10-26: New User Details

A. Username – Set the Username for accessing the software. The Username must be
unique to the system.

Note
We recommend setting a Username with a length of 8 to 24 characters without spaces,
but spaces are allowed and there is no character limit.

B. Email – The email address used to contact the user. The user receives notification emails
and messages at this address according to the user’s subscription settings.

C. First name –The user’s first name. There are no character limits.
D. Last name – The user’s last name. There are no character limits.
E. Password – The Password for the user when logging in to the software for the first time.

Password must be at least 6 characters, have at least one special character, at least one
digit (0-9), and at least one uppercase (A-Z). The above validation is related to the
password complexity settings.

F. Confirm Password – Re-enter the password to ensure that it was entered correctly.
G. Password will change on the next login – Check this checkbox if you want to require

the user to create a new password when the user logs in for the first time.
H. Account is disabled – Check this checkbox if you want to set up the new user now but

want the user account to remain disabled until a later time.

Note
A disabled account still uses one of your user licenses.
• To obtain more licenses: Request a License Proposal

Delete a User
Before you begin, confirm that:

• You are logged in as an Administrator.

When the Users Tab is active:

1. Find the User you want to delete by making selections in the Navigation Pane and
the Contents Pane.
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2. Click the Delete User function in the Home Menu view of the Ribbon Menu. See:
Ribbon Menu

Figure 10-27: Delete User Function

Note
Double check that you have selected the correct User to delete. There is no confirmation
dialogue for this function.

Disable / Enable a User
This control has two functions depending on the state of the User.

• For Enabled Users it is labeled Disable User.

• For Disabled Users it is labeled Enable User.

A disabled user account cannot log in and cannot receive notifications or messages.

Note
A disabled account still uses one of your user licenses.

• To check if a user is Disabled, look in the Details Pane — Users Tab Selected, for a
Disabled label under the User portrait.

• To obtain more licenses: Request a License Proposal

• To remove unnecessary users: Delete a User

Before you begin, confirm that:

• You are logged in as an Administrator.

When the Users Tab is active:

1. Find the User you want to Disable / Enable by making selections in the Navigation
Pane and the Contents Pane.

2. Click the Disable User function in the Home Menu view of the Ribbon Menu. See:
Ribbon Menu

Figure 10-28: Disable / Enable User Function

Note
There is no confirmation dialogue for this function.
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Lock / Unlock a User
This control has two functions depending on the state of the User.

• For Unlocked Users it is labeled Lock User.

• For Locked Users it is labeled Unlock User.

A Locked user account receives notifications or messages, but cannot log in.

Note
A Locked account still uses one of your user licenses.

• To check if a user is Locked, look in the Details Pane — Users Tab Selected, for a Locked
label under the User portrait.

• To obtain more licenses: Request a License Proposal

• To remove unnecessary users: Delete a User

Before you begin, confirm that:

• You are logged in as an Administrator.

When the Users Tab is active:

1. Find the User you want to Lock / Unlock by making selections in the Navigation
Pane and the Contents Pane.

2. Click the Lock User function in the Home Menu view of the Ribbon Menu. See:
Ribbon Menu

Figure 10-29: Lock / Unlock User Function

Note
There is no confirmation dialogue for this function.

Force a User to Logout
An Administrator can force a User to log out at any time.

Before you begin, confirm that:

• You are logged in as an Administrator.

When the Users Tab is active:

1. Find the User you want to force to logout by making selections in the Navigation
Pane and the Contents Pane.

2. Click the Force Logout function in the Home Menu view of the Ribbon Menu. See:
Ribbon Menu

3. The User is logged out after a 5 minute delay.
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Figure 10-30: Force Logout Function

Note
Double check that you have selected the correct User to Force Logout. There is no
confirmation dialogue for this function.

Edit Logins Settings
The Edit Logins button enables you to change the OpenID Connect Provider and the
Claim Value settings for a User.

Before you begin, confirm that:

• You are logged in as an Administrator.

1. Find the User you want to edit by making selections in the Navigation Pane and the
Contents Pane.

2. When the Users Tab is active, click the Edit Logins function in the Home Menu view
of the Ribbon Menu. See: Ribbon Menu

3. The Edit Logins window appears.

• OpenID Connect Provider — Select from a dropdown list of providers that you
defined in the OIDC Settings.

• Claim Value — Add the appropriate value here for that provider you have
selected.

• Delete — Delete this connection type for this User.

• Add Login — Add a new provider for this User.

Note
When no OIDC Settings are defined, the following error message is displayed:

• There aren't any OpenID Connect providers to pick from. You can add them by clicking
the "OIDC Settings" button under the Settings tab.

See: OIDC Settings
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Reset Password
Administrator privileges are not required to reset your own password, but they are
required to reset other users’ passwords.

The Reset Password button enables you to send an email with a reset link for your
Password.

If you want to reset the password of a different User, confirm that:

• You are logged in as an Administrator.

1. Find the User you want to edit by making selections in the Navigation Pane and the
Contents Pane.

2. When the Users Tab is active, click the Reset Password function in the Home Menu
view of the Ribbon Menu. See: Ribbon Menu

3. The Reset Password window appears.

• OK — Click OK to proceed, and an email will be sent to the address associated
with that account.

• Cancel — Click Cancel to exit without making any changes.

Refresh Users
After changes are made to User information, you can refresh the User List with updated
information by clicking the Refresh Users button.

Before you begin, confirm that:

• You are logged in as an Administrator.

When the Users Tab is active:

1. Select the scope of users you want to refresh.
a. To refresh the information of every User, select the All Users folder in the

Navigation Pane.

b. To refresh the information of a specific User, find the User you want to
refresh by making selections in the Navigation Pane and the Contents Pane.

2. Click the Refresh Users function in the Home Menu view of the Ribbon Menu. See:
Ribbon Menu
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The information is then reloaded.

Export to CSV
Information about every User can be exported to a .csv file. The information includes:

• Username

• Display Name

• Last Activity

• Locked

• Disabled

Before you begin, confirm that:

• You are logged in as an Administrator.

When the Users Tab is active:

1. Click the Export to CSV function in the Home Menu view of the Ribbon Menu. See:
Ribbon Menu

The information is then saved in the Downloads directory you have configured in your
browser settings as Users.csv.

10.3.2 Template Management Functions
AMS Machine Works has functionality for preparing different kinds of User Template. This
enables an Administrator to create a group of privileges as a Template, and then use the
Template to assign those privileges to a User.

There are three Template Management Functions available in the Home Menu when the
Templates Tab is selected:

• Create a User Template

• Delete a User Template

• Apply a User Template

Create a User Template
The New Template button enables you to create a Template with standard settings for
managing User Permissions. Every Template is created in the Custom folder found in the
Navigation Pane.
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Before you begin, confirm that:

• You are logged in as an Administrator.

1. When the Templates Tab is active, click the New Template function in the Home
Menu view of the Ribbon Menu. See: Ribbon Menu

2. The New Template window appears.

• A — Enter the name for this Template.

• B — Select which permissions are granted by this Template.

• C — Select which Location a User is granted access to by this Template.

Delete a User Template
To remove a Template, use the Delete Template function.

Before you begin, confirm that:

• You are logged in as an Administrator.

When the Templates Tab is active:

1. Find the Template you want to delete by making selections in the Navigation Pane
and the Contents Pane.

2. Click the Delete Template function in the Home Menu view of the Ribbon Menu.
See: Ribbon Menu
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Note
Double check that you have selected the correct Template to delete. There is no
confirmation dialogue for this function.

Apply a User Template
The Apply Template button enables you to use a Template with standard User
Permissions to manage User access to features and Locations.

Note
Future changes to a Template do not affect any User automatically. The Template must
be reapplied manually.

Before you begin, confirm that:

• You are logged in as an Administrator.

1. Find the Template you want to use by making selections in the Navigation Pane
and the Contents Pane.

Note
There are no Default Templates available in AMS Machine Works 1.7.5.

2. When the Templates Tab is active, click the Apply Template function in the Home
Menu view of the Ribbon Menu. See: Ribbon Menu

3. The Apply Template window appears.

• Selected — Check the box next to the name of every User you want to have this
Template.

• Name — The names of every User in the system.

• OK — Click OK to confirm your choices.

• Cancel — Click Cancel to exit without making changes.
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10.3.3 License Management Functions
There are a variety of types of AMS Machine Works License which enable different features
and capabilities.

The list of License types includes:

• AMS_Machine_Works_OPC_UA_Server: This is the License for the software.

• AMS_Machine_Works_Users: This is the License for the number of unique User
accounts which are available.

Note
Complete information about your installation and licenses can be found in your Guardian
Information. See: View Guardian Information

A License has one of three statuses:

• Good: A Good License has more than 80% of its resources still available.

• Fair: A Fair License has less than 80%, but more than 0%, of its resources still available.

• Poor: A Poor License has 0% of its resources still available.

Note
A License which is based on a Start Date and an End Date is Good until the End Date and
then it is Poor. See: License Management Functions

When a License which has a Start Date and an End Date is closer than 90 days to the End
Date, emails are sent to the Administrator at the following intervals:

Where N equals the number of days until the End Date

1. If N > 60 and N ≤ 90, a reminder is sent once a week.

2. If N > 30 and N ≤ 60, a reminder is sent twice a week.

3. If N > 7 and N ≤ 30, a reminder is sent three times a week.

4. If N ≤ 7, a reminder is sent every single day.

There are three License Management Functions available in the Home Menu when the
Licenses Tab is selected:

• Register a License

• Request a License Proposal

• View Guardian Information

Register a License
The Register License button enables you to select the License file which matches the
Machine Fingerprint of the computer which AMS Machine Works is installed on.

The Machine Fingerprint is available in the Request a License Proposal window.

A License can be active for a specific duration, or control which features are enabled, or
how many users are allowed.
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Note
A License is cryptographically connected to the Machine Fingerprint value, and cannot be
used for a different machine.

Before you begin, confirm that:

• You are logged in as an Administrator.

1. When the Licenses Tab is active, click the Register License function in the Home
Menu view of the Ribbon Menu. See: Ribbon Menu

2. The Register License window appears.

• Browse — Navigate your storage to find the License file.

• Contact Info — Customer support phone numbers.
— US Customers: 1-888-367-3774 (Option 2)

— Global Customers: (+63) 702-1888

• Email Link — Link to customer support. wwcs.custserv@emerson.com

• OK — Confirm the selection of the License file.

• Cancel — Close the window without making any changes.

Request a License Proposal
The Request Proposal button enables you to request a License proposal from Emerson
which matches the Machine Fingerprint of the computer which AMS Machine Works is
installed on.

A License can be active for a specific duration, or control which features are enabled, or
how many users are allowed.

Note
A License is cryptographically connected to the Machine Fingerprint value, and cannot be
used for a different machine.
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Before you begin, confirm that:

• You are logged in as an Administrator.

1. When the Licenses Tab is active, click the Request Proposal function in the Home
Menu view of the Ribbon Menu. See: Ribbon Menu

2. The Request License window appears.

• Copy — Click Copy to copy the Machine Fingerprint generated for this specific
machine.

• Contact Info — Customer support phone numbers.
— US Customers: 1-888-367-3774 (Option 2)

— Global Customers: (+63) 702-1888

• Email Link — Click the link to customer support, and paste in the Machine
Fingerprint value you copied. wwcs.custserv@emerson.com

• OK — Click OK to exit this window.

View Guardian Information
The Guardian Info button enables you to view the many pieces of the Registration and
Configuration information associated with your License and the current state of the
software.

The Machine Fingerprint is available in the Request a License Proposal window.

A License can be active for a specific duration, or control which features are enabled, or
how many users are allowed.

Before you begin, confirm that:

• You are logged in as an Administrator.

1. When the Licenses Tab is active, click the Guardian Info function in the Home
Menu view of the Ribbon Menu. See: Ribbon Menu
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2. The Guardian Info window appears.

• Registration — This is an expandable hierarchy of many aspects of your License,
Users, and Machine Configuration.

• OK — Click OK to export the Guardian Info in a file named SysRegData.epm to
the Downloads directory you have configured in your browser settings.

• Cancel — Click Cancel to close the window without making any changes.
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11 Event Viewer
The Event Viewer utility allows you to view system-generated events. You can choose to
display events per module or view all events logged by the system.

The following modules log events:

• Device Configuration — events relating to configuration of connected devices, such as
device discovery errors.

• Asset Explorer — events and configurations in the Asset Explorer utility, such as
adding, editing, and deleting assets and locations, asset binding, and all asset health
changes.

• Data Highway — all events occurring in the Data Highway, such as parameter
registration and unregistration.

• Machine Configuration — all machine configurations, such as adding, editing, and
deleting components, bearings, collections, measurement definitions, alarm limits,
and channel mappings.

• User Manager — all events in the User Manager utility, such as adding, editing, and
deleting users and logging in and logging out users.

• Vibration Analyzer — all events in the Vibration Analyzer, also known as VibApp, such
as adding, editing, and deleting plot labels and machine notes, RPM changes, machine
health train changes, and alarms.

Events are displayed with the following details:

• Date and Time—date and time the event was recorded.

• Event Type—the type of event to which the interface responds.

• Source—the module associated with the event.

• Asset—the asset associated with the event.

• Attachments—the attachment associated with the event. Events with attachments
have a paper clip icon.

Note
The database in a Tier-1 installation (Limited Storage), Microsoft SQL Server 2017 Express,
has a size limit of 10 GB. If the databases reach this size limit, the software will no longer be
able to store new events.

11.1 View events
Only system-generated events can be viewed in the Event Viewer utility.

Prerequisites

Launch the Event Viewer utility.

Procedure

1. On the left pane, select to view events by Application or by Modules:
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• Click Application to view all events logged by the system.

• Expand the Modules folder and click on a module to view events recorded for
the specific module.

2. Select an event from the list.

Details display in the bottom pane. If an event has an attachment, a thumbnail of
the attachment is displayed.

11.2 Archive events
Events stored in Plantweb Optics are archived periodically. Archived events are deleted
from the database and stored in an archive file.

By default, events that are older than 180 days are archived. Event archiving automatically
happens every 30 days. You can retrieve archived files in C:\EMERSONCSI\DATA
\Backups\Events. Archive files are in .csv format with the text OpticsEventsArchive
appended in the file name.

Note
Archived events cannot be imported and viewed in the software.
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12 AMS Machine Works Limits
Table 12-1: AMS Machine Works Limits

Name Limit Units

Network Devices

AMS 9420s 400 count

Emerson Wireless Gateway 20 count

Asset Explorer

New Asset (Name) 60 characters

Asset Generic 500 count

Locations 1,000 count

Machine Trains 500 count

Device Configuration

Measurement Points 2,000 count

Measurements per collection 2,000 count

Machine Configuration

Machine Train Details

Machine Train Components 3 components

Speed 120,000 RPM

Machine Train Name 60 characters

Machine Train Description 125 characters

Machine Train Component Name 60 characters

Machine Train Component
Description

125 characters

Motor

Manufacturer 60 characters

Model 60 characters

Speed (RPM) 120,000 RPM

Power 50,000 HP

Number of Poles 48

Number of Rotor Bars 500

Number of Stator Slots 501

Frame Size NaN -N

Rated Volts 20,000 Volts

Full Load Current 1,000 Amps
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Table 12-1: AMS Machine Works Limits (continued)

Name Limit Units

Rated RPM 120,000 RPM

Motor Parts
(similar to turbine parts, blower, centrifuge, compressor, generator, Generic, Spindle)

Shaft Name 60 characters

Bearing 9 -

Coupling

Coupling Name 60 characters

Coupling Description 255 characters

Gearbox

Gearbox Name 60 characters

Gearbox Description 255 characters

Manufacturer 60 characters

Model 60 characters

Gearbox Ratio 100 -

Shaft 3 -

Gearbox Parts - Shaft Name 60 characters

Gearbox Parts - Gear Name 60 characters

Gearbox Parts - Number of Teeth 2,000 -

Number of Gears per shaft 2 -

Number of Bearings per shaft 2 per shaft -

Pump

Pump Information - Number of Inlet
Pump Vanes

100 -

Pump Information - Number of
Outlet Pump Vanes

100 -

Pump Stages 20 -

Number of Vanes 100 -

Number of Bearings per Pump 9 -

Fan

Fan - Number of Primary Fan Blades 100 -

Fan - Number of Secondary Fan
Blades

100 -

Fan Stages 20 -

Fan Number of Blades 100 -

Number of Bearings per Fan Shaft 9 -
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Table 12-1: AMS Machine Works Limits (continued)

Name Limit Units

Machine Configuration

Combined Measurement Location Properties

Sensor Angle 360 Degrees

Tach. Angle 360 Degrees

Resting Voltage 24 Volts

Bearing Clearance 1000 microns

Tach name 60 characters

Misc

Point ID 30 characters

Point ID Description 60 characters

Machine Journal

General

Cases per system 5,000 count

Cases (Open) per machine
component

50 count

Cases (Resolved) per machine
component

50 count

Cases (Open + Resolved) per
machine component

100 count

Posts/Replies per system 500,000 count

Posts/Replies per case 100 count

Replies per post NA count

Post text size 102,400 characters

Case text size 64 characters

Attachments per post 64 count

Attachment (Single image) size 15 MB

Attachment (Single other) size 50 MB

Attachment filename length 256 characters

Attachment link length 1,024 characters

Attachment description length 256 characters

Tag text size 64 characters

Tags per post 50 count

Mentioned users per post 20 count

Number of severities 100 count

Number of urgencies 100 count
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Table 12-1: AMS Machine Works Limits (continued)

Name Limit Units

Severity text size 64 characters

Urgency Text Size 64 characters

Number values of severities 100 value

Number values of urgencies 100 value

Attachment size per download 1 GB

Work recommendations per post 64 count

Work recommendations per system 480,000 count

Posts per report 200 count

Work recommendation subject
length

256 characters

Work recommendation description
length

500 characters

Work recommendation comment
length

256 characters

Vibration Analyzer

Concurrent Users 5

Maximum nested hierarchy levels
supported

6
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Glossary

agent

A lightweight service responsible for communicating with devices. Each type of agent is
designed to communicate with a specific kind of device. An AMS Machine Works
installation can support multiple instances of every type of agent simultaneously. Multiple
instances of a single type of agent can be used to load balance network traffic as well as
support multiple isolated networks.

alert hysteresis

is expressed as a percentage of the value of an alert by which the value must change
towards a safe value before the alert can be triggered again.

For example, if you have an Upper Absolute Alert set for x=100, and the Alert Hysteresis
is set at 5%, the Alert will not be repeatedly triggered by fluctuations within the 5% band,
(i.e., values where 100 < x > 95).

But if the value of x passes below 95, a fresh alert will be triggered the next time x > 100.

alert state
A user-defined categorization of the health of an asset. There are four alert state statuses:
advise, warning, critical, and good.

Analysis Dashboard

The AMS Machine Works Analysis Dashboard provides an overview of the status,
measurement, and health information of machines trains.

asset
Any physical component (such as a device or machine) being monitored by AMS Machine
Works, or the logical representation of a physical asset. Examples include: motor, pump,
fan, turbine, and more.

Asset Explorer
A utility that provides an interface for organizing and interacting with assets, and
launching other utilities.

asset priority
A value representing the importance of an asset with respect to other assets in the system:
Not Set, Low, Medium, High, or Very High.

auto mapping

In the measurement pane of the device configuration process you can AUTOMAP a
device’s three measurements to the horizontal, vertical, and axial axes.

channel mapping

The association of each channel on an BROKEN: [xsh1673258136315.dita] asset
source with a particular measurement location on a machine.

collection

In the Network Device Module, a collection can be configured for each device. A collection
defines the measurement(s) which can be demanded, and some collections are stored
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whenever the Store on Alert function is triggered by one the device's native scalar
measurements.

device

A measurement instrument connected to AMS Machine Works.

device location

A representation of the real-world, physical position of the measurement device.

event

Any change related to the network connection status, health status, or on demand
collection status of a device.

Event Viewer
Utility that allows you to view system-generated events.

failure effects

This filter option identifies and organizes assets according to the effects they cause if there
is an equipment failure. For example, you can label a Machine Train component, e.g. a Fan,
with Environmental Control if the purpose of the component is to provide cooling to a
production environment.

filters
Labels for categorizing system elements to allow grouping and filtering using the search
feature. In the Asset Explorer utility, you can label any asset with the failure effects label.

health status

There are five health statuses:

• Good: health status — good

• Advice: health status — advice

• Warning: health status — warning

• Critical: health status — critical

• Unknown: health status — unknown

health status — advice

health status — critical

health status — good

health status — unknown

Unknown status is for:

• Devices which currently have no network connection.

• Devices which have not yet communicated their the initial configuration information.

health status — warning

location
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A location is used to organize your site. A location can contain another location or a
machine train. For example a location could be used to hold all the machine trains and sub-
locations in a physical area, or it could be used to group similar types of machine trains.

location navigator
An area in the Asset Explorer utility where you can create and organize your site, view
information about the locations and assets you create, and perform operations within the
context of a selected location or asset.

machine train

A machine train is a representation of every asset and device used to define and monitor a
piece real world equipment.

measurement location
An approximate representation of the physical location where data is acquired, usually the
physical location of a measurement device.

protocol

A protocol describes how a device sends and receives information on the network.
Examples include HART and Ethernet.

site

The site is the root of your location tree structure.

spectrum

A spectrum plot is a graphical representation of vibration frequencies and their amplitude.
In AMS Machine Works you can view spectra in the Vibration Analyzer application or in the
AMS Machine Works Dashboard.

store on alert

The store on alert function enables data capture for a Collection or Collections whenever
an alert state is triggered. Store on alert settings are available for any native scalar
measurement.

trends

A trend plot shows a number of measurements of a parameter over a period of time. In
AMS Machine Works you can view trends in the Vibration Analyzer application or in the
AMS Machine Works Dashboard.

User Manager
Utility that lets you control and monitor access to various components of the software.

Vibration Analyzer
A module of AMS Machine Works that lets you analyze periodic vibration data collected
from supported devices connected to machines in your site.

waveform

A waveform plot is a graphical representation of how the vibration level changes with
time. In AMS Machine Works you can view waveforms in the Vibration Analyzer application
or in the AMS Machine Works Dashboard.
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active plot 151
Alerts 69
Analysis Dashboard

Analysis View
Associated Data 140
Machine Information panel 136
Machine Status 134
Plot and Unit Settings 124
Subheader Shortcuts 122
Trend Plots 138

Header Section 116
List View

Machine Train List 133
Subheader Section 121
System View

Machine Status KPI 130
System Messages 131

User Interface Elements
App Switcher 118
Colors and Icons 112
Filters

Displayed Trends Filter 128
Persistent Machine Train Filters 128
Temporary Machine Train Filters 126

Help 121
Language Settings 119
Navigation Breadcrumbs 121
Navigation Tree 117
Search 125
System Settings 120
User Menu 119

Asset Explorer
Add a Location 192
Add a Machine Train 193
Deleting Locations and Machine Trains 197
Edit a Machine Train 194
Edit Alerts 195
Failure Effects

Apply Failure Effect Labels
Home menu method 200
Properties pane method 200
Right-click method 199

Define Custom Failure Effect Labels 201
Delete Custom Failure Effect Labels 201
Modify Custom Failure Effect Labels 201
Remove Failure Effect Labels 201

Locations versus Assets 191
Renaming Locations, Machine Trains, and Assets 196
User Interface Elements

Contents Pane 187
Location navigator 186

Asset Explorer (continued)
User Interface Elements (continued)

Navigation bar 185
Properties Pane 188
Ribbon

File menu 182
Home menu 183
Search menu 184

Search bar 190
User toolbar 191

C

cascade plot
display calculated trend 169

cursor
display sideband 154
linked 155
modes 152
move 153
set reference 153

E

Event Viewer
View Events 253

F

fault frequency
match available 168
match cursor location 167

H

Historian 177

I

Introduction
Symbols 9

L

Limits 255

M

Machine Alerts
Add Alerts 73
Alert Creator Screen
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Machine Alerts (continued)
Alert Creator Screen (continued)

Alert List 71
Asset Sketches 71
Top Menu 71

Edit Alerts 70
Store on Alert Settings 75

Machine Configuration
Add Machine Details

Add or Remove a Custom Position 37
Coupling Components 38
Driven Components

Fan Components 54
Other Driven Components 56
Pump Components 51

Driver Components
Motor Components

Basic Information 41
Motor Information 42
Motor Parts 44

Turbine Components 45
Intermediate Components

Define Gearbox Parts 49
Set Output Ratio 48

Using Libraries
Bearing Library

Add a Bearing 30
Add a Bearing to the Library 33

Motor Library
Add a Motor to the Library 29
Search the Motor Library 28

Other Libraries
Add an Item to the Library 36
Search a Library 35

Add Machine Train Details 25
Channel Mappings

Channel Mapping Interface
Asset Pane 61
Custom Position Pane 64
Measurement Pane 62
Network Device Pane 59

Definition of a Machine Train 23
Definition of Machine Train Components 23
Initiate the Configuration Process 24
Machine Configuration User Interface 24
Machine Train Summary

Copy Alerts 67
Copy Machine Train 66
Print Summary 65

Summary 64
Machine Journal

Launch the Machine Journal 205
Machine Journal Terms 205

N

Network Device Module

Network Device Module (continued)
Agents

Change Agent 108
Rename Agent 109

Dashboard
Connection Status 80
Device Health 81
Header 79
System Stats 82

Dashboard and Sidebar 77
Devices

AMS Asset Monitor
Details 85
Modifying Devices 89

AMS Asset Monitor Tab 84
AMS Wireless Tab 97
Collection Details

Schedule Collection 106
Emerson Wireless

Bulk Configuration 100
Details 97

Emerson Wireless Gateway
Details 92
Modifying Devices 95

Emerson Wireless Gateway Tab 91
Unit Settings 109

O

Overview
AMS Machine Works Architecture 20
System Components 21

P

plot
annotate 156
customize display 158
overlay 155
zoom in 155
zoom out 155

plotting workspace
configure 157

S

Setup Options Editor
plot options 163
spectrum 161
trend 163
waveform 159

Site setup
Asset Explorer 181

spectrum plot
display calculated trend 169
display fault frequency 167, 171
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spectrum plot (continued)
function bar 165
harmonic family list 166
label peaks 168
locate peak 168
mark cursors 153
peak list viewer 166
remove peak 168
view 165
view multiple spectrums in one plotting workspace
169

T

trend plot
function bar 176
hide upper advise 177
hide upper danger 177
hide upper warning 177
show upper advise 177
show upper danger 177
show upper warning 177
view 175
view multiple plots on one plot 176

U

User Manager
Home Menu

License Management
Register License 248
Request License Proposal 249
View Guardian Information 250

Template Management
Apply Template 247
Create Template 245
Delete Template 246

User Management
Add a User 239
Delete a User 240
Disable a User 241
Edit Logins Settings 243
Enable a User 241
Force Logout 242
Lock a User 242
Refresh Users 244, 245
Reset Password 244
Unlock a User 242

Home Menu Functions 238
Interface Overview

Contents Pane 225
Context Tab Menu 223
Details Pane

Licenses Tab Selected 231
Templates Tab Selected 229
Users Tab Selected 226

User Manager (continued)
Interface Overview (continued)

Navigation Pane 224
Ribbon Menu 223

Settings Menu Functions
Lockout Settings 236
OIDC Settings 237
Password Settings 234
User Settings 233

V

Vibration Analyzer
change server 177
connection profile 177

W

waveform plot
display fault frequency 167, 171
function bar 170
play audio 172
use micro-step cursor 171
view revolutions 172

Web Services 177
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